Horse Farm Management System

for

Windows™

HFM (Standard) User’s Guide

Date: January 1, 2012

Copyright © 2012 The Jockey Club Information Systems, Inc.
# TABLE OF CONTENTS

## TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVAILABLE REPORTS IN THE STANDARD PROGRAM</td>
<td>5</td>
</tr>
<tr>
<td>Base Reports</td>
<td>5</td>
</tr>
<tr>
<td>Misc. Reports</td>
<td>5</td>
</tr>
<tr>
<td>Mare Reports</td>
<td>5</td>
</tr>
<tr>
<td>Fertility Analysis Reports</td>
<td>5</td>
</tr>
<tr>
<td>Additional Reports</td>
<td>5</td>
</tr>
<tr>
<td>Procedure Reports</td>
<td>6</td>
</tr>
<tr>
<td>A/R Transaction Reports</td>
<td>6</td>
</tr>
<tr>
<td>Billing: Standard &gt; Preliminary Reports</td>
<td>6</td>
</tr>
<tr>
<td>Billing: Standard &gt; Historical Reports</td>
<td>6</td>
</tr>
<tr>
<td>Mare Info Reports</td>
<td>7</td>
</tr>
<tr>
<td>MENU OPTIONS IN THE STANDARD PROGRAM</td>
<td>8</td>
</tr>
<tr>
<td>Master Files Menu</td>
<td>8</td>
</tr>
<tr>
<td>Procedures Menu</td>
<td>8</td>
</tr>
<tr>
<td>A/R Transactions Menu</td>
<td>9</td>
</tr>
<tr>
<td>Billing Menu</td>
<td>9</td>
</tr>
<tr>
<td>Preliminary Reports</td>
<td>9</td>
</tr>
<tr>
<td>Historical Reports</td>
<td>10</td>
</tr>
<tr>
<td>Mare Information Menu</td>
<td>10</td>
</tr>
<tr>
<td>Reports Menu</td>
<td>11</td>
</tr>
<tr>
<td>1. Base Reports</td>
<td>11</td>
</tr>
<tr>
<td>2. Misc. Reports</td>
<td>11</td>
</tr>
<tr>
<td>3. Procedure Reports</td>
<td>11</td>
</tr>
<tr>
<td>4. Mare Reports</td>
<td>12</td>
</tr>
<tr>
<td>5. Fertility Analysis Reports</td>
<td>12</td>
</tr>
<tr>
<td>Setup Menu</td>
<td>13</td>
</tr>
<tr>
<td>Billing Setup</td>
<td>13</td>
</tr>
<tr>
<td>Security</td>
<td>13</td>
</tr>
<tr>
<td>Online Verification</td>
<td>14</td>
</tr>
<tr>
<td>General Information about Horse Farm Management</td>
<td>20</td>
</tr>
<tr>
<td>Field Colors</td>
<td>20</td>
</tr>
<tr>
<td>General steps to add information into the system</td>
<td>20</td>
</tr>
<tr>
<td>General steps to edit information in the system</td>
<td>20</td>
</tr>
<tr>
<td>General steps to delete information from the system</td>
<td>20</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td>26</td>
</tr>
<tr>
<td>Getting Started – Just the Basics</td>
<td>26</td>
</tr>
<tr>
<td>Set Up Your Company First</td>
<td>26</td>
</tr>
<tr>
<td>Set up Farms</td>
<td>27</td>
</tr>
<tr>
<td>Select and Review Preferences</td>
<td>27</td>
</tr>
</tbody>
</table>
SET UP CLIENTS 28
SET UP BOARDING TYPES 28
SET UP PROCEDURE MASTERS 28
SET UP HORSES 28
REVIEW MASTER LISTS 29
INITIAL A/R CLIENT BALANCES FOR NEW USERS ONLY 29

DETAILED WALK THROUGH 30
1. SET UP YOUR COMPANY 30
2. SET UP FARMS 32
3. REVIEW AND SELECT PREFERENCES 32
4. SET UP CLIENTS 38
5. SET UP BOARDING TYPES 50
6. SET UP HORSE TYPES 51
7. SET UP PROCEDURE CATEGORIES 52
8. SET UP PROCEDURE MASTERS 53
9. HORSE ENTRY 65
10. REVIEW MASTER LISTS [OPTIONAL] 78
11. REVIEW BILLING SETUP [OPTIONAL] 82
SERVICE CHARGE [OPTIONAL] 85
SERVICE TAX 86
G/L ACCOUNT SETUP [OPTIONAL] 90

HEALTH RECORD ENTRIES 91
PROCEDURES 91
1. ADDING PROCEDURES THAT HAVE BEEN PERFORMED ON HORSES 91
2. ADDING MASS PROCEDURE ENTRIES 96
3. EDITING MASS PROCEDURES 101
4. DELETING A MASS PROCEDURE 104
5. SCHEDULING PROCEDURES TO BE PERFORMED 105
6. SCHEDULE MASTER SAMPLES 107
PROCEDURE REPORTS 112
1. PROCEDURES PERFORMED REPORT 112
2. PROCEDURE CATEGORY LISTING 114
3. PROCEDURE MASTER LISTING 115
4. SCHEDULE MASTER REPORT 117

MAINTAINING CLIENT BALANCES 120
A/R TRANSACTIONS 120
1. Adding Payments 120
2. Adding Adjustments (Direct Charges/Credits) 126
3. Editing Adjustments (Direct Charges/Credits) 130
AUTO ALLOCATION 132
A/R TRANSACTIONS REPORTS 136

MONTH END BILLING 151
STANDARD BILLING 151
Processing the Billing 151
PRELIMINARY REPORTS 156
Printing Invoices and Historical Journals 183
# MARE INFORMATION

## RECORDING THE BREEDING SEASON
1. Creating a Mare’s Breeding “Season” Record
2. Automatically Adding New Broodmare Season Records
3. Booking the Mare for Breeding
4. Recording the Breeding Dates
5. Recording the Foaling Information
6. Teasing Results Entry (From the Mare Information Page)

## MARE INFO REPORTS
1. Foaling Report
2. Breeding Report
3. Outside Bookings
4. Farm Mares Bred Summary
5. Broodmare Listing
6. Mare List by Client
7. Generate Broodmare Season

## REPORTS

### HORSES
1. Procedures Performed Report
2. Procedure Category
3. Procedure Master
4. Schedule Master
   1. Foaling Report
   2. Breeding Report
   3. Outside Bookings
   4. Farm Mares Bred Summary
   5. Broodmare Listing
   6. Mare List by Client

### FERTILITY ANALYSIS REPORTS
1. Farm-Mares: Mares by Month
2. Farm-Mares: Mares by Mare Type
3. Farm-Mares: Mares by Stud Farm

## SETUP

### COMPANY SETTINGS

### INITIAL A/R CLIENT BALANCES FOR NEW USERS ONLY

### SERVICE CHARGE [OPTIONAL]

### SERVICE TAX

### G/L ACCOUNT SETUP [OPTIONAL]

### HOW TO REACH US
AVAILABLE REPORTS IN THE STANDARD PROGRAM

*Base Reports*
- Clients
- Horses
- Farms
- Boarding Types
- Horse List by Client

*Misc. Reports*
- Arrival
- Departure
- Departure Form
- Horse Notes
- Health Record
- Mini Pedigree
- Horse Movement

*Mare Reports*
- Foaling
- Breeding
- Outside Bookings
- Farm Mares Bred Summary
- Broodmares
- Mare List by Client
- Teasing Worksheet
- Teasing Results Report
- Foaling Mares By Location

*Fertility Analysis Reports*
- Farm-Mares: Mares by Month
- Farm-Mares: Mares by Mare Type
- Farm-Mares: Mares by Stud Farm

*Additional Reports*
- Labels
- Report Writer
Procedure Reports
- Procedures Performed
- Procedure Category
- Procedure Master
- Schedule Master
- Schedule Procedures Due

A/R Transaction Reports
- Payments
- Adjustments
- Aged A/R
- Detailed A/R
- Unapplied Payments
- Credit Invoices
- Unapplied Payments with Unpaid Invoices
- Billed Charges

Billing: Standard > Preliminary Reports
- Pre-Billing
- Adjustments
- Payments
- Boarding
- Service Charges
- Service Tax
- Preliminary A/R
- Detail A/R
- Closing Summary
- Board & Procedure Revenue
- Invoices

Billing: Standard > Historical Reports
- Board and Procedure Revenue
- Adjustments
- Payments
- Boarding
- Service Charges
- Service Tax
- Aged A/R
- Detail A/R
- Closing Summary
- Board & Procedure Revenue
- Invoices
**Mare Info Reports**

- Foaling
- Breeding
- Outside Bookings
- Farm Mares Bred Summary
- Broodmares
- Mare List by Client
MENU OPTIONS IN THE STANDARD PROGRAM

Master Files Menu

Procedures Menu
A/R Transactions Menu

Billing Menu

Preliminary Reports
Historical Reports

Mare Information Menu
Reports Menu

1. Base Reports

2. Misc. Reports

3. Procedure Reports
4. Mare Reports

5. Fertility Analysis Reports
Registration

![Registration](image)

Online Verification

![Online Verification](image)

Help Menu

![Help Menu](image)
FAQ

This displays a list of Frequently Asked Questions and their corresponding answers. The list includes questions and answers related to Installation of HFM, Setup, A/R Transactions, Procedure Entry, Mare Information Entry and Billing.

Information for Backups

This shows the location of the files you should back up on a regular basis. The Database holds all of the information that you have entered into HFM and the Save Folder contains all of the invoices that have been saved during month end closing. You should back up these files on a regular basis.
**SQL Loader**

This is used to apply patches to your database and should only be used under the direction of a TJCIS support person.

![SQL Loader window](image)

**Send Database To TJCIS**

This menu option is in Development and is currently not available.
Check for Updates

From this screen you can check your program & database versions, go to Fast Support under the direction of a TJCIS support person, you can go directly to The Jockey Club website or you can Upload your datafile directly to TJCIS.
This will be used under the direction of a TJCIS support person and it will allow the support person to see your computer screen at the same time as you. You will enter your farm/company name and the TJCIS support person will provide you with the Support Key.

Click here to access the TJCIS Upload Site

Press BROWSE and locate the file that you need to send us.

Press UPLOAD to move the file to the server.

After you click the upload button, the file will be sent to the server.

THIS MAY TAKE SOME TIME. -- Don't worry. Just let it finish.

When done, you will see a new page to show that the file has made it.
This TJCIS File Upload page will be used if you need to send your datafile directly to a TJCIS support person. You will click “Browse” to locate your datafile and then you will click “Upload” to send your datafile to TJCIS.

About Horse Farm Management System

Note: This is an informational page. You can check to see which HFM Version you are currently running.

This example shows Version 4.2.2.04 (A)
General Information about Horse Farm Management

Field Colors
Throughout the program you will see different colored fields for entry. The following colors are the default settings. These default settings can be changed for individual users by going to Setup > Preferences > User Settings and selecting different colors from the drop down list.

Yellow fields: Require information to be entered before the record can be saved.
Green fields: These fields appear in pairs and indicate that information must be entered in either one or the other field (or both fields).
White fields: Indicate that the information is optional, but it would be in your best interest to fill in as much information as you can.
Gray fields: Are “display only” fields and do not allow users to make any changes.

Tip: To see when a record was created and then who updated it, look in the “Audit Log” area on the screen. It will indicate the created by and date and time for the person that created the entry as well as information on the last time/date the entry was updated.

General steps to add information into the system
There are two basic ways to add information into the system. Most of the entry forms have an ADD button that opens the form and allows the user to enter the new information. On some forms, the information is presented to the user in a list format. On these forms there will be a NEW button. Click the NEW button and after an empty line has been inserted you can type in a new entry for the list.

General steps to edit information in the system
To edit existing information, the system has been designed to allow the user to first “lookup” or find the record that needs changing. Once the record has been located, most forms allow the user to directly change values.

General steps to delete information from the system
The best way to delete a record is by using the DELETE button on the listing forms. You first select the record you wish to remove and click the DELETE button on the form. The system will prompt to double check that you are sure you want to delete. After you confirm, the record will be removed. Warning: Once a record has been removed, it cannot be “undeleted”. The information would have to be re-entered by the user.
Inactive Records

You have the option of marking records as inactive. Records that can be marked as inactive are: Farms, Clients, Horses, Procedure Categories, Procedure Masters and Boarding Types. To mark a record as inactive, open the record and click in the box marked “Active” to remove the check. When the Active box is unchecked, that item will no longer appear in drop down lists. (A)
Client Entry/Edit

A

Client Details:
- First Name: Michael
- Last Name: Wallic
- Name: CEMECA Enterprises

Client Info:
- Client ID: 1
- Client ID: 1
- Service Charge Setup:
  - Standard: Standard
  - Standard: Standard

Location Address:
- Location: 352 Magnolia Bay Lane
- City: Springfield
- State: Virginia
- ZIP: 22193

Phone/E Mail Entries:
- Type: Home
  - Phone Number: (602) 641-3311
  - E-Mail: michaelj@michealj.com
- Main Area Code: (703)
Horse Entry/Edit

Procedure Category Entry/Edit

Page 23 of 324
Procedure Master Entry/Edit

Boarding Type Entry/Edit
Once you have marked an item as “Inactive” you can always search for it by “Un-checking” the Show Active Only box on the individual search screens. When the Show Active Only box is unchecked, you will see both the Active and the Inactive items in the search list.
For this “Getting Started” section, all of the different methods of entering/editing data are not covered. While the system can handle many types of farms and operating styles, this section is meant to show the user just one way of using the software. This “quick start” will give most farms a straightforward way to immediately begin using the system.

**Getting Started – Just the Basics**

After the Horse Farm Management System has been installed and you have called The Jockey Club to complete the registration process, you should take the following basic steps in order to begin setting up and using the program. Please keep in mind that some steps must be completed before you can continue to the next step. For example, you will need to set up your client list before you set up your horses because the system requires that you enter the horse ownership before exiting the horse master screen.

The following is the recommended order for entering your information. This section also provides a brief overview. A detailed “How To” begins on page 31.

**Set Up Your Company First**

(Setup > Companies)
On the Company Search screen, highlight the name “Place Your Name HERE” and click the Edit button.
On the Company Entry/Edit screen, go to the “Name” field, **DELETE the words “Place Your Name HERE” and then type in your own company/farm name.** Enter your address and then enter your phone number, fax number, etc. and click “Save” when done. If you need to, you can come back to this screen at a later time and set up additional companies.

NEXT

Set up Farms

*(Master Files > Farms)*

Click the Add button and enter your farm first and any other information such as address and phone number. When finished, click the “Save” button. Add any other farms that you will be interacting with during the course of the year. Other “Farm” entries could include the stallion farm where your mare will be sent for breeding or the name of a clinic where you might send horses for veterinary services or the name of the track where your horse is currently in training.

Select and Review Preferences

*(Setup > Preferences)*

- Application Settings > Company Settings
  - Select a default breed from the drop down list
  - Select your farm name from the drop down list as the “Default Farm”
**Set up Clients**
(Master Files > Clients)
Click the “Add” button and first add yourself as a client and then add each of your clients, whether an individual, a farm, a company, etc. Enter as much information as you have on each client and click “Save”.

**Set up Boarding Types**
(Master Files > Boarding Types)
Add a “Boarding Type” for each type of horse you have on your farm and the daily rate you will be charging for each Boarding type. The board type is used for billing and the daily rate is the amount a horse will be charged per day to board with you. (Mare, Mare under lights, Barren mare, Mare pasture board, Foal, Weanling, Yearling, Sales Prep, etc.)

**Set up Horse Types**
(Master Files > Horse Types)
Similar boarding types can be grouped together in one Horse Type making it easier to produce lists or perform mass procedures. For example, you may have Mare, Mare under lights, Barren mare or Mare pasture board but they are all “Mares”. If you have a Horse Type of “Mare”, you can associate all of the other “Mare Boarding Types” to the Horse Type of “Mare”.

**Set up Procedure Categories**
(Master Files > Procedure Categories)
Add general categories that your specific procedures will fall within such as: (Blacksmith, De-Worm, Vaccinations, Medical, Vanning, Tack & Equipment, Reproductive, Registration/Nominations, Outside Vet, etc).

**Set up Procedure Masters**
(Master Files > Procedure Masters)
Add each of the specific procedures that may be performed on a horse and the standard charge if there is one. (Palpation, Ultrasound, Trim 4, Coggins, Foal Profile, Tetanus Vaccination, Jockey Club Registration, Neck Strap, Culture, etc).

**Set up Horses**
(Master Files > Horses)
Add all horses that are currently on your farm or horses that you wish to track. Enter an Ownership date and select the owner’s name from the client master list. Enter an arrival date if the horse has arrived on your farm and select a Boarding Type.
**Review Master Lists**
(Setup > Master Lists) *(Optional)*
You should review the categories so that you are familiar with the items in each category and make changes as needed. To add an item to a category click the “New” button, type in your entry and then click “Save”.

**Review Billing Setup**
(Setup > Billing Setup) *(Optional)*
Billing Codes. The system has been preloaded with all necessary G/L codes. Only if your farm uses specific G/L accounting codes will you need to change them.
Service Charge. If you charge late fees for overdue invoices, then enter codes for each rate you plan to use.
G/L Account Setup. The system has been preloaded with all necessary G/L codes. Only if your farm uses specific G/L accounting codes will you need to change them.

**Initial A/R Client Balances for New Users Only**
(Setup > Billing Setup > A/R Maintenance)
For each client listed, type in any outstanding balances from your previous billing in the appropriate column (Current, Over 30, Over 60, Over 90, Service Charges). The amount entered here will show up as the beginning balance on the client’s first invoice.
The following section outlines the step-by-step process of setting up your farm’s information and entering your horses’ daily activity into the Windows Horse Farm Management program.

1. **Set up your Company**
   - Select “Setup” from the menu
   - Select the “Companies” menu item to open the form
   - Highlight the company name “Place Your Name HERE” and click the “Edit” button. In the “Name” field, DELETE the words “Place Your Name HERE” and **type in your own company/farm name**. Enter your address. Click the button “New” to enter your phone number, fax number, e-mail address, etc. and click “Save” when done.
   - Please note that you can set up more than one company if needed. For example, you may want to keep your Breeding stock in one company and your Sales stock in another separate company.
   - To add a new company select Setup > Companies and click the “Add” button. In the “Name” field type in the name of the additional company and enter the address, the phone number, fax number, etc. and click “Save” when done.
**TIP:** If your company logo is available, you can click the “New” button and browse for your logo and then click the box “Show on Invoice”. Your logo will then print out in the heading on the top, right-hand side of your client invoices. To remove the logo, click the “Remove” button in the Logo area on the Company Entry/Edit screen.

- **G/L Account.** This is not a required field. If you do not need to identify a specific G/L Account number for your farm, you can leave this field blank.
2. Set up farms
   - Select “Master Files” from the menu
   - Select the "Farms" menu item
   - Click the “Add” button. First, add your own farm
   - Add any other farms or facilities that you will be interacting with during the breeding season or throughout the year. Enter as much information as you can, including the main phone number, contacts, Veterinarian Name/Number and any Breeding Requirements.
   - Other farms would include those that you send your mare to for breeding. Add any other farms that you will be interacting with during the breeding season. Other “Farm” entries could include the stallion farm where your mare will be sent for breeding or the name of a clinic where you might send horses for veterinary services or the name of the track where your horse is currently in training.

3. Review and Select Preferences
   - Select “Setup” from the menu
   - Select the “Preferences” menu item to open the form
   - Select “Company Settings”
   - Select the default breed from the drop down list
   - Select your own farm name from the drop down list as the “Default Farm”
It is important to make note of the Location and name of the Save Folder. This folder will hold all of the saved invoices from the closed billing periods and it should be backed up on a regular basis.

**Application Settings**

If you want to be able to type horse names in lower case and let the system automatically convert them to uppercase, check the box next to “Capitalize All Horse Names”
Mare/Foal Settings

- Days Between Last Day Bred and Foaling Date. This number is pre-populated but can be changed. This is the number used to calculate the Projected Foaling Date which shows up on the Mares Bred Summary Report, the Foaling Mares By Location Report and the Due Date which can be found on the Teasing Worksheet.

- New Foal Naming. When a new foal is entered into the system via the Mare Entry/Edit > Foaling Info you can select how the name will appear. You can select to default the new foal’s name to be the Mare Name first and then the Season Year (Blackeyed Susan 12), or the Season Year first and then the Mare Name (12 Blackeyed Susan).

- Disregard the “Stallion Mare” preferences unless you have purchased the HFM Stallion Module.
Billing Settings

Print Company Name on Invoices
- If you want your name, address, etc. to automatically appear as the heading on your invoices, leave the “✓” marked in the box. If you are using pre-printed stationery and do not want the system to automatically generate the heading, simply un-check the box next to Print Company Name on Invoice to remove the “✓”.

Print Board Descriptions on Invoice
- Invoices usually show “Board @ $xx.xx per day”. If the Print Board Type Description On Invoice is checked, the invoice will show “Sales Prep @ $xx.xx per day”.

Check for Duplicate Procedures
- This option will warn you if you have entered a duplicate item within the same entry set

Disable the Warning When Removing A Billing Option On Procedure Detail
- If you DO NOT want the system to warn you that you have removed a procedure from invoicing, check the box next to “Disable the Warning When Removing A Billing Option On Procedure Detail”.

Tax Name
- For Non-US clients, enter the tax name that will be used in billing (such as HST, GST, etc.).
Display Auto-Allocation Options

- When this box is checked, options will be displayed to help automate the process of applying credit invoices and unapplied payments to outstanding invoices.

Billing Settings > Standard

- Default Standard Service Charge. Select the default service charge from the drop down menu. This will auto-populate in the service charge field on the client master file each time a new client is added to the program.
- Standard Billing Starting Invoice #. This is the default number that will be used as the first number on your first invoice generated through the billing menu. This number can be changed but it has to be a number that is greater than any currently created invoices.
- Summarize Invoice History Details. If checked, the invoice will be shown in summary format. If unchecked the invoice will be shown in detail format.
- Show Horse Charge Details on Invoice. If checked, the invoice will print the detail page for all of the horse charges. If unchecked the details will not be printed.
- Show Procedure Summary on Invoice. If checked, the invoice will print the charges by category page. If unchecked there will be no summary page printed.
- Use double window envelope. If checked, the invoice heading will be shifted so that the address shows through a standard double window envelope.
Standard Billing Invoice Comments. Enter any information in this area that you want to appear on client invoices such as: Net 30, Payable Upon Receipt or Happy Holidays. The text that is entered here will appear on the first page of all client invoices.

User Settings

- If you want your reports to print to the screen first before printing to a printer, check the box next to “Default All Reports To The Screen”
- Each person can select his/her own Required Field Color and the Alternate Required Field Color from the drop down list.
- Show reports with formatting bands. If checked, all reports will display formatting bands. If unchecked there will be no formatting bands on any of the reports.
Email Settings

Please contact The Jockey Club (800) 333-1778 or (859) 224-2800 for detailed instructions on the Email Settings.

4. Set Up Clients
   Select "Master Files" from the menu.
     o Select the "Client" menu item
     o Click the “Add” button to add each horse owner, client, billing entity, etc. to the system.
- First add yourself as a client.
- Next, enter all of your clients. You can enter just the last name and first name and leave the Farm/Company name blank or you can enter just the farm name or you can enter the last name, first name and the farm name. Enter as much information on each client as possible.
- When assigning ownership for horses you will be selecting clients from the Client Table that you have created.

**Tax ID:** This area is more for your reference and will only appear on the Client Listing Report. It provides a place to note the Social Security Number of the client or the Federal ID Number of the company that has been entered on this screen.

**Service Charge Setup:** Service charges are applied on an individual basis. If you want the system to automatically calculate service charges for a particular client, select the appropriate service charge code from the drop down list.

**Miscellaneous:**
- **Business Owner:** This check-box is for your visual reference. If checked, it indicates to you that the person listed (Last name, First name), owns the Farm/Company that has been entered on this screen.
- **Use Farm/Company Name Only.** If the farm is the billing entity and not the client name, then check the “Use Farm/Company Name Only” box and only the farm/company name will appear on the invoices and reports.
Active: When this box is checked it indicates that the client is Active. If you uncheck the box the client will become Inactive.

Suppress Billing always defaults “Blank”. This means that the system will automatically keep track of all charges for this client and that the system will generate an invoice for this client. If you check the box, this client’s billing becomes suppressed and no invoice will be generated.

Exempt Code: If you are using the Service Tax options and have set up the Service Taxes and the Tax Name (HST, GST, etc.) you will use this field to enter an Exempt Code for those clients that are not eligible to be charged a Service Tax.

Invoice Distribution Method. The default for this field is “Standard”. If you wish for a client to receive invoices via E-mail, select “Email” from the drop down list.

Note: The Client Comments area is for your reference. These comments do not print on any report.

Note: The Saved Documents area is a place that allows you to save copies of photos, scanned documents, videos, etc. directly into HFM. Any file that is on your computer can be added to this area.

Additional Client Entry/Edit Screen Options

Mailing Codes: One or several mailing codes can be assigned to each client. If a mailing code is assigned, you will be able to print labels based on any of the pre-defined mailing codes. You can add as many Mailing Codes to each client as needed.
To select a new mailing code for the client, click the button “New”, highlight the Mailing Code you want to add to the client and click “Select.”
You can add as many Mailing Codes to each client as needed.
To populate the Mailing Code List, go to Setup > Master Lists and select “Mailing Code” from the drop down category list. Click on “New” and enter each item that you want to include in the Mailing Code list.
Billing Info: This is a look-up screen only. It will show all current activity for that particular client.
**Payments:** Receipts for a client can be entered or edited from the Client Screen. To enter a new payment, click the button “New”. To look at an existing Payment, highlight the entry and click “Edit”.

<table>
<thead>
<tr>
<th>Date</th>
<th>Service Type</th>
<th>Amount</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/01/2006</td>
<td>Stud Fee</td>
<td>$2,000.00</td>
<td>Partial #003</td>
</tr>
<tr>
<td>01/01/2006</td>
<td>Stud Fee</td>
<td>$5,000.00</td>
<td>Partial part</td>
</tr>
<tr>
<td>12/18/2005</td>
<td>Stud Fee</td>
<td>$1,000.00</td>
<td></td>
</tr>
<tr>
<td>02/15/2004</td>
<td>Standard</td>
<td>$369.15</td>
<td>Print in full</td>
</tr>
<tr>
<td>02/03/2004</td>
<td>Standard</td>
<td>$375.00</td>
<td>Prior Bal</td>
</tr>
<tr>
<td>01/25/2004</td>
<td>Standard</td>
<td>$250.00</td>
<td>More Board</td>
</tr>
</tbody>
</table>
Adjustments: Adjustments can be entered or edited from the Client Screen. To add a new adjustment, click the button “New”. To look at an existing Adjustment, highlight the entry and click “Edit”.

![Adjustments Table]

*Note: The table shows different dates and amounts with corresponding comments.*
**Horses:** This is a look-up screen only. It will display all of the horses for which this client has ownership. You can select to view either currently boarding horses or all horses.
**Other Addresses**: This screen provides a place to store any additional addresses for this client. Select “New” when entering a new address and then select the desired item from the “Category” drop down list.

**Note**: If you select the category of “Billing”, the system will use this address for this client’s invoices instead of the address entered on the Client info. page. All other categories serve only to store the additional addresses.
If you have entered any additional addresses for a client, the “Other Addresses” tab will reflect the number of additional addresses that have been entered.

**TIP:** You can enter a client’s street or P.O. Box, skip the city and state, enter the zip code and the system will automatically enter the city and state for you.

**TIP:** If you select a foreign country, the country code for that country will automatically appear above the main phone number.

**TIP:** When entering phone numbers, type in the number without spaces or dashes and the system will automatically format it for you. For example, 8592242800 = (859) 224-2800.

**TIP:** Enter any additional phone numbers for each client in the Phone/E-Mail Entries area (fax, home, cellular etc.). Click the button “New” and simply select the type from the drop down list.
5. Set up Boarding Types

Select “Master Files” from the menu
Select “Boarding Types” from the menu

Add a “Boarding Type” for each type of horse you have on your farm and the daily rate you will be charging for each Boarding type. The board type is used for billing and the daily rate is the amount a horse will be charged per day to board with you. (Mare, Mare under lights, Barren mare, Mare pasture board, Foal, Weanling, Yearling, Sales Prep, etc.)

- [Optional] Although not required, the system allows you to identify a Debit G/L Account for each Boarding Type. If each horse type has a unique G/L Account Number, the system will summarize the boarding charges for each Board Type at Month End Billing.

- [Optional] Comments entered in the “Boarding Type Comments” field will appear on the Horse Type Listing report (Reports> Base Reports>Boarding Type Listing)
6. **Set up Horse Types**  
Select “Master Files” from the men  
Select “Horse Types” from the menu  
Click “New” to add each Horse Type

![Horse Types](image1)

**Note:**  Similar Boarding Types can be grouped together in one Horse Type making it easier to produce lists or perform mass procedures. For example, you may have Mare, Mare Under Lights, Barren Mare or Mare Pasture Board but they are all “Mares”. If you have a Horse Type of “Mare”, you can associate all of the other “Mare Boarding Types” to the Horse Type of “Mare” making it much easier to perform mass procedures on a particular Horse Type which includes several Boarding Types as well as making it easier to produce reports for one particular Horse Type which may include several *Boarding Types*. 

![Boarding Type](image2)
7. Set up Procedure Categories

Each specific procedure that is performed on a horse falls into a general “Procedure Category”. This allows procedure category totals to appear on your clients’ invoices (i.e. Total Vaccination Charges, Total Blacksmith Charges, etc.)

- Select “Master Files” from the menu
- Select "Procedure Categories" menu item
- Click “Add” to add each Category
- Enter a category name. It should be a general, descriptive name such as Blacksmith, De-worming, Vaccinations, Medical, Nominations/Registration, Tack & Equipment, Vanning, etc.

- Select whether or not you want items in this category to print on your departure form (No, Yes, Last). If you select “No”, the procedures that have been performed in this category will not print on the departure form, if you select “Yes”, the procedures that have been performed in this category will print on the departure form. If you select “Last”, only the last occurrence of the procedures that have been performed in this category will print on the departure form.

- [Optional] Select an appropriate billing category.
- [Optional] Enter a G/L Account number for this category. If a unique G/L Account number is assigned to each category, the system will summarize charges for each category at Month End Billing.

**Note:** The “Procedure Category Comments” area is for your reference. These comments do not print on any report.
8. Set up **Procedure Masters**

- Select “Master Files” from the menu.
- Select "Procedure Masters" menu item
- Click “Add” to add each individual procedure
- Procedure Name: Enter the name of each specific procedure that may be performed on a horse on a regular basis such as Rabies Vaccination, New Halter, Deworm – Strongid, Palpation, Ultrasound, Trim 4, Jockey Club Registration, IgG, Biopsy, Bute Paste, CF Blood, Infuse – Gentocin, etc.

- Default Unit Charge: Enter the Standard Charge for each procedure. If there is no standard charge you cannot leave the field blank, you must enter -0-.
- Procedure Category: Select the corresponding Procedure Category for that procedure from the drop down list.
- Default Teasing Chart Results: Works in conjunction with the “Results on Teasing Chart” option. For example, “P” could be used on the teasing chart to indicate when the mare was Palped, “U” could be used on the teasing chart to indicate when the mare had an Ultrasound, “B” could be used on the teasing chart to indicate when the mare was bred. The Teasing Chart Results field is limited to 3 characters.
- **Unit Type:** Select the Unit Type for this procedure from the drop down list.

- **Default Performed by:** If this particular procedure is normally performed by a specific vet or company or blacksmith, select the person/company from the drop down list and the Default Performed By will auto populate on the procedure entry/edit screen.

- **Departure Print:** Select whether or not this procedure will print on your Departure Form (No, Yes, Last). If left blank, it will default to whatever you selected when you set up the Procedure Category. Whatever is selected in the Procedure Master Entry/Edit form will take precedence over what is entered in the Procedure Category Entry/Edit form.

- **Default to Appear on Invoice:** All Procedure Masters will default to appear on the client invoice. If you want to record a procedure for a horse but want it to always default to NOT print on the invoice, uncheck the box.

- **[Optional] Override G/L Acct:** You can enter a General Ledger Account number for this specific procedure that will override the General Ledger Account number in the Procedure Category Entry/Edit screen. For example, you might set up the category “Vaccinations” with a General Ledger number of 3000. Procedures that fall within that category such as Rabies Vaccination would have an Override G/L Account Number of 3000.10, Tetanus vaccination would be 3000.11, Strangles vaccination would be 3000.12, etc.
[Optional] Health Type: When entering procedures you can mark any number of procedures as “Health Type”. If marked as a Health Type, you will have the option to show only records that are a “Health Type” when you print a horse’s Health Record (Reports>Misc. Reports>Health Record). For example, you might mark the procedure “Rabies Vaccination” as a Health Type but you would not mark the procedure “Vanning” or “Neck Strap” as a “Health Type”.

---

Page 55 of 324
[Optional] Movement/Transfer Procedure: If a procedure is marked as the “Movement/Transfer Procedure”, additional fields will be available for input on the Procedure Entry/Edit screen. When entering this procedure for a horse you will be able to change the Farm, Location, Barn, Stall and Field from the Procedure Entry/Edit screen and this information will automatically be updated in the horse’s master file.

[Optional] Update Mare Exam Status: If a procedure is marked to “Update Mare Exam Status”, additional fields will be available for input on the Procedure Entry/Edit screen. When entering this particular procedure for a horse you will be able to enter the Pregnancy Exam Status (Status After Exam). This information will automatically update the “Status After Exam” field in the Mare Information screen.
- [Optional] Foaling: Enter a procedure called “Foaling or Foaling Date or Foaled” and check the box “Foaling”. This will enable the system to automatically create a procedure in the mare’s health record showing the foaling information that has been entered in the Mare Information Screen > Foaling Info Tab. Often the master procedure “Foaling Fee” is marked as the Foaling procedure eliminating the need to manually enter the foaling fee. This procedure will also automatically appear on the client’s invoice.

- You can have only one procedure marked as your Foaling Procedure.
- [Optional] Recurring: A procedure such as Regumate, SMZ Tabs, Vitamins/Supplements, Bute, etc. would be examples of Recurring procedures. If a procedure is marked as Recurring you will be able to enter the beginning date of a procedure and an ending date. If the procedure will be ongoing, the end date can be left blank (as in Regumate daily).
- [Optional] Breeding: Enter a procedure called “Bred or Breeding or Breeding Dates” and check the box “Breeding”. This will enable the system to automatically create a procedure in the horse’s health record stating that the mare was bred to a particular stallion on a particular day. This procedure will also automatically appear on the client’s invoice.
  - You can have only one procedure marked as your Breeding Procedure

- [Optional] Results on Teasing Chart: If a procedure is marked to have “Results on Teasing Chart”, additional fields will be available for input on the Procedure Entry/Edit screen. When entering this procedure for a horse you will be able to enter information for LO (Left Ovary), RO (Right Ovary), Cervix and Other. This information will automatically appear on the Teasing Chart. The Results fields are limited to 3 characters.
Coggins: If there is a procedure marked “Coggins”, the field “Last Coggins” on the horse master file entry/edit screen will automatically be updated with the date that the coggins was last performed.
- [Optional] Arrival/Depart Procedure: Enter a procedure called "Arrival/Departure" and check the box "Arrival/Depart Procedure". This will allow the system to automatically create a procedure in the horse's health record stating that the horse arrived on a particular date from a particular place and/or departed on a particular date and shipped to a particular place. This automatic entry will take place when you enter an arrival or departure date in the Horse Entry/Edit > Boarding page.

- You can have only one procedure marked as your Arrival/Depart Procedure.
[Optional] Date of Birth: If a master procedure is marked as the “Date of Birth” procedure it will enable the system to automatically create a procedure in the foal’s health record indicating that the foal was born and it will include any foaling information that was entered on the Mare Information Screen > Foaling Info Tab. Often the master procedure “Foal Date of Birth” is marked as the Date of Birth procedure eliminating the need to manually enter a procedure to record the foal’s date of birth.

This automatic entry will take place when you enter foaling information in the Mare Entry/Edit > Foaling Info tab and click “Add Foal as New Horse”

You can have only **one** procedure marked as your Date of Birth Procedure
Note: The “Proc Master Comments” area is for your reference. These comments do not print on any report.

Note: After you have finished setting up the program, you will be entering all of the daily procedures that have actually been performed on your horses. At that time, you will be selecting one of these procedures from a master listing on the procedure detail screen.
9. Horse Entry

- Select “Master Files” from the menu.
- Select “Horses” menu item
- Select “Add” to add each horse to the system.

- Enter the horse’s name.
- Select the Breed (if you have Default Breed selected in the Preferences section this will be added automatically).
- The default farm (yours) will be added automatically.
- Enter all of the basic information about this horse.
- Next, you must assign an owner to this horse.

**TIP:** The “Horse Comments” field on the Horse Entry/Edit form is for your reference and does not appear on any report.

**TIP:** Expected Arrival Date on the Horse Form is the date that you expect the horse to arrive on your farm – NOT the actual arrival date. This field is optional and can be left blank.

**TIP:** Expected Departure Date on the Horse Form is the date that you expect the horse to depart from your farm – NOT the actual departure date. This field is optional and can be left blank.
**TIP:** If you type a comment in the Departure Notice field, that comment will appear on your departure form.

*When adding a horse to the system, you are required to identify the owner of the horse for billing purposes.*

While you are still on the "Horse Entry/Edit: screen…

- Click on the "Ownership" tab
- Click "New Date" (this is usually the day that the horse arrived on your farm). (A)
- Enter the ownership date and click “OK”
- The Client Lookup screen will open after you have clicked “OK”. Find the current owner of the horse from the list and click the button “Select”.

![Client Search Popup](image)
If more than one person owns the horse, click on the “New” button located under and to the right of the Owner section and select the next owner. Each owner is entered on a separate line, so be sure to indicate the correct ownership percentages for each client.
All board and procedure charges will be billed to owners of horses based on the percent of ownership. **Note:** Total Percent Owned must always equal 100%

**TIP:** Ownership Dates: The system will store all ownership changes and will process billing based on any combination of ownership percentages. When ownership changes, click on the “New Date” button and enter the date the new ownership takes effect and then select the new owner(s) from your client master list. Do not delete prior ownership dates/clients when adding new ownership.

**TIP:** Exception Board Rate: If the owner(s) is to be charged a boarding rate different from what you have established as standard, enter that rate in the Exception Board Rate column. For example, if your standard rate for a mare is $18.00 per day and you want to charge a client $15.00 per day, enter $15.00 in the Exception Board Rate column. If you don’t want to charge a client anything for board, enter $0.00 in the Exception Board Rate column. If your standard rate is $18.00 per day and you want to charge a client $22.00 per day, then enter $22.00 in the Exception Board Rate column, etc.
**TIP**: Exception Procedure %: If there is more than one owner and you would like to charge a fixed percentage of all procedures to one owner and a fixed % to the other owner(s), you can enter that procedure exception percent in the field provided. Procedure Exception % must add up to 100%.

- After you have entered the ownership for the horse, **you must let the system know that the horse has arrived on your farm if you want the system to calculate the daily boarding charges.**
  - Click the "Boarding" tab to open the Arrival / Departure / Boarding screen.
  - Click the button "New Arrival", enter the arrival date and click "OK".
  - Select the "Vanned by"
  - Select the "Arrived From"
  - Select a "Boarding Type" from the drop down list
  - Daily board charges for each horse will begin accumulating based on the arrival/departure date. Horses will be charged board “day in” and “day out”.
TIP: Exception Rate: If the owner(s) is to be charged a boarding rate different from what you have established as standard, enter that rate in the Exception Rate field above the Standard Rate. An Exception Rate entered on the Boarding screen will cause the system to charge the exception rate only when the horse is at this specific “Boarding Type”. If a horse is “Broodmare” with the exception rate of $10.00 and then changes to “Sales Prep”, the owner will be charged the standard rate for “Sales Prep” and the Exception Rate for “Broodmare” will no longer apply.

TIP: If you have entered an Exception Rate in the Ownership screen (Exception Board Rate) and an Exception Rate in the Boarding screen, the Ownership Exception Board Rate will be the controlling rate.

TIP: The Boarding screen will store all of the history of the horse’s arrivals and departures and board type changes. When making a new entry, do not type over or remove the existing dates. Always click “New Departure”, “New Arrival” or “Change Boarding”.

Page 71 of 324
**TIP:** The “Boarding Comments” field on the Boarding form is for your reference and does not appear on any report.

**TIP:** The system will charge one day’s board on the day the horse arrives on the farm and will continue through the day the horse departs the farm (inclusive).
Additional Options on the Horse Master Entry/Edit Screen

- **Insurance** – Click the button “New” and enter and store current insurance information on each horse (Insurance Company, Contact, Phone, Fax, Policy Number, Coverage, etc.)

![Horse Insurance Entry/Edit](image)

- **Procedures** – Enter or edit procedures that have been performed to this horse either from here or from the Procedures menu item. (Procedures > Procedures Performed)

- **Mare Info.** – Click the button “New” to add new information or click the button “Edit” to view information that has already been entered. You can enter breeding information through this screen or through the Procedures menu item. (Mare Info > Mares)

- **Notes** – Click the button “new” and enter additional information pertaining to this horse. Enter a date, select the procedure from the drop down list, select the Performed By, Farm and then enter any additional comments in the Horse Notes Comments section. Information entered here will only appear on the Horse Notes Report (Reports > Misc. Reports > Horse Notes). Information entered here does not appear on invoices. The Notes screen can be used to enter horse markings, evaluations, workouts, etc.
Sales – Store information on the sales history of this horse. Click the button “New” and add sale information.

Nominations – Enter and store information on what nominations have been submitted for this horse. Click the “New” button and select a nomination from the list.
- **Equineline** – You can order Equineline reports directly from the Horse Entry/Edit screen.
Verify button – This is a billable service. When enabled it will verify the name, sex, color, Date of Birth and pedigree for this horse. Please contact The Jockey Club directly to purchase this feature.
Saved Documents – This is an area where documents relating to this horse can be saved. Click the “Add” button and then click the “Browse” button to browse for the file. Enter the Name for the document and click “OK” when finished.
10. **Review Master Lists [optional]**
   No changes are needed unless your farm uses a different set of terms
   Select “Setup” from the menu
   Select “Master Lists”
   Select the list category that you wish to review. This displays the list of user choices for that category. Example: Address Category
You should just review the categories and not make changes at this time. If your farm needs additional items than those that are shown, they can be added by clicking the button “New” See (A)
When you click the “New” button, a new, blank line will appear in the list. Type the new entry in the new blank line and then click “Save”.

<table>
<thead>
<tr>
<th>Item</th>
<th>System Defined</th>
</tr>
</thead>
<tbody>
<tr>
<td>cc</td>
<td>False</td>
</tr>
<tr>
<td>Cup</td>
<td>False</td>
</tr>
<tr>
<td>Mg</td>
<td>False</td>
</tr>
<tr>
<td>ml</td>
<td>False</td>
</tr>
<tr>
<td>Oz</td>
<td>False</td>
</tr>
<tr>
<td>Scoop</td>
<td>False</td>
</tr>
<tr>
<td>Tablets</td>
<td>False</td>
</tr>
<tr>
<td>Tube</td>
<td>False</td>
</tr>
<tr>
<td>Vial</td>
<td>False</td>
</tr>
</tbody>
</table>
**Note:** If you select the Category of “Mare Status”, you will see that the system has defined several of the items as “True”. The system requires these specific items to be used exactly as they are shown in order for the associated reports to be correct and will not allow you to change or delete these items. If you select an item marked as “True” you will see that the button “Remove” is not active, thus you cannot change or remove any item marked as “True”.

<table>
<thead>
<tr>
<th>Item</th>
<th>System Defined</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barren</td>
<td>True</td>
</tr>
<tr>
<td>Donor - Recip In Foal</td>
<td>False</td>
</tr>
<tr>
<td>In-Foal</td>
<td>True</td>
</tr>
<tr>
<td>Maiden</td>
<td>False</td>
</tr>
<tr>
<td>Not Bred</td>
<td>True</td>
</tr>
<tr>
<td>Slipped</td>
<td>True</td>
</tr>
<tr>
<td>Unknown</td>
<td>True</td>
</tr>
</tbody>
</table>
11. Review Billing Setup [optional]
(Setup > Billing Setup)

Since the Horse Farm Management System uses General Ledger Account numbers to allocate charges and payments appropriately, G/L Account numbers should be identified prior to using the system.

**Note:** The system has been preloaded with all necessary G/L codes. Only if your farm uses specific G/L accounting codes will you need to change the preloaded codes.

**Billing Codes**
- Select “Setup”
- Select “Billing Setup”
- Select “Billing Codes”
The system is preloaded with a Default Debit and a Default Credit G/L Account number. Unless you want to use specific G/L Account numbers, you do not need to do anything in these fields.

You can leave the numbers that have been pre-loaded or you can enter account numbers designated by your farm.

**Note:** When you are entering your cash receipts on a daily/regular basis, you will be selecting this payment code from a drop down list. Again, this payment application code indicates to the system that the cash receipt will be applied to your Standard (Board) billing.
**Note:** Your “Month End Billing”, or “Board Billing” consists of boarding charges as well as procedure charges. When a payment is made, you will not be separating the payments into “Board Payments” and “Procedure Payments”.

**TIP:** Your Billing Application Code Default Debit Account can be either numerical or alphabetical.

**A/R Maintenance (New Users Only)**
- Select “Setup”
- Select “Billing Setup”
- Select “A/R Maintenance”
- A list is displayed with all of the clients that you have entered into the system.

```
Note: The amounts entered in this table will be reflected as the beginning balance on the first billing run performed on HFM.
```
• **Important:** You can only edit A/R balances in this manner during your initial install/configuration process. Once you have Generated and Finalized a billing, you can no longer edit information on this page.

**Service Charge [optional]**

If you charge late fees for unpaid invoices, you will enter codes for each rate you plan to use. The Horse Farm Management System will automatically apply a “late fee” to any unpaid balances for those clients that you specifically indicate should be charged late fees/service charges. A client will never be charged late fees unless you specifically mark it as such. To set up the Service Charges/Late Fees:

- Select “Setup”
- Select “Billing Setup”
- Select “Service Charge”
- Click the button “New” to add each Service Charge
Each line can have a different Service Charge Code with different percentages. Depending on your specific needs, you can enter just one service charge type or several. Click the button “New” then enter the Service Charge Description and the rate in the 30, 60 & 90 columns.

**Service Tax**  
(Setup > Billing Setup > Service Tax)  
**Note:** This feature is used by international clients. It allows the entry of a service tax such as GST, HST, VAT, etc. to be charged on boarding and procedures.

- Select “Setup”  
- Select “Billing Setup”  
- Select “Service Tax”  
- Click the button “Add”  
- Add the tax Name  
- Add the Rate  
- Add the G/L Account Number [optional]  
- Go to Setup > Preferences > Billing Settings and enter the Tax Name

See (A)
- Go to Master Files > Boarding Types and select the appropriate TAX name from the drop down list.

- Go to Master Files > Procedure Master and select the appropriate TAX name from the drop down list.
When you enter a procedure for a horse that has been marked to have the Service Tax applied, the information will automatically populate on the procedure entry screen.

If you do not want a client to be charged the Services Tax, enter the Exempt Code on their Client master page. See (A)
G/L Account Setup [optional]

- Select “Setup”
- Select “Billing Setup”
- Select the “G/L Account Setup”

**Note:** The system has been preloaded with all necessary G/L Account Numbers. Only if your farm uses specific G/L accounting codes will you need to change the preloaded Account Numbers.
HEALTH RECORD ENTRIES

Procedures

1. **Adding Procedures That Have Been Performed on Horses**
   
   **Procedure Detail**
   
   - Select “Procedures” from the menu.
   - Select the "Procedures Performed" menu item
     (You can also get to this screen by clicking the “Procedures” tab in the “Horse Entry/Edit” form)
   - Click on the horse name from the list and click “Select”
   - To edit an existing procedure click on the procedure shown on the list and click "Edit"  
   - To enter a new procedure click the button "Add"
   - **Performed:** Enter the date that the procedure was performed
   - **[Optional] You can enter the time that the procedure was performed by typing in the time on the same line as the date. Entering a time will prompt the system to list procedures chronologically on the pre-billing report and on the invoices. If no time is entered, the system lists procedures by date but in a random order.**
   - **Performed By:** Enter the name of the person that performed the procedure (Vet name, Blacksmith name, Farm Name, Farm Manager Name, etc.) or pick the name from the drop down list.
   - **[Optional] Invoice Ref.:** Enter the invoice number.
   - **[Optional] Procedure:** Pick the name of the procedure that was performed from the drop down list.
   - **[Optional] Override Description:** You can enter an “Override Description” for the procedure that was performed. For instance, you might have “Blacksmith - Equilox” as the procedure and want to type in an Override as “Blacksmith – Equilox LF” **See (A)**
   - **[Optional] Charge:** You can change the amount in the “Charge” field if the amount charged for the procedure is different than the standard charge that you have set up. For example, the standard charge for Equilox was set up at $125.00 but in this particular case the blacksmith had to use additional time and materials on the hoof which increased the amount charged to $135.00. You can highlight “$125.00” and type in $135.00 and the client’s invoice will now reflect the correct charge of $135.00. **See (B)**
   
   - **Or, if the Quantity is 1.00 you can, in many cases, change the quantity to another number and the charge field will automatically update to show the correct amount.**
- **Appear on Invoice?**: This box always defaults with a ✓ in the box unless you have changed the default setting on the Procedure Master. When “Appear on Invoice?” is checked, it indicates that this procedure and the amount charged will appear on the client’s invoice.
- If you un-check the box, this procedure and the associated charge will not appear on the client’s invoice.
o [Optional] Print Procedure Comments on invoice?  If checked, any comments that have been entered in the “Procedure Comments” area will appear on the client’s invoice.

o [Optional] Print Results on invoice?  If checked, any Results that have been entered in the “Results Details” area will appear on the client’s invoice.

o [Optional] Procedure Comments:  Type in comments pertaining to the procedure that has been performed. These comments will appear on the departure form and on the procedures performed report. Additionally, these comments will appear on the client’s invoice if the “Print Procedure Comments on Invoice” box has been checked.

**Charges**

o Unit Charge:  This is a read only field and will display the Unit Charge information that has been entered on the Procedure Master page.

o Quantity:  This will default to “1.00”. If the quantity number is changed the Charge will automatically be updated to reflect the corresponding amount.

o Charge:  Defaults to whatever amount that has been set up in the Procedure Master page. This charge can be changed on this screen if necessary.

**Results Details**

o [Optional] Results:  Enter any additional information regarding the procedure that has been performed. This information will appear on the departure form, health record report and the procedures performed report.

o [Optional] Received Date:  Enter the date that you received the results. Information entered in the Received Date field does not appear on any report.

**Scheduling Details**

o [Optional] Future Scheduling:  If you would like to schedule this specific procedure to be done again to this particular horse on a particular date in the future, enter the date in this field. Procedures that are scheduled will be printed on the Scheduled Procedures Due Report (Procedures>Reports>Scheduled Procedure Due).

o [Optional] Scheduling Comments:  Enter any comments pertaining to the procedure that has been scheduled in the future. These comments will appear on the Scheduled Procedure Due Report.

**Multiple Entries**

o To enter the same (or similar) procedures on multiple horses do the following:
  - Enter the first procedure as explained above.
  - Single-click the “Save/Add” button to save the current procedure and activate a new record.
  - Select the next Horse from the drop down horse list.
• Single-click the “Fill From Previous” button to populate all other fields with the previously entered data (Performed, Procedure, Performed By, Invoice Reference # and Charge).
• Edit any of the fields that need to be changed and repeat these steps as needed.

  o To enter multiple procedures on a single horse do the following:
    • Enter the first procedure as explained above.
    • Single-click the “Save/Add” button to save the current procedure and activate a new record.
    • Single-click the “Fill From Previous” button to populate all other fields with the previously entered data.
    • Edit any of the fields that need to be changed and repeat these steps as needed.

Editing Procedures
When editing a procedure that has already been entered:
• Select “Procedures” from the menu.
• Select the "Procedures Performed" menu item
• (You can also get to this screen by clicking the “Procedure Entry” tab in the “Horse Entry/Edit” form)
• Find the horse name in the list and press “Select” or double click on the horse name that you want.
• From the Procedures Detail screen select the procedure you want to edit and press “Edit” or double click on the selected procedure to open up the record.
You can Search By Procedure, by Procedure Performed Date or by Unbilled Procedures By Date

- After editing the procedure, click “Save”.

**TIP:** All procedures automatically become part of the horse’s health record and the monthly billing. All procedures entered will appear on the client’s invoices *unless* either the “Appear on Invoice” option was unchecked (on the Procedure Detail screen) or the "Suppress Billing" option was checked (on the Client Entry/Edit form) for the owner of the horse.
2. Adding Mass Procedure Entries
   - Select "Procedures" from the menu.
   - Select "Mass Procedures" menu item

   ![Mass Procedures window]

   - Click "New" to enter a new Mass Procedure or click on an existing Mass Procedure and click "Edit" if you want to view and/or edit an individual entry in an existing Mass Procedure.
- Click on “Boarding” to view a list of horses that are currently “Boarding” or click on “All” to view a list of the horses whether they are currently boarding or not and then click “Apply Filter” to see the horse list.
To generate a Mass Procedure for one particular group of horses, select the Horse Type from the drop down list.

Click “Apply Filter”. When you click “Apply Filter”, the system searches through the entire horse list shown and returns with only horses of the type you have selected.

If all horses shown in the Horse List are to be included in the Mass Procedure, click the third arrow from the top (this arrow points to the right and has a “shadow”) See (A) Clicking on that particular arrow will select all of the horses in the list to be included in the mass procedure.
When the horses in Mass Group List (box on the right) correctly shows all of the horses you want to include in the mass procedure, click “Next”
On the next page (Mass Procedure Details) select the procedure that was performed from the drop down list.

[Optional] Enter an override description.

Enter the date on which the procedure was performed.

[Optional] Enter who performed the procedure.

[Optional] Enter the Invoice Number.

Unit Charge is the standard charge that you originally set up. It is a read only field and cannot be changed.

Quantity defaults to “1” – change the quantity only as necessary.

Charge is the standard charge that you originally set up – change the dollar amount only as necessary.

[Optional] Enter any comment regarding this procedure. This comment will appear on the Procedures Performed Listing and Health Record Report.

[Optional] If you want the comments to appear on your invoices, click in the box “Print Comments on Invoices”.

Click “Finish”

System will prompt you if you want to continue or not.

Click “Yes” and the System will give you the message that the Procedures have been saved.
Click “Ok” and the Mass Procedure Worksheet will appear on the screen.

Print the worksheet for your reference or close the report and click “Close” to close the Mass Procedure Entry screen.

3. Editing Mass Procedures
   - Select “Procedures” from the menu.
   - Select “Mass Procedures” menu item
Select the Mass Procedure that you want to edit and click “Edit”.

---

**Mass Procedures**

<table>
<thead>
<tr>
<th>Performed Date</th>
<th>Procedure</th>
<th>Performed By</th>
<th>Entered Date</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/26/2010</td>
<td>Trim 4</td>
<td>The Blacksmith</td>
<td>04/27/2010</td>
<td>cco</td>
</tr>
<tr>
<td>08/31/2009</td>
<td>Exam - General</td>
<td>The Vet</td>
<td>08/31/2009</td>
<td>cco</td>
</tr>
<tr>
<td>05/04/2009</td>
<td>Rhino</td>
<td>The Farm Vet</td>
<td>05/04/2009</td>
<td>admin</td>
</tr>
<tr>
<td>05/04/2009</td>
<td>Trim 4</td>
<td>The Blacksmith</td>
<td>05/04/2009</td>
<td>admin</td>
</tr>
<tr>
<td>05/01/2009</td>
<td>Vitamins &amp; Supple...</td>
<td>The Farm Manager</td>
<td>05/04/2009</td>
<td>cco</td>
</tr>
<tr>
<td>04/24/2009</td>
<td>Coggin</td>
<td>The Vet</td>
<td>04/24/2009</td>
<td>admin</td>
</tr>
<tr>
<td>04/23/2009</td>
<td>Venining</td>
<td></td>
<td>04/24/2009</td>
<td>admin</td>
</tr>
<tr>
<td>04/17/2009</td>
<td>Medication</td>
<td></td>
<td>04/17/2009</td>
<td>cco</td>
</tr>
<tr>
<td>04/01/2009</td>
<td>Vitamins &amp; Supple...</td>
<td>The Farm Manager</td>
<td>05/04/2009</td>
<td>cco</td>
</tr>
</tbody>
</table>

---

**Horse Listing**

<table>
<thead>
<tr>
<th>Horse Name</th>
<th>Farm Name</th>
<th>Horse Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama</td>
<td>TJCIS Main Mare Farm</td>
<td>More</td>
</tr>
<tr>
<td>Arizona</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Arkansas</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Blackened Susan (QH 2008340102)</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Connecticut</td>
<td>TJCIS Secondary Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Dance Partner</td>
<td>TJCIS Secondary Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Debbie</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Half Moon Cay</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Lily Of The Valley</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Mediterranean Pinks</td>
<td>TJCIS Main Mare Farm</td>
<td>Mare</td>
</tr>
<tr>
<td>Dashing Poppy</td>
<td>TJCIS Secondary Mare Farm</td>
<td>Mare</td>
</tr>
</tbody>
</table>
When you click “Edit”, the list of all horses included in the Mass Procedure will open. From here you can select any individual horse name and view and/or edit just one horse’s record at a time.

Once you have selected a horse and have opened up the Procedure Detail Edit screen, you will be able to make any necessary changes to this record providing it has not been included in a closed billing.

The procedure can also be changed/edited through Procedures Performed.

**NOTE:** The Mass Procedure edit screen will display Mass Procedures for **one year from the current date**. The procedures that have been created will always be shown in the Procedures Performed and can always be accessed via the same.
### 4. Deleting a Mass Procedure

- Select “Procedures” from the menu.
- Select “Mass Procedures” menu item
- Select the Mass Procedure that you want to delete and click “Remove”.

When you select “Delete”, that specific procedure is deleted from all horses that had been included in that specific Mass Procedure.

If you want to delete just one horse from the “Mass Procedure”, select the specific mass procedure and click “Edit”. All of the horses in that mass procedure will be displayed. Find the one horse’s name, click on the name and click “Remove”.

<table>
<thead>
<tr>
<th>Performed Date</th>
<th>Procedure</th>
<th>Performed By</th>
<th>Entered Date</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/26/2010</td>
<td>Trim 4</td>
<td>The Blacksmith</td>
<td>04/27/2010</td>
<td>cec</td>
</tr>
<tr>
<td>05/31/2009</td>
<td>Exam - General</td>
<td>The Vet</td>
<td>08/31/2009</td>
<td>cec</td>
</tr>
<tr>
<td>05/04/2009</td>
<td>Rhino</td>
<td>The Farm Vet</td>
<td>05/04/2009</td>
<td>admin</td>
</tr>
<tr>
<td>05/04/2009</td>
<td>Trim 4</td>
<td>The Blacksmith</td>
<td>05/04/2009</td>
<td>admin</td>
</tr>
<tr>
<td>05/01/2009</td>
<td>Vitamins &amp; Supplements</td>
<td>The Farm Manager</td>
<td>05/04/2009</td>
<td>cec</td>
</tr>
</tbody>
</table>
5. Scheduling Procedures to be Performed
   o Select “Procedures” from the menu.
   o Select “Schedule Master” menu item.
   o Click “Add” to schedule a new procedure
NOTE: Scheduling a procedure will not add a procedure to the system. If you want the procedure to show up in the horse’s health record, you will have to indicate that the scheduled procedure has been performed via the Procedure Performed Entry screen.
6. Schedule Master Samples

- To schedule one specific procedure to take place on one specific day on one particular horse, select the following:
  - Schedule Name: Enter a name for the Scheduled Procedure
  - Procedure: Select the procedure that is to be scheduled
  - Horse: Select correct horse name from the drop down list
  - Schedule the Procedure: Select “one time” from the drop down list and enter the date that the procedure is scheduled to be done.

- This will schedule an insurance exam to be performed on the horse “Evening Primrose” on April 25, 2011.
To schedule a procedure to take place once per month for a particular horse type, select the following:

- **Schedule Name**: Enter a name for the Scheduled Procedure (Example: Monthly Trim - Mares)
- **Procedure**: Select the procedure that is to be scheduled (Example: Trim 4)
- **Horse Type**: (Example: Mare)
- **Procedure**: (Example - Trim 4)
- Schedule the procedure (30) (Days) (after the) (procedure) (Trim 4) has occurred. OR
- Schedule the procedure (1) (Month) (after the) (procedure) (Trim 4) has occurred.
- Create new scheduled procedures starting on (Example: 04/26/10)

This will schedule all of the horses with the Horse Type of “Mares” to get trimmed every 30 days beginning on April 26, 2010.
This will schedule all Mares to get trimmed every month on the 26th of each month beginning April 26, 2010.

To schedule a specific procedure to take place after a given number of days has passed since an initial procedure was performed, select the following:

- **Schedule Name**: Enter a name for the Scheduled Procedure (Example: Foals – 10 Day Tetanus)
- **Procedure**: Select the procedure that is to be scheduled (Example: Tetanus)
- Schedule the procedure (10) (Day) (after the) (procedure) (Foal Date of Birth) has occurred.
- This will schedule all foals to have a Tetanus performed 10 days after the procedure of “Foal Date of Birth” has been entered into the system.
- This type of scheduling is particularly helpful when you need to schedule procedures based on the event of “Foal Date of Birth” since the dates that these procedures are performed can be different for each individual in the group.

**Note:** You can also schedule procedures to be performed based on other scheduled procedures.

- This is an advanced feature and we recommend that you call The Jockey Club directly (800) 333-1778 or (859) 224-2800 to get detailed information on how to set up advanced “Scheduling Chains”.
While you are on the “Procedure Detail” screen you can schedule the same procedure to be done to the same horse on a particular day in the future.

- Select “Procedures”
- Select “Procedure Performed”
- Select the horse and the procedure that was performed
- Enter a date for future scheduling and any comments pertaining to the procedure to be done.

This example shows that the horse “Evening Primrose” had the procedure “X-Ray” done on 04/27/10 and is scheduled to have another “X-Ray” done on 05/11/10.

The Scheduling Comments from the procedure detail screen will appear on the Scheduled Procedures Due report.
Procedure Reports

1. Procedures Performed Report

![Procedures Performed Report]

Prints a report of the procedures that have been performed based on the criteria selected.

You can select any date range, sort the report by Performed Date, Horse Name, Order Entered, search either in the Performed Date or the Entered Date, select horses that are boarding or not or with activity or not.
You can also select by the “Farm”, “Horse”, “Location”, “User ID”, “Invoice Ref No”, “Barn”, “Horse Type”, “Band/Tag”, one “Procedure” or several, one “Category” or several, “Performed By” or “Current Owner” field. The report will show amounts charged and totals based on what you have selected to print.

TIP: To select more than one procedure for the Procedures Performed Report, simply click in the box to the right of the procedure to select all of the procedures you want to include on your report. Follow the same steps to select more than one Category.

TIP: To print a report to double-check your day’s entries, enter “today’s date” in the Starting Date and Ending Date and search in “Entered Date”. Next, Sort By “Ordered Entered” and submit the report either to the printer or the screen. This report will show you all of the procedures that have been entered for that particular day in the order that you actually entered them.
2. Procedure Category Listing

This menu item prints an alphabetical list of the categories that have been entered into the system.

<table>
<thead>
<tr>
<th>Description</th>
<th>Print On Departure Form?</th>
<th>GL Revenue Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>No</td>
<td>1100</td>
</tr>
<tr>
<td>Arrival/Departure</td>
<td>No</td>
<td>7000</td>
</tr>
<tr>
<td>Blacksmith</td>
<td>Last</td>
<td>7001</td>
</tr>
<tr>
<td>Deworm</td>
<td>Lead</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Movement</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>No</td>
<td>R7011</td>
</tr>
<tr>
<td>Registrations/Nominations</td>
<td>Yes</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Yes</td>
<td>7006</td>
</tr>
<tr>
<td>Task</td>
<td>No</td>
<td>7007</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Yes</td>
<td>7003</td>
</tr>
<tr>
<td>Warning</td>
<td>No</td>
<td>7008</td>
</tr>
<tr>
<td>Vet - Farm Vet</td>
<td>No</td>
<td>7010</td>
</tr>
<tr>
<td>Vet - Outside/General Vet</td>
<td>No</td>
<td>7009</td>
</tr>
</tbody>
</table>

When printing this report you can choose to show those Categories that have been marked as “Inactive” or not.
3. Procedure Master Listing

This menu item prints a list of the master procedures that have been entered into the system. You can either sort the list by category or not and you can choose to show those Master Procedures that have been marked as “Inactive” or not.
<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Std. Charge</th>
<th>Print on Repert Form</th>
<th>Breeding Procedure</th>
<th>Print on Teaching Res.</th>
<th>G/L Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>Advertising</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>1100</td>
</tr>
<tr>
<td>Arrival / Departure</td>
<td>Arrival / Departure</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7000</td>
</tr>
<tr>
<td>Blacksmith</td>
<td>Trim 4</td>
<td>$30.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7001</td>
</tr>
<tr>
<td>Deworm</td>
<td>Intermed</td>
<td>$12.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Deworm</td>
<td>Strongid</td>
<td>$14.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Movement</td>
<td>Farm to Farm Movement</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Confirmation Notes</td>
<td>$0.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Evaluation Notes</td>
<td>$0.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Reproductive Notes</td>
<td>$0.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>Regenerate</td>
<td>$3.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>SMZ Tabs</td>
<td>$1.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>Vitamins &amp; Supplements</td>
<td>$2.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Registrations / Nominations</td>
<td>Breeders’ Cup Nomination</td>
<td>$500.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Registrations / Nominations</td>
<td>Jockey Club Registration</td>
<td>$200.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Breeding Date</td>
<td>$0.00</td>
<td>True</td>
<td>True</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foal Date of Birth</td>
<td>$0.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foaling Information</td>
<td>$200.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foal</td>
<td>$50.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foal for Dilation</td>
<td>$0.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Ultrasound</td>
<td>$60.00</td>
<td>Last</td>
<td>False</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Ultrasound - In Foal</td>
<td>$0.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7006</td>
</tr>
<tr>
<td>Stud Fee Billing Items</td>
<td>Cattle Fee</td>
<td>$150.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Stud Fee Billing Items</td>
<td>Container Deposit</td>
<td>$200.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Stud Fee Billing Items</td>
<td>Shipping Expenses/Fees</td>
<td>$0.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Tack</td>
<td>New Matter</td>
<td>$40.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7007</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Rabies</td>
<td>$10.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Rhino</td>
<td>$10.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Tetanus</td>
<td>$10.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>West Nile</td>
<td>$12.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vening</td>
<td>Vening</td>
<td>$175.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Vet - Farm Vet</td>
<td>Treatment</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7010</td>
</tr>
</tbody>
</table>
4. Schedule Master Report

This menu item prints a list of all of the scheduled procedures that have been entered into the system.

<table>
<thead>
<tr>
<th>Schedule Name</th>
<th>Procedure shown as due</th>
<th>After</th>
<th>Based On</th>
<th>Fitness</th>
<th>Horse Type</th>
<th>Location</th>
<th>Horse</th>
<th>LO</th>
<th>RO</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electric</td>
<td>Nomadistic</td>
<td>(1 time on 01/19/2000)</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insurance Exam</td>
<td>Insurance Exam</td>
<td>(1 time on 04/25/2011)</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Herd Health</td>
<td>Nomadistic</td>
<td>(1 time on 04/10/2000)</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Annual</td>
<td>New Hitter</td>
<td>5 Days</td>
<td>Arrival/Departure</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Yearly Exams</td>
<td>Coggins</td>
<td>repeating every 1 year</td>
<td>Coggins</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Folds - 10 day Tetanus</td>
<td>Tetanus</td>
<td>10 Days</td>
<td>Feed Date of Birth</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gen Exam</td>
<td>Exam - General</td>
<td>1 Days</td>
<td>Feeding Information</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>US Vet Exam</td>
<td>Ultrasound</td>
<td>19 Days</td>
<td>Pre-Op</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ProgExam</td>
<td>Results</td>
<td>Cervix</td>
<td>Other</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monthly Vet - Horse</td>
<td>Trix 4</td>
<td>repeating every 1 Month</td>
<td>Trix 4</td>
<td>Farm</td>
<td>Horse Type</td>
<td>Location</td>
<td>Horse</td>
<td>LO</td>
<td>RO</td>
</tr>
</tbody>
</table>
5. Scheduled Procedures Due Report

- Select “Procedures” from the menu
- Select “Procedure Reports” from the menu
- Select “Scheduled Procedures Due” menu item

Select a date range to print. You might want to see what procedures have been scheduled for one day, one week, one month or even one year.

Once you have selected a date range, you have the option to further limit the report by selecting other criteria.

- If you want to see everything that is scheduled for “In-Foal” mares only, check the box next to “Only In-Foal Mares?” and leave the other fields blank.
- If you want to see everything that is scheduled for all horses on one particular farm, select the specific farm name from the drop down list and leave the other fields blank.
- If you want to see everything that is scheduled for one particular horse, select the one horse’s name from the drop down list and leave the other fields blank.
- If you want to see everything that is scheduled for one particular horse type, select that particular horse type from the drop down list and leave the other fields blank.
- If you want to see all horses that have been scheduled for a particular procedure, select the specific procedure from the drop down list and leave the other fields blank.
- If you want to see all horses that have been scheduled for all procedures in a particular category, select the specific category from the drop down list and leave the other fields blank.
If you want to see all horses of one horse type that have been scheduled for a particular procedure, first select the specific horse type from the drop down list and then select the specific procedure from the drop down list and leave the other fields blank.

**Note:** The Schedule Procedures Due Report will provide you with a list of what should be done to your horses based on what has been entered in the Schedule Master screen. Because it has been scheduled does not mean that the procedure has actually been performed on a horse or a group of horses.

**NOTE:** When the due date in the Schedule Master screen has passed for a scheduled procedure, that scheduled procedure will appear as (Past Due) on the procedure Detail screen and (Over Due) on the Scheduled Procedures Due Report.

### Procedure Detail

**Search History**

- Irish Moss

<table>
<thead>
<tr>
<th>Description</th>
<th>Performed On</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coggins</td>
<td>04/24/2010</td>
<td>Past Due</td>
</tr>
</tbody>
</table>

### Scheduled Procedures Due Report

**Date Range:** 05/01/2010 - 05/31/2010

**Show only Currently Boarding Horse:** Irish Moss

<table>
<thead>
<tr>
<th>Date</th>
<th>Horse Name</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/24/2010</td>
<td>Irish Moss</td>
<td>Coggins</td>
<td>(Over Due) Annual coggins - scheduled 1 year after last coggins</td>
</tr>
</tbody>
</table>
1. Adding Payments
   - Select “A/R Transactions” from the menu
   - Select the “Payments” menu item
   - Select the name of the client that has made a payment

   - Either double click on the name or click once on the name and then click “Select”
Click "Add" to enter a new payment (or "Edit" to change an existing entry if it has not yet been finalized in a billing).
- **Date Received:** Enter the date that the payment was received (you can type in the date or click the “down arrow” to select the date from the calendar)
- **Applied To:** Select “Standard” from the drop down list or whatever Billing Application Code you have set up for Standard/Monthly billing in the “Applied To” field
- **Check Number:** Enter the check number
- **Amount:** Enter the amount of the payment
- **Show Comments On Invoice?:** [Optional] Click this box if you want the payment comments to show up on the invoice.
- **Payment Comments:** Enter any further comments regarding this payment. These comments will appear on the Receipts Report.
- **[Optional]** Reference: Enter any reference notes pertaining to that payment. These notes will appear on the Receipts Report.
- Click the “Apply” box on the line of the invoice you wish to pay
- Click the “Save” button to save the record.

**NOTE:** The “Applied On” date is automatically filled in during month end closing. The date will indicate the ending date range for the billing in which the procedure was included.

**Unapplied Payments**
If a person makes a payment and there are no outstanding invoices or if they pay more than what is currently owed, it is considered an “unapplied payment” and the amount will be shown in red.
If there are unapplied amounts you will have to apply them once invoices become available.

To apply an unapplied payment go to A/R Transactions > Payments and select the client. On the payment history screen select the unapplied payment entry and click “Edit”.
Click the “Apply” box on the invoice you wish to apply. The amount to be applied will now show $0 and is no longer in red.
NOTE: On the payment search history screen the Applied On date shows which billing has picked up the payment. If the Applied On date is blank, the payment has not yet been included in a closed billing.
Note: Once a payment has been picked up and included in billing and that billing has been finalized, you cannot make any changes to the dollar amount that has been posted and you cannot delete the payment entry.

2. Adding Adjustments (Direct Charges/Credits)
   - Select “A/R Transactions” from the menu
   - Select the “Adjustments” menu item
   - Select the client’s name
   - Click “Add” to enter a new Adjustment (Direct Credit/Charge) for that client. Date Applied: Enter the date of the adjustment.
   - Applied To: Select the billing system where the adjustment will be applied (Standard, Monthly, Month End, etc.)
   - Enter the amount of the adjustment (the system will automatically fill in the G/L Account Number, the G/L Amount and the Total Distribution).

Note: A positive number entered in the Amount field such as $642.00 See (A) will add a charge to the client’s balance and a negative number such as -$642.00 or ($642.00) will deduct the amount from the client’s balance. See (B)
Add the optional “Adjustment Comment” which will show the explanation for the adjustment on the client’s invoice if you check the box “Show Comment on Invoice?” This Invoice Comment will also appear on the Adjustments Report.

NOTE: On the adjustments search history screen the Applied On date shows which billing has picked up the adjustment. If the Applied On date is blank, the adjustment has not yet been included in a billing.
NOTE: On the Adjustments Entry/Edit screen the “Applied On” field is automatically filled in when you finalize the billing. See (A)

- After you have entered the Date Applied, the Amount and then selected an item from the Applied To drop down list, you will next click on the Invoice Allocation tab.

On the Invoice Allocation page you can either apply the adjustment to an existing invoice or you can click “New Invoice” to keep the adjustment as a separate entry. Until you actually apply the Adjustment to an invoice you will see the (Amount To Be Applied) $642.00 in Red.
To apply the Adjustment to an existing Invoice, click the Apply Box on the left side of the screen.

To apply the Adjustment to a New Invoice, click the button “New Invoice” at the bottom – left side of the screen.

Click “Save” to save the record.
3. Editing Adjustments (Direct Charges/Credits)
   - To edit an existing entry that has not been finalized, select “A/R Transactions” from the menu
   - Select the “Adjustments” menu item
   - Select the client's name and click “Select”
   - Click on the entry that you want to edit and click “Edit”
   - Make changes as needed and click “Save”

Note: Once an adjustment has been picked up and included in billing and that billing has been finalized, you cannot make any changes to the adjustment entry and you cannot delete the adjustment entry.

4. Entering a “Zero Dollar” Adjustment
If a client has a credit invoice and an unpaid invoice you can enter a “Zero Dollar” adjustment to offset the invoices.

Select A/R Transactions > Adjustments
Select the Client

Click “Add”
Enter the Date Applied
Select the “Applied To”
Enter $0.00 in the amount field

Click on the “Invoice Allocation” tab.
In this example, a credit invoice for ($85.87) will be applied to the outstanding invoice of $185.75. To process the Zero Dollar Adjustment, enter a positive $85.87 in the Amount To Apply column for Invoice #100000827 and then click the Apply box on the line for Invoice #1000001100. A negative (credit) amount of ($85.87) will automatically be entered in the Amount To Apply column for Invoice #1000001100. You have now applied the credit invoice to the outstanding invoice and the net effect is $0. Click “Save”.

**Auto Allocation**

At any time during the month you can run the “Proposed Auto-Allocation Report” to see if there are any clients that have any unapplied payments or credit invoices that can be applied.

1. Click on “A/R Transactions”
3. Click “Submit to view the report.”
The report will display the clients that have either an unapplied payment that now can be applied to an unpaid invoice or a credit adjustment that can now be applied to an unpaid invoice.

The Auto-Allocation feature will allocate funds to the oldest invoices first.

In the example above, there is an unapplied payment in the amount of $500.00 for the client Annie McGillicutty. The Auto-Allocation will take the $500.00 and pay off three invoices completely and pay one invoice partially.

and pay one invoice partially.

In the example above there is also a credit invoice in the amount of ($256.75) for the client Sara Pterra. The Auto-Allocation will take the ($256.75) and pay of one invoice completely and then partially pay one invoice.
If you do not want the program to Auto-Allocate a particular entry, go back to the specific Payment screen or the specific Adjustment Entry/Edit screen and click the box “Do Not Auto-Allocate”
Once you have reviewed the report and you agree with the Proposed Auto-Allocations, click “Finalize Auto-Allocations”

Click the box to Print the Journal after the Allocations have been created and then click the button “Finalize Allocations”.

Click “Yes” if you wish to continue.

Confirmation that the Auto-Allocation is complete will appear, click “Ok” and then print the Auto-Allocation Journal. As the message indicates, you will need to re-generate if you are processing your billing at this time.
## A/R Transactions Reports

<table>
<thead>
<tr>
<th>A/R Transactions</th>
<th>Billing</th>
<th>Mare Info</th>
<th>Stallion</th>
<th>Reports</th>
<th>Setup</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjustments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-Allocation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Payments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adjustments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aged A/R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detailed A/R</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unapplied Payments</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Credit Invoices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unapplied Payments with Unpaid Invoices</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billed Charges</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 1. Payments Report

This will print a report of the payments that have been entered into the system based on the criteria selected. You can specify any date range, a specific client or all clients and include only those payments that have not been billed yet or show **all** receipts for that date range including those that have already been billed.
NOTE: Syndicate Billing Payments and Stud Fee Billing Payments pertain only to those clients that have purchased the “Stallion Module”.

Payments Report Example #1

This example shows payments for all clients from 5/27/2010 thru 09/30/2010 that have not been closed.
This example shows all payments for the client February Rain Farm from 05/17/2007 thru 09/30/2010 whether they have been closed or not.
NOTE: The comments shown on this report are those comments that were entered in the “Payment Comment” field on the Payment Entry/Edit form.
2. **Adjustments Report**

This will print a report of the Adjustments that have been entered into the system based on the criteria selected. You can specify any date range, a specific client or all clients and include only those Adjustments that have not been billed yet or show all Adjustments for that date range including those that have already been billed.

**Adjustments Report Example #1**

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Comment</th>
<th>Applied To</th>
<th>Adjustment Amount</th>
<th>All Account</th>
<th>Closed?</th>
<th>Invoice No.</th>
<th>Invoice Amount</th>
<th>Offset Account</th>
<th>Offset Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/01/2010</td>
<td>Petti, Sara</td>
<td>Monthly</td>
<td>March</td>
<td>($256.75)</td>
<td>101</td>
<td>102</td>
<td>10001077</td>
<td>($256.75)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>06/01/2010</td>
<td>Biddle, Drew</td>
<td>Miscellaneous charges for new home in June</td>
<td>March</td>
<td>$642.00</td>
<td>101</td>
<td>102</td>
<td>10001075</td>
<td>$642.00</td>
<td></td>
<td>($642.00)</td>
</tr>
</tbody>
</table>

**Report Total:**

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>102</td>
<td>$0.00</td>
<td>$385.25</td>
</tr>
</tbody>
</table>

This example shows payments for all clients from 6/01/2010 thru 09/30/2010 that have not been closed.
**Adjustments Report Example #2**

This example shows all Adjustments for the client Drew Elliott from 06/01/2007 thru 09/30/2010 whether they have been closed or not.
NOTE: Syndicate Billing Adjustments and Stud Fee Billing Adjustments pertain only to those clients that have purchased the “Stallion Module”.

NOTE: The comments shown on this report are those comments that were entered in the “Adjustment Comment” field on the Adjustment Entry/Edit form.

3. Aged A/R Report
   - You can select to print <All> clients for this report or you may select just one client from the drop down list.
The Aged A/R Report will show you what the total balance is for each client after the last closing. This report shows any “real-time” interim Payments or Adjustments along with the (new) actual Adjusted Balance after the interim Payments and/or Adjustments have been entered.

When you finalize the billing, the Total Balance, Current, Over 30, Over 60, Over 90, Accumulated Service Charges are all updated and the Interim Payments and Interim Adjustments are set back to $0.00.

4. Detailed A/R Report

This menu option prints a Detailed Accounts Receivable Report for any given date range. You can select to print the report for <All> clients or you can select a client name from the drop down list and print the report for just one client.
The Detailed Accounts Receivable Report shows the Invoice Number, the Invoice Date, Invoice Amount, the Payment or Adjustment Date, Check Number, Reference, Comments, the Actual Payment or Adjustment Amount, the Debit and Credit Account number and the Balance.

The report will group the account information into 30, 60, 90 days aging and current aging.

The Payment/Adjustment Amount column will indicate if the amount is an Invoice (I), Service Charge (S), Receipt (R) or an Adjustment (A).
5. **Unapplied Payments Report**

To print this report you can select any date range and <All> clients or you can select just one client from the drop down list.

This report will show all unapplied payments whether or not they can be applied to an outstanding invoice at this time.

**NOTE:** Syndicate Billing Payments pertain only to those clients that have purchased the “Stallion Module”.

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Check #</th>
<th>Payment Amount</th>
<th>Applied To</th>
<th>Reference</th>
<th>Billing Account</th>
<th>Credit Account</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/2010</td>
<td>O’Meara, Colleen</td>
<td>1862</td>
<td>$10,000.00</td>
<td>Monthly</td>
<td>102</td>
<td>101</td>
<td></td>
<td>On account</td>
</tr>
<tr>
<td>01/31/2010</td>
<td>Alligator Partnership</td>
<td>1863</td>
<td>$3,000.00</td>
<td>Monthly</td>
<td>102</td>
<td>101</td>
<td></td>
<td>On account</td>
</tr>
<tr>
<td>02/01/2010</td>
<td>February River Farm</td>
<td>2113</td>
<td>$1,000.00</td>
<td>Monthly</td>
<td>102</td>
<td>101</td>
<td></td>
<td>Advance payment</td>
</tr>
<tr>
<td>02/01/2010</td>
<td>Williams, Edward</td>
<td>2113</td>
<td>$5,000.00</td>
<td>Monthly</td>
<td>102</td>
<td>101</td>
<td></td>
<td>Payment in advance. Horse will arrive at end of September</td>
</tr>
</tbody>
</table>

**Daily Total:** $23,500.00

**Report Total:** $23,500.00
6. Credit Invoices Report

To print this report you can select <All> clients or you can select just one client from the drop down list.

<table>
<thead>
<tr>
<th>Name</th>
<th>Invoice No.</th>
<th>Invoice Date</th>
<th>Invoice Amount</th>
<th>Payable Date</th>
<th>Paid By</th>
<th>Reference</th>
<th>Comment</th>
<th>Payable Amount</th>
<th>Debit Account</th>
<th>Credit Account</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Together</td>
<td>1009090028</td>
<td>05/02/2098</td>
<td>$700.00</td>
<td>05/01/2098</td>
<td>$600.00</td>
<td></td>
<td></td>
<td>$600.00</td>
<td>101</td>
<td></td>
<td>($110.00)</td>
</tr>
<tr>
<td></td>
<td>100091017</td>
<td>06/28/2098</td>
<td>$900.00</td>
<td>06/28/2098</td>
<td>$800.00</td>
<td></td>
<td></td>
<td>$800.00</td>
<td>101</td>
<td></td>
<td>($110.00)</td>
</tr>
<tr>
<td><strong>Customer Total</strong>:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>($220.00)</strong></td>
</tr>
</tbody>
</table>

| Author, Frederick | 1009090027  | 07/01/2098   | $0.00          | 05/26/2098   | $0.00   |           |                 |                | 101           |               | $102.80  |
|                  | 100091100   | 07/01/2098   | $320.00        | 04/22/2098   | $320.00 |           |                 |                | 101           |               | $465.00  |
| **Customer Total**: |            |              |                |              |         |           |                 |                |               |               | **$177.80** |
| **Report Total**:  |            |              |                |              |         |           |                 |                |               |               | $149.00  |

This report will show you all outstanding credit invoices whether or not they can be applied to an outstanding invoice at this time.
7. **Unapplied Payments with Unpaid Invoices Report**

![Unapplied Payments with Unpaid Invoices Report]

**NOTE:** The Syndicate button pertains only to those clients that have purchased the “Stallion Module”.

This report shows only those clients that have an unapplied payment or a credit invoice that can be applied to an outstanding invoice. A client will also show up on this report if they have only credits but no invoices that are currently due.

<table>
<thead>
<tr>
<th>Name</th>
<th>Invoice No.</th>
<th>Invoice Date</th>
<th>Invoice Amount</th>
<th>Pay/Adj Date</th>
<th>Check#</th>
<th>Reference</th>
<th>Comment</th>
<th>Pay/Adj Amount</th>
<th>Debit Account</th>
<th>Credit Account</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altogether Partnership</td>
<td>1000308209</td>
<td>05/01/2008</td>
<td>$750.00</td>
<td>07/12/2008</td>
<td>Wire</td>
<td>On account</td>
<td>$90.00</td>
<td>1</td>
<td>101</td>
<td></td>
<td>($111.63)</td>
</tr>
<tr>
<td>1000308107</td>
<td>05/02/2008</td>
<td>$750.00</td>
<td>07/01/2008</td>
<td>On account</td>
<td>$90.00</td>
<td>1</td>
<td>($760.25) R $102</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000308101</td>
<td>07/01/2008</td>
<td>$0.00</td>
<td>07/12/2008</td>
<td>Wire</td>
<td>On account</td>
<td>$90.00</td>
<td>1</td>
<td>($761.25) R $102</td>
<td>101</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1000308104</td>
<td>05/01/2008</td>
<td>$0.00</td>
<td>07/01/2008</td>
<td>Wire</td>
<td>On account</td>
<td>$90.00</td>
<td>1</td>
<td>$325.00</td>
<td>101</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unapplied Payment</td>
<td>07/12/2008</td>
<td>$0.00</td>
<td>07/12/2008</td>
<td>Wire</td>
<td>On account</td>
<td>($1,440.40) U $102</td>
<td>101</td>
<td>($1,440.40)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Customer Total:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$99.97</td>
<td></td>
<td>101</td>
<td></td>
<td>($1,138.37)</td>
</tr>
<tr>
<td>Wadincky, John</td>
<td>1000308206</td>
<td>04/26/2008</td>
<td>$0.00</td>
<td>04/26/2008</td>
<td>Wire</td>
<td>Adjustments</td>
<td>$200.00</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td>$200.00</td>
</tr>
<tr>
<td>1000308120</td>
<td>05/09/2008</td>
<td>$1.75</td>
<td>05/09/2008</td>
<td>Wire</td>
<td>$1.75</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td>$1.75</td>
</tr>
<tr>
<td>1000308142</td>
<td>06/09/2008</td>
<td>$175.00</td>
<td>06/09/2008</td>
<td>Wire</td>
<td>$175.00</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td>$175.00</td>
</tr>
<tr>
<td>1000308160</td>
<td>06/23/2008</td>
<td>$0.00</td>
<td>06/23/2008</td>
<td>Wire</td>
<td>$0.00</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td>$0.00</td>
</tr>
<tr>
<td>1000308203</td>
<td>06/30/2008</td>
<td>$980.00</td>
<td>06/30/2008</td>
<td>Wire</td>
<td>$980.00</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td>$980.00</td>
</tr>
<tr>
<td>Unapplied Payment</td>
<td>06/30/2008</td>
<td>$0.00</td>
<td>06/30/2008</td>
<td>Wire</td>
<td>$0.00</td>
<td>A Change</td>
<td>101</td>
<td></td>
<td></td>
<td></td>
<td>$0.00</td>
</tr>
<tr>
<td><strong>Customer Total:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>$99.97</td>
<td></td>
<td>101</td>
<td></td>
<td>$99.97</td>
</tr>
</tbody>
</table>

**Page 147 of 324**
If you don't want to manually apply the unapplied payments or manually enter $0 adjustments, you can go to the menu option A/R Transactions > Auto Allocation and follow the steps to have unapplied payments and/or credit invoices automatically allocated to unpaid invoices.

8. Billed Charges Report

This report will show you either billed procedure charges or boarding charges or a combination of both based on the criteria selected.

First select which Billing Period (Starting date and Ending date) and then select any additional criteria you wish to include on the report.
This example shows Boarding charges for the horse Blackeyed Susan for the billing dates 10/01/04 – 12/31/07.

![Billed Charges Report](image)

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Horse</th>
<th>Charge Date</th>
<th>Performed Code</th>
<th>Description</th>
<th>Days</th>
<th>Gross Amount</th>
<th>Owner %</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coleman, Gary</td>
<td>Blackeyed Susan</td>
<td>10/01/04</td>
<td>100100</td>
<td>Boarding @ $25.00</td>
<td>31</td>
<td>$775.00</td>
<td>60.00%</td>
<td>$465.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11/01/04</td>
<td>110100</td>
<td>Boarding @ $25.00</td>
<td>30</td>
<td>$775.00</td>
<td>60.00%</td>
<td>$465.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12/01/04</td>
<td>120100</td>
<td>Boarding @ $25.00</td>
<td>31</td>
<td>$775.00</td>
<td>60.00%</td>
<td>$465.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>01/01/05</td>
<td>010100</td>
<td>Boarding @ $25.00</td>
<td>31</td>
<td>$775.00</td>
<td>60.00%</td>
<td>$465.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>02/01/05</td>
<td>020100</td>
<td>Boarding @ $25.00</td>
<td>11</td>
<td>$488.50</td>
<td>60.00%</td>
<td>$301.50</td>
</tr>
</tbody>
</table>

**Boarding Totals**: 11.97 days, $1,225.00

**Procedures**: $0.00

**Ending Balance**: $0.00
This next example shows Boarding and Procedure charges for the horse Blackeyed Susan for the billing dates 10/01/04 – 12/31/04.
MONTH END BILLING

Standard Billing

Processing the Billing

The steps for processing the billing are as follows:
1. Generate Billing
2. View the Preliminary Reports
   i. Make any necessary changes
   ii. If you make changes, Generate again
   iii. After generating, review the Preliminary Reports
3. Finalize the Billing only when you are satisfied that all information is correct
4. Print the Invoices
5. View and/or print any or all of the Historical Reports

To start the billing process, the system needs to calculate board and procedure charges for each horse and allocate all charges to the appropriate owner based upon arrival and departure dates, percentages of ownership and dates the charges were incurred. All of this is done in a single process.

- Select “Billing” > “Standard” from the menu
- Select "Generate Billing"
- Select the billing range by entering a “From Date” and a “To Date” for the billing you are going to process.
To generate the billing for all clients and all horses for the selected date range, leave Client as <All> and leave Horse as <All>.

Click “Generate” to begin the processing.

To generate the billing for just one client and all of the horses owned by that client, select the specific client’s name from the drop down list, leave Horse as <All> and click “Generate”

To generate the billing for just one horse and all owners (if applicable), select the specific Horse name from the drop down list, leave Client as <All> and click “Generate”

To generate the billing for just one horse for just one client, select the Client name from the drop down list, select the Horse name from the drop down list and click “Generate”

Note: The Generate Billing process may be done as many times as necessary. If you generate, review the pre-billing and then find something that needs to be corrected and/or changed (adding procedures, payments, receipts; changing ownership, board rates, board types, etc), simply make the necessary changes and generate again. This generation process simply allows the system to sort through all of the records to see what should be included in the billing date range you have selected as well as to pick up any changes you have just made.

Once you are satisfied that the Pre-Billing is correct, continue the billing process by printing or viewing the remaining Preliminary Reports. These reports will be used to verify the billing charges and may be run as many times as necessary. In order for these reports to print accurate up-to-date information, remember that if you have made any changes, you must first “Generate” before running the Preliminary Reports again.

TIP: The generate process will pick up all procedures that fall within the selected date range as well as any procedures that were performed prior to the selected date range that have not yet been billed.

For example, a vet ticket might get turned in after you have already closed a billing period. You enter the charge on the date it happened last month and when you generate for this month, the system will see that the procedure has not yet been billed and it will pick up the procedure and include it in the current billing. The generate process will never pick up procedures that have been performed beyond the selected date range.
**TIP:** The generate process will pick up and include all Adjustments (Direct Credit/Charge) entries that fall within the selected date range as well as those that were entered prior to the selected date range that have not yet been billed. The generate process will **not** pick up Adjustments that have been performed beyond the selected date range.

**TIP:** The generate process will pick up all cash receipts, **regardless** of the payment date that have been entered and will include them in the current billing.

### Unapplied Payments or Credit Invoices with Unpaid Invoices

When you generate your billing this message will appear if you have any clients with Unapplied Payments or Credit Invoices that can be applied to outstanding invoices.

Click “Yes” to see the report
Click “No” to not see the report at this time and continue with the generate process.

If you click “Yes”, the report will be displayed on the screen.
You can manually process these items or you can go back to the menu option A/R Transactions > Auto Allocation > Standard, view the Proposed Auto Allocation Report and then Finalize the Auto Allocation. (See Section ("Maintaining Client Balances")

**IMPORTANT NOTE:** If you do not make the offsetting entries your client balances will not age properly.

---

**Clients with Unapplied Payments or Credit Invoices with Unpaid Invoices**

<table>
<thead>
<tr>
<th>Name</th>
<th>Invoice No.</th>
<th>Invoice Date</th>
<th>Invoice Amount</th>
<th>Pay/Adj Date</th>
<th>Pay/Adj Date</th>
<th>Check #</th>
<th>Reference</th>
<th>Comment</th>
<th>Pay/Adj Amount</th>
<th>Pay/Adj Amount</th>
<th>Debit Account</th>
<th>Credit Account</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Clients with Unapplied Payments or Credit Invoices with Unpaid Invoices**

<table>
<thead>
<tr>
<th>Item</th>
<th>Invoice No.</th>
<th>Invoice Date</th>
<th>Invoice Amount</th>
<th>Pay/Adj Date</th>
<th>Pay/Adj Date</th>
<th>Check #</th>
<th>Reference</th>
<th>Comment</th>
<th>Pay/Adj Amount</th>
<th>Pay/Adj Amount</th>
<th>Debit Account</th>
<th>Credit Account</th>
<th>Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Run Date:** 09/16/2010 9:48
**Company:** TUCS Test Company
**Page:** 1 of 2
**User:** ccc

**Run Date:** 09/16/2010 9:48
**Company:** TUCS Test Company
**Page:** 2 of 2
**User:** ccc
The Pre-Billing Report is **NOT** the invoice. It is a report that lists all of the board and procedure charges based on the Billing Generate dates that were selected. The report is alphabetical by client and then for each client the horses are listed alphabetically. This report allows you to quickly review and verify the charges for each client/horse before continuing to the next step in the billing process.

- You can select <All> clients, <All> horses, you can select one client from the drop down list and <All> horses, you can select one horse from the drop down list and <All> clients or you can select one horse from the drop down list and one client from the drop down list.
In this sample pre-billing one client was selected (Sara Pterra) and <All> horses.
The Pre-Billing Report will show the Boarding Total, the Procedure Total, the total Payments, Adjustments and Service Charges. There will also be a G/L Account summary at the very end showing the totals for each G/L Account.

If you have selected to Suppress a client’s billing, you can still view and/or print the Suppressed Billing charges.
### Billing - Pre-Billing Report

**Run Date:** 08/17/2010 11:33 AM  
**Company:** TJ CIS Test Company

**Billing Range:** 07/01/2008 - 07/31/2008  
**Show Only Suppressed Clients:** Yes  
**Billing System:** Standard

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Horse</th>
<th>Charge Date</th>
<th>Description</th>
<th>Gross Amount</th>
<th>Owner %</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jared, James</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Farm More #1</td>
<td></td>
<td>07/01/2008 Thru 07/31/2008@25.00</td>
<td>$75.00</td>
<td>100.00 %</td>
<td>$75.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/03/2008 Exam - General</td>
<td>$25.00</td>
<td>100.00 %</td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/05/2008 Trim 4</td>
<td>$30.00</td>
<td>100.00 %</td>
<td>$30.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Ivermectin</td>
<td>$2.00</td>
<td>100.00 %</td>
<td>$2.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 New Halt</td>
<td>$40.00</td>
<td>100.00 %</td>
<td>$40.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Fenbendazole</td>
<td>$8.00</td>
<td>100.00 %</td>
<td>$8.00</td>
<td></td>
</tr>
<tr>
<td>- Farm More #2</td>
<td></td>
<td>07/01/2008 Thru 07/31/2008@25.00</td>
<td>$75.00</td>
<td>100.00 %</td>
<td>$75.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/03/2008 Exam - General</td>
<td>$25.00</td>
<td>100.00 %</td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/05/2008 Trim 4</td>
<td>$30.00</td>
<td>100.00 %</td>
<td>$30.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Ivermectin</td>
<td>$2.00</td>
<td>100.00 %</td>
<td>$2.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 New Halt</td>
<td>$40.00</td>
<td>100.00 %</td>
<td>$40.00</td>
<td></td>
</tr>
<tr>
<td>- Farm More #3</td>
<td></td>
<td>07/01/2008 Thru 07/31/2008@1.00</td>
<td>$31.00</td>
<td>100.00 %</td>
<td>$31.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/03/2008 Exam - General</td>
<td>$25.00</td>
<td>100.00 %</td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/05/2008 Trim 4</td>
<td>$30.00</td>
<td>100.00 %</td>
<td>$30.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Ivermectin</td>
<td>$2.00</td>
<td>100.00 %</td>
<td>$2.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 New Halt</td>
<td>$40.00</td>
<td>100.00 %</td>
<td>$40.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Fenbendazole</td>
<td>$8.00</td>
<td>100.00 %</td>
<td>$8.00</td>
<td></td>
</tr>
</tbody>
</table>

**A Real Rugby**  
**Blackwood Susan**  
**R 0105**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Gross Amount</th>
<th>Owner %</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jared, James</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Farm More #1</td>
<td></td>
<td>07/01/2008 Thru 07/31/2008@8.00</td>
<td>$0.00</td>
<td>50.00 %</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/03/2008 Exam - General</td>
<td>$35.00</td>
<td>100.00 %</td>
<td>$35.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/05/2008 Trim 4</td>
<td>$30.00</td>
<td>100.00 %</td>
<td>$30.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Ivermectin</td>
<td>$40.00</td>
<td>100.00 %</td>
<td>$40.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 New Halt</td>
<td>$12.00</td>
<td>100.00 %</td>
<td>$12.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>07/15/2008 Fenbendazole</td>
<td>$2.00</td>
<td>100.00 %</td>
<td>$2.00</td>
<td></td>
</tr>
</tbody>
</table>

**Beginning Balance:** $2,00  
**Payments:** $8,00  
**Adjustments:** $8,00
### Billing - Pre-Billing Report

**Run Data:** 08/17/2010 11:33 AM  
**Company:** TCIS Test Company

**Billing Range:** 07/01/2008 - 07/31/2008  
**Show Only Suppressed Clients:** No  
**Billing System:** Standard

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Horse</th>
<th>Charge Date</th>
<th>Description</th>
<th>Gross Amount</th>
<th>Owner %</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Boarding Total:** $1,561.00
- **Procedure Total:** $857.00
- **Payments:** $0.00
- **Adjustments:** $0.00
- **Service Charge:** $2,677.24

### (G/L Account Summary)

<table>
<thead>
<tr>
<th>G/L Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>$0.00</td>
<td>$2,230.00</td>
</tr>
<tr>
<td>401</td>
<td>$1,550.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>403</td>
<td>$371.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>430</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7000</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7001</td>
<td>$150.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7002</td>
<td>$72.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7005</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7007</td>
<td>$240.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>7008</td>
<td>$125.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Total Amounts:**  
- **Debit:** $2,238.00  
- **Credit:** $2,238.00
## Adjustments Report

- This report shows a complete listing of any Adjustments (Direct Charges or Credits) you have entered that will be included in this billing cycle.

### Billing - Adjustment Report

#### Run Date: 09/17/2010 11:41
- Company: TUCIS Test Company
- Billing Range: 07/01/2008 - 07/31/2008
- Billing System: Standard
- User: eac

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Procedure Code</th>
<th>Comment</th>
<th>Adjustment Amount</th>
<th>Adj Account</th>
<th>Invoice No</th>
<th>Invoice Amount</th>
<th>Offset Account</th>
<th>Offset Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/09/2010</td>
<td>Adler, Frederick J.</td>
<td>1000</td>
<td>Additional charges for missing card.</td>
<td>$165.75</td>
<td>106019162</td>
<td>101</td>
<td>$165.75</td>
<td>$165.75</td>
<td></td>
</tr>
<tr>
<td>09/09/2010</td>
<td>Adler, Frederick J.</td>
<td>1000</td>
<td>Additional charges for missing card.</td>
<td>$165.75</td>
<td>106019162</td>
<td>101</td>
<td>$165.75</td>
<td>$165.75</td>
<td></td>
</tr>
<tr>
<td>09/09/2010</td>
<td>Alcobello Partnership</td>
<td>1000</td>
<td>Vet charges missed last month.</td>
<td>$325.00</td>
<td>106019101</td>
<td>101</td>
<td>$325.00</td>
<td>$325.00</td>
<td></td>
</tr>
<tr>
<td>09/09/2010</td>
<td>Alcobello Partnership</td>
<td>1000</td>
<td>Vet charges missed last month.</td>
<td>$325.00</td>
<td>106019101</td>
<td>101</td>
<td>$325.00</td>
<td>$325.00</td>
<td></td>
</tr>
</tbody>
</table>

#### (GL Account Summary)

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>$0.00</td>
<td>$4,374.59</td>
</tr>
<tr>
<td>102</td>
<td>$1,378.59</td>
<td></td>
</tr>
<tr>
<td>999</td>
<td>$2,390.59</td>
<td>$39.10</td>
</tr>
</tbody>
</table>

**Total Amounts:** $4,374.59  $4,374.59

---

Page 161 of 324
Payments Report

- This report shows a complete listing of all of the cash receipts that will be included in this billing cycle.

<table>
<thead>
<tr>
<th>Date</th>
<th>Name</th>
<th>Check #</th>
<th>Payment Amount</th>
<th>Applied To / Comment</th>
<th>Reference</th>
<th>Invoice No.</th>
<th>Amount</th>
<th>Debit Account</th>
<th>Credit Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/01/2009</td>
<td>Fields of Golf Farm</td>
<td>8854</td>
<td>$5,000.00</td>
<td>Monthly</td>
<td></td>
<td>100000782</td>
<td>$2,500.60</td>
<td>102</td>
<td>191</td>
</tr>
<tr>
<td>07/02/2009</td>
<td>All In Incorporated</td>
<td>2237</td>
<td>$2,25</td>
<td>Monthly</td>
<td></td>
<td>100000099</td>
<td>$2,25</td>
<td>102</td>
<td>191</td>
</tr>
<tr>
<td>07/03/2009</td>
<td>February Sun Farm</td>
<td>5587</td>
<td>$3,675.73</td>
<td>Monthly</td>
<td>Reference</td>
<td>100000796</td>
<td>$3,675.73</td>
<td>909</td>
<td>191</td>
</tr>
<tr>
<td>07/15/2009</td>
<td>Elliott, Deven</td>
<td>50452</td>
<td>$50,545.25</td>
<td>Monthly</td>
<td></td>
<td>100000057</td>
<td>$50,545.25</td>
<td>102</td>
<td>191</td>
</tr>
<tr>
<td>07/15/2009</td>
<td>Ford Stream Farm</td>
<td>45409</td>
<td>$1,245.60</td>
<td>Monthly</td>
<td></td>
<td>100000040</td>
<td>$1,245.60</td>
<td>102</td>
<td>191</td>
</tr>
<tr>
<td>07/16/2009</td>
<td>Fields of Golf Farm</td>
<td>10,000.00 Monthly</td>
<td>100000059</td>
<td>$1,165.00</td>
<td>100000151</td>
<td>$1,165.00</td>
<td>102</td>
<td>191</td>
<td></td>
</tr>
<tr>
<td>07/04/2009</td>
<td>Fields of Golf Farm</td>
<td>10,000.00 Monthly</td>
<td>100000160</td>
<td>$2,781.80</td>
<td>100000163</td>
<td>$2,781.80</td>
<td>102</td>
<td>191</td>
<td></td>
</tr>
<tr>
<td>07/04/2009</td>
<td>Fields of Golf Farm</td>
<td>10,000.00 Monthly</td>
<td>100000173</td>
<td>$3,613.00</td>
<td>100000223</td>
<td>$3,613.00</td>
<td>102</td>
<td>191</td>
<td></td>
</tr>
<tr>
<td>07/04/2009</td>
<td>Fields of Golf Farm</td>
<td>10,000.00 Monthly</td>
<td>100000202</td>
<td>$1,175.00</td>
<td>100000229</td>
<td>$1,175.00</td>
<td>102</td>
<td>191</td>
<td></td>
</tr>
</tbody>
</table>

Total:
$248,192.13

<table>
<thead>
<tr>
<th>(G/L Account Summary)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debit Amount</td>
</tr>
<tr>
<td>101</td>
</tr>
<tr>
<td>912</td>
</tr>
<tr>
<td>889</td>
</tr>
<tr>
<td>Total Amount</td>
</tr>
</tbody>
</table>
Boarding Charges Report

- This report lists only boarding charges for each horse. It will show the horse’s Boarding type, boarding dates, rate, total amount charged and a grand total of horse days for the billing cycle.

- It is helpful to Group by Boarding Type so that you can easily review all the horses in each Boarding Type group. When you group by Boarding Type, the list will be shown alphabetically by each Boarding Type.
### Billing - Boarding Charges Report

#### Horse Name: Pickett's Board
- **Farm:** TnCIS Main Horse
- **Boarding:** 6/29/2008 - 7/27/2008
- **Days:** 31
- **Owner:** Fields, Pauline E.
- **Rate:** $20.00, 100.00%
- **Horse Total:** $650.00

#### Horse Name: Rosemary (He)
- **Farm:** TnCIS Secondary
- **Boarding:** 6/29/2008 - 7/27/2008
- **Days:** 31
- **Owner:** Watts, Michael J.
- **Rate:** $20.00, 100.00%
- **Horse Total:** $650.00

#### Horse Name: Silverplate
- **Farm:** TnCIS Secondary
- **Boarding:** 6/29/2008 - 7/27/2008
- **Days:** 31
- **Owner:** Pena, Sara
- **Rate:** $20.00, 100.00%
- **Horse Total:** $650.00

#### Horse Name: Teak's Beat
- **Farm:** TnCIS Main Horse
- **Boarding:** 6/29/2008 - 7/27/2008
- **Days:** 31
- **Owner:** Calahan, Caren
- **Rate:** $20.00, 100.00%
- **Horse Total:** $650.00

#### Horse Name: Totally Fire
- **Farm:** TnCIS Main Horse
- **Boarding:** 6/29/2008 - 7/27/2008
- **Days:** 31
- **Owner:** Calahan, Caren
- **Rate:** $20.00, 100.00%
- **Horse Total:** $650.00

**Total Boarding Days:** 165
**Farm Total:** $275.00

---

### Billing - Boarding Charges Report

#### Horse Name: G7 Zulu's Debut
- **Farm:** TnCIS Main Horse
- **Boarding:** 7/30/2008 - 8/31/2008
- **Days:** 31
- **Owner:** Calahan, Caren
- **Rate:** $42.00, 100.00%
- **Horse Total:** $2,220.00

**Total Boarding Days:** 31
**Farm Total:** $4,180.00

**Boarding Days Grand Total:** 146
**Grand Total:** $5,225.00

### G/L Account Summary

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>$22,252.89</td>
<td>$22,252.89</td>
</tr>
<tr>
<td>402</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>403</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>404</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>405</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>406</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>407</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>408</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>409</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>410</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>429</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>52040</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

**Total Debit Amount:** $22,252.89
**Total Credit Amount:** $22,252.89

---

Page 164 of 324
This report shows the service charges that will be applied for the selected billing date range. This report lists each client that will be getting a Service Charge (late fee) and the amount of the Service Charge.

If you click the box to Include Details, the report will show the Invoice Numbers and the late fees that will be applied to each invoice for this billing cycle.
## Billing - Service Charges Report

**Run Date:** 09/17/2010 11:56 AM  
**Company:** TUCIS Test Company  
**Billing Range:** 07/01/2008 - 07/31/2008  
**Billing System:** Standard

### Client Name: Collins, Carol

<table>
<thead>
<tr>
<th>Invoice Number</th>
<th>Amount of Service Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>100000795</td>
<td>$2,653.71</td>
</tr>
<tr>
<td>100000028</td>
<td>$18,874.82</td>
</tr>
<tr>
<td>100000000</td>
<td>$104.76</td>
</tr>
<tr>
<td>100000888</td>
<td>$102.79</td>
</tr>
<tr>
<td>100000073</td>
<td>$107.48</td>
</tr>
<tr>
<td>100000951</td>
<td>$122.02</td>
</tr>
<tr>
<td>100001030</td>
<td>$96.26</td>
</tr>
</tbody>
</table>

**Sub-Total:** $22,071.64

### Client Name: Elliott, Drew

<table>
<thead>
<tr>
<th>Invoice Number</th>
<th>Amount of Service Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>100001021</td>
<td>$7.56</td>
</tr>
<tr>
<td>100000993</td>
<td>$3.23</td>
</tr>
<tr>
<td>100000507</td>
<td>$26,750.14</td>
</tr>
</tbody>
</table>

**Sub-Total:** $26,759.93

### February Rain Farm

<table>
<thead>
<tr>
<th>Invoice Number</th>
<th>Amount of Service Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>100000778</td>
<td>$6.90</td>
</tr>
<tr>
<td>100000964</td>
<td>$31.88</td>
</tr>
<tr>
<td>100001022</td>
<td>$55.80</td>
</tr>
<tr>
<td>100000886</td>
<td>$33.08</td>
</tr>
<tr>
<td>100000999</td>
<td>$7.53</td>
</tr>
</tbody>
</table>

**Sub-Total:** $141.19
## Billing - Service Charges Report

**Run Date:** 09/17/2010 11:58 AM  
**Company:** TJCIS Test Company  
**Billing Range:** 07/01/2008 - 07/31/2008  
**Billing System:** Standard

### Show Details

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Invoice Number</th>
<th>Amount of Service Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>100000795</td>
<td>$21.06</td>
</tr>
<tr>
<td></td>
<td>100000761</td>
<td>$18.00</td>
</tr>
<tr>
<td></td>
<td>100000779</td>
<td>$68.70</td>
</tr>
</tbody>
</table>

**Sub-Total:** $97.76

### Watts, Michael J.

<table>
<thead>
<tr>
<th>Invoice Number</th>
<th>Amount of Service Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>100000764</td>
<td>$72.00</td>
</tr>
<tr>
<td>100000783</td>
<td>$1,267.41</td>
</tr>
<tr>
<td>100000000</td>
<td>$51.02</td>
</tr>
<tr>
<td>100000835</td>
<td>$47.09</td>
</tr>
<tr>
<td>100000888</td>
<td>$61.26</td>
</tr>
<tr>
<td>100000875</td>
<td>$68.45</td>
</tr>
<tr>
<td>100000896</td>
<td>$70.35</td>
</tr>
<tr>
<td>100000712</td>
<td>$73.17</td>
</tr>
<tr>
<td>100000203</td>
<td>$28.78</td>
</tr>
<tr>
<td>100000241</td>
<td>$22.10</td>
</tr>
<tr>
<td>100000282</td>
<td>$20.57</td>
</tr>
<tr>
<td>100000299</td>
<td>$42.06</td>
</tr>
<tr>
<td>100000404</td>
<td>$43.55</td>
</tr>
<tr>
<td>100000861</td>
<td>$73.34</td>
</tr>
<tr>
<td>100000871</td>
<td>$50.36</td>
</tr>
<tr>
<td>100000854</td>
<td>$50.39</td>
</tr>
<tr>
<td>100001028</td>
<td>$45.08</td>
</tr>
<tr>
<td>100000843</td>
<td>$40.70</td>
</tr>
</tbody>
</table>

**Sub-Total:** $2,000.20

**Grand Total:** $2,097.96
Services Tax Report

This report will show the client’s name and the total Services Tax amount for each client for this billing cycle.

Note: This feature is used by international clients. It allows the entry of a service tax such as GST, HST, VAT, etc. to be charged on selected boarding types and/or procedures.
Preliminary A/R Report

This report shows what your client’s balances will look like after this billing cycle is closed.

Detailed A/R Report

This report shows the Invoice Number, the Invoice Date, Invoice Amount, the Payment or Adjustment Date, Check Number, Reference, Comments, the Actual Payment or Adjustment Amount, the Debit and Credit Account number and the Balance. The Payment/Adjustment Amount column will indicate if the amount is an Invoice (I), Service Charge (S), Receipt (R), Unapplied Payment (U) or Adjustment (A).

The report will group the account information into 30, 60, 90 days aging and current aging.
Closing Summary

- This is a one-page report summarizing your clients’ Beginning Balances, Cash Receipts, Direct Charges/Credits, Procedure Charges, etc.

<table>
<thead>
<tr>
<th>Client Beginning Balances</th>
<th>$4,053,176.66</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Boarding Charges</td>
<td>$22,237.09</td>
</tr>
<tr>
<td>Total Procedure Charges</td>
<td>$5,531.04</td>
</tr>
</tbody>
</table>

**Total Revenue**
- **Total All In / Departure** $0.00
- **Total Blacksmith** $1,320.00
- **Total Unworn** $328.00
- **Total Recurring Procedures** $185.00
- **Total Reproduc** $340.00
- **Total Tax** $1,762.00
- **Total Vaccinations** $12.20
- **Total Surgery** $75.00
- **Total Veterinary** $1,262.00

Board and Procedure Revenue Report

- This report will display all of the board and procedure charges for the current billing. The charges will be sorted by G/L account numbers first and then by farm. The G/L Account Summary is on the last page of this report and will separate the board charges from the procedure charges if G/L Numbers have been assigned.
<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7058</td>
<td>TCDC Secondary Mare Farm</td>
<td>Yellow Jopali</td>
<td>Willis, Michael J.</td>
<td>07/10/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7059</td>
<td>TCDC Secondary Mare Farm</td>
<td>Yellow Jopali</td>
<td>Willis, Michael J.</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $183.51

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7060</td>
<td>Training Facility</td>
<td>High Moss</td>
<td>February Rain Farm</td>
<td>07/15/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7061</td>
<td>Training Facility</td>
<td>High Moss</td>
<td>February Rain Farm</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
<tr>
<td>7062</td>
<td>Training Facility</td>
<td>Judd Sable</td>
<td>Colleen, Carol</td>
<td>07/10/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7063</td>
<td>Training Facility</td>
<td>Judd Sable</td>
<td>Colleen, Carol</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
<tr>
<td>7064</td>
<td>Training Facility</td>
<td>A Georgia</td>
<td>Ottines' Ranch</td>
<td>07/10/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7065</td>
<td>Training Facility</td>
<td>A Georgia</td>
<td>Ottines' Ranch</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
<tr>
<td>7066</td>
<td>Training Facility</td>
<td>A Georgia</td>
<td>Ottines' Ranch</td>
<td>07/10/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7067</td>
<td>Training Facility</td>
<td>A Georgia</td>
<td>Ottines' Ranch</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
<tr>
<td>7068</td>
<td>Training Facility</td>
<td>Told By Fire</td>
<td>D'Erwanne, Colleen</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
<tr>
<td>7069</td>
<td>Training Facility</td>
<td>Twilight Agenda</td>
<td>Willis, Michael J.</td>
<td>07/15/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7070</td>
<td>Training Facility</td>
<td>Twilight Agenda</td>
<td>Willis, Michael J.</td>
<td>07/15/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7071</td>
<td>Training Facility</td>
<td>Twilight Agenda</td>
<td>Elliot, David</td>
<td>07/15/2008</td>
<td>Exam - General</td>
<td>$25.00</td>
<td>100.00%</td>
<td></td>
<td>$25.00</td>
<td></td>
</tr>
<tr>
<td>7072</td>
<td>Training Facility</td>
<td>Twilight Agenda</td>
<td>Elliot, David</td>
<td>07/15/2008</td>
<td>Prenailin</td>
<td>$2.50</td>
<td>100.00%</td>
<td></td>
<td>$2.50</td>
<td></td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $573.00

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7061</td>
<td>TCCC Stallion Arena</td>
<td>Stallion</td>
<td>Test of Time</td>
<td>Colleen, Carol</td>
<td>07/01/2008</td>
<td>Thru 7/07/2008</td>
<td>31</td>
<td>$10.00</td>
<td>100.00%</td>
<td>$310.00</td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $310.00

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7061</td>
<td>TCCC Meat Mare Farm</td>
<td>Stallion</td>
<td>Test of Time</td>
<td>Colleen, Carol</td>
<td>07/01/2008</td>
<td>Thru 7/07/2008</td>
<td>31</td>
<td>$10.00</td>
<td>100.00%</td>
<td>$310.00</td>
</tr>
<tr>
<td>7062</td>
<td>TCCC Meat Mare Farm</td>
<td>Stallion</td>
<td>Test of Time</td>
<td>Michael, J.</td>
<td>07/01/2008</td>
<td>Thru 7/07/2008</td>
<td>31</td>
<td>$10.00</td>
<td>100.00%</td>
<td>$310.00</td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $620.00

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7061</td>
<td>TCCC Meat Mare Farm</td>
<td>Stallion</td>
<td>Hot Clicks</td>
<td>Just For You Farm</td>
<td>07/01/2008</td>
<td>Thru 7/07/2008</td>
<td>31</td>
<td>$15.00</td>
<td>100.00%</td>
<td>$450.00</td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $450.00

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Farm</th>
<th>Horse Type</th>
<th>Horse Name</th>
<th>Client Name</th>
<th>Date</th>
<th>Description</th>
<th>Days</th>
<th>Rate</th>
<th>Owner %</th>
<th>Amount Billed</th>
</tr>
</thead>
<tbody>
<tr>
<td>7061</td>
<td>TCDC Meat Mare Farm</td>
<td>A Real Ruby</td>
<td>D'Erwanne, Colleen</td>
<td>07/22/2008</td>
<td>Thru 7/29/2008</td>
<td>31</td>
<td>$300.00</td>
<td>100.00%</td>
<td>$9,300.00</td>
<td></td>
</tr>
<tr>
<td>7062</td>
<td>TCDC Meat Mare Farm</td>
<td>Mediterranean Pines</td>
<td>McCabe, Brian</td>
<td>07/22/2008</td>
<td>Thru 7/29/2008</td>
<td>31</td>
<td>$300.00</td>
<td>100.00%</td>
<td>$9,300.00</td>
<td></td>
</tr>
</tbody>
</table>

**Farm GL Account Total**: $18,600.00

---

**Report Total**: $22,761.93

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>7058</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7059</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
</tbody>
</table>

**Procedure Summary**

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>7060</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7061</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7062</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7063</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7064</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7065</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7066</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7067</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7068</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7069</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7070</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7071</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
<tr>
<td>7072</td>
<td>$25.00</td>
<td>$25.00</td>
</tr>
<tr>
<td>7073</td>
<td>$2.50</td>
<td>$2.50</td>
</tr>
</tbody>
</table>

**Boarding Summary**

---

<table>
<thead>
<tr>
<th>GL Account</th>
<th>Debit Amount</th>
<th>Credit Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>7061</td>
<td>$22,223.89</td>
<td>$22,223.89</td>
</tr>
<tr>
<td>401</td>
<td>$7,788.75</td>
<td>$7,788.75</td>
</tr>
<tr>
<td>402</td>
<td>$4,265.25</td>
<td>$4,265.25</td>
</tr>
<tr>
<td>403</td>
<td>$1,116.60</td>
<td>$1,116.60</td>
</tr>
<tr>
<td>404</td>
<td>$2,419.60</td>
<td>$2,419.60</td>
</tr>
<tr>
<td>405</td>
<td>$1,775.00</td>
<td>$1,775.00</td>
</tr>
<tr>
<td>406</td>
<td>$1,015.60</td>
<td>$1,015.60</td>
</tr>
<tr>
<td>407</td>
<td>$1,015.60</td>
<td>$1,015.60</td>
</tr>
<tr>
<td>408</td>
<td>$1,015.60</td>
<td>$1,015.60</td>
</tr>
<tr>
<td>409</td>
<td>$2,249.69</td>
<td>$2,249.69</td>
</tr>
<tr>
<td>410</td>
<td>$2,249.69</td>
<td>$2,249.69</td>
</tr>
<tr>
<td>N00701</td>
<td>$4,030.00</td>
<td>$4,030.00</td>
</tr>
</tbody>
</table>

**Total Amounts**: $22,223.89
Invoices

These are NOT your final invoices - these are your Edit invoices and should be reviewed for accuracy before you actually finalize the billing. At this point you can still make any changes and/or corrections, generate again and review the Edit invoices.

Remember: You can choose to have the invoice summarized or you can show all of the detail.
This Sample invoice shows all of the Detail.

TJCIS Test Company
621 Corporate Drive
4th Floor
Lexington, KY 40503
Phone: (859) 224-2810
E-mail: www.tjcis.com

O'Riley's Racing County Tipperary Ireland

Billing Statement
Period Ending: 07/31/2008

Invoice # 100001110

CLIENT SUMMARY

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/25/2008</td>
<td></td>
<td>$235.40</td>
</tr>
<tr>
<td>07/01/2008</td>
<td></td>
<td>$263.00</td>
</tr>
<tr>
<td>07/09/2008</td>
<td></td>
<td>$87.24</td>
</tr>
<tr>
<td>07/28/2008</td>
<td></td>
<td>$125.40</td>
</tr>
</tbody>
</table>

Adjustments

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/25/2008</td>
<td></td>
<td>$750.00</td>
</tr>
<tr>
<td>07/01/2008</td>
<td></td>
<td>$785.00</td>
</tr>
<tr>
<td>07/09/2008</td>
<td></td>
<td>$222.00</td>
</tr>
<tr>
<td>07/28/2008</td>
<td></td>
<td>$924.00</td>
</tr>
</tbody>
</table>

BEGINNING BALANCE:

<table>
<thead>
<tr>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>$94.50</td>
</tr>
<tr>
<td>$384.50</td>
</tr>
</tbody>
</table>

Current Month Horse Charges

<table>
<thead>
<tr>
<th>Horse Name</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>D6 A Georgia</td>
<td>$64.75</td>
</tr>
<tr>
<td>A Georgia</td>
<td>$443.25</td>
</tr>
<tr>
<td>Pineapple Princess</td>
<td>$67.41</td>
</tr>
</tbody>
</table>

Total Horse Charges $561.41

Please return this portion with payment

Client No. Invoice # Client Name Amount Paid Due Current Total Due
7 100001110 O'Riley's Racing $604.87 $567.83 $1,072.76
TJCIS Test Company
821 Corporate Drive
4th Floor
Lexington, KY 40503
Phone: (859) 224-2810
E-mail: www.tjcis.com

<table>
<thead>
<tr>
<th>Service Charges</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>07/31/2000 (Invoice #: 100000450)</td>
<td>$4.10</td>
</tr>
<tr>
<td>07/31/2000 (Invoice #: 1000003945)</td>
<td>$1.29</td>
</tr>
<tr>
<td>07/31/2000 (Invoice #: 1000000285)</td>
<td>$1.88</td>
</tr>
</tbody>
</table>

Total for Invoice #100001110 $571.66

ENDING BALANCE: $1 $7.276

Please send all Board Billing payments to P.O. Box 821 Lexington, KY 40503. Please do not use our physical street address when mailing a check via regular mail.

Service charges represent 1.5% interest being charged on any past due accounts. Please remit board payments in a timely manner to avoid such charges in the future.

Thank you for your business.
This Sample invoice is for the same client but has been Summarized.

TJCIS Test Company
821 Corporate Drive
4th Floor
Lexington, KY 40503
Phone: (869) 224-2810
E-mail: www.tjcis.com

<table>
<thead>
<tr>
<th>Client Summary</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PREVIOUS BALANCE:</strong></td>
<td><strong>Charges</strong></td>
<td><strong>Credits</strong></td>
<td><strong>Balance</strong></td>
</tr>
<tr>
<td>Adjustments</td>
<td>$1,257.08</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BEGINNING BALANCE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>$501.00</td>
</tr>
<tr>
<td><strong>Current Month Horse Charges</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B&amp;B George</td>
<td>$54.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A George</td>
<td>$422.28</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pineapple Princess</td>
<td>$374.41</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total Horse Charges</strong></td>
<td>$951.44</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Service Charges</strong></td>
<td></td>
<td></td>
<td>$7.27</td>
</tr>
<tr>
<td><strong>Total for Invoice</strong></td>
<td></td>
<td></td>
<td>$958.71</td>
</tr>
<tr>
<td><strong>ENDING BALANCE:</strong></td>
<td></td>
<td></td>
<td>$1,072.76</td>
</tr>
</tbody>
</table>

Please send all Board Billing payments to P.O. Box 921 Lexington, KY 40503. Please do not use our physical street address when mailing a check via regular mail.

Service charges represent 1.5% interest being charged on any past due accounts. Please remit board payments in a timely manner to avoid such charges in the future.

Thank you for your business.

Please return this portion with payment

<table>
<thead>
<tr>
<th>Client No.</th>
<th>Invoice #</th>
<th>Client Name</th>
<th>Amount Past Due</th>
<th>Current</th>
<th>Total Due</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>100001110</td>
<td>O’Riley’s Racing</td>
<td>$654.87</td>
<td>$567.89</td>
<td>$4,072.76</td>
</tr>
</tbody>
</table>
Billing – Finalize Billing

To make the billing process final, the system must update tables to reflect the current billing balances, record aging balances, flag procedures as having been invoiced, etc. This process is accomplished when you select “Finalize Billing”.

Finalize Billing is the final step in the billing process. Do NOT select this option unless you have reviewed all of the Preliminary Reports are satisfied that your billing is correct.

To Finalize the billing, go to Billing > Standard and click on “Finalize Billing”. If you have generated for <All> Clients and <All> Horses, the finalize screen will look like this:
If you have generated for **only one client**, the Finalize Billing screen will look like this:

![Billing - Finalize Billing](image)

If you have generated for **only one horse**, the Finalize Billing screen will look like this:

![Billing - Finalize Billing](image)

Click “Finalize” to begin the process.

![Continue with Billing Finalize](image)

Click “Yes” to continue the finalization process.
Click “No” if you do not want to Finalize at this time.
When the Finalize has been completed, you will get this message.

![Finalize Complete](image)
After the Finalize has completed you will print your invoices.

Go to Billing > Standard > Print invoices

NOTE: A/R Aging Files are not updated until the Finalize process is performed.

NOTE: If you have selected to Suppress the Billing on any of your clients, the billing process will NOT produce an invoice for them. See (A) & (B)
While there is no actual invoice, you can print several reports to see what the suppressed charges are for that billing period.

To see the Suppressed Charges you can print a Pre-Billing Report (A) just for Suppressed Billing, you can print Boarding Charges (B) just for Suppressed Billing, and the total amount of suppressed charges for the current billing will appear on your Closing Summary Report (C).
NOTE: “Finalize Billing” option should not be selected until you are satisfied that all information in the billing is correct.

Once the Finalize Process has completed you can print your invoices and you can print any of the Historical Journals that were saved during the Finalize process.

To view and/or print the final invoices go to Billing > Standard > Print Invoices.
Select the Billing Period Ending Date and select <All> clients or select just one client from the drop down list.

**NOTE:** You can also print your final invoices by going to Billing > Standard > Historical Reports > **Invoices** and select the Billing Period Ending Date and <All> clients or select just one client from the drop down list.
Once the Finalize process has been completed, the “EDIT” watermark is removed from the invoice.
To print Invoices or any of the Historical Journals go to Billing > Standard > Historical Reports

- To print Invoices, select “Invoices” and then select the Billing Period Ending date and <All> clients. If you only want to print one client’s invoice, select the Billing Period Ending date and then select the one client from the drop down list.
• Or you can go directly to the Save folder and view/print any of the Historical Journals from that location.

• Each folder in the directory is named according to the ending date range for each billing that has been finalized. Find the ending date range for the billing you want to view and click on the folder.
- All Historical Journals including the Invoices are saved as PDF files.
- When you find the file you want to open, double click on the file. The file will open up and you will be able to view and/or print.

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Type</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.PDF</td>
<td>14 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>2.PDF</td>
<td>21 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>4.PDF</td>
<td>20 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>5.PDF</td>
<td>19 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>7.PDF</td>
<td>17 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>9.PDF</td>
<td>19 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>Adjustments.PDF</td>
<td>8 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>AgedAR.PDF</td>
<td>8 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>ClosingJournal.PDF</td>
<td>13 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:20 PM</td>
</tr>
<tr>
<td>DetailedAR.PDF</td>
<td>6 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>Invoices.PDF</td>
<td>30 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>Payments.PDF</td>
<td>54 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>ProcedureJournal.PDF</td>
<td>13 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>Revenue.PDF</td>
<td>41 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:20 PM</td>
</tr>
<tr>
<td>ServiceCharges.PDF</td>
<td>46 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>ServicesTax.PDF</td>
<td>7 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
<tr>
<td>SuppressedRevenue.PDF</td>
<td>11 KB</td>
<td>Adobe Acrobat Doc...</td>
<td>09/19/2006 3:19 PM</td>
</tr>
</tbody>
</table>

**Note:** The invoices will be at the top of the list and the number before the .PDF file extension represents the client's actual client Number.
Recording the Breeding Season

1. Creating a Mare's Breeding "Season" Record
   - Select "Mare Info" from the menu.
   - Select "Mares" menu item.

Note: You can also get to this screen by clicking the "Mare Info." button in the "Horse Entry/Edit" form.
- Select a mare name from the list on the screen and press "Edit" or double-click on the mare name.

If the horse is not yet in the mare list and you want to add her as a Mare, click the **Add** button to see your complete horse list and then click on the name of the horse you want to add as a mare and click "Select".
Enter New Season Year: Enter the “Season Year” and press “OK”.

- Horse Name  - Horse Type  - Band Tag Number  - Active
  - Farm Mare #1  - Mare  -  -
  - Farm Mare #2  - Mare  -  -
  - Farm Mare #3  - Mare  -  -
  - A PARTNER MARE  -  -  -
  - Always Best (FR)  - In Training  -  -
  - Irish Moss  - In Training  -  -
  - Russian Sage  - In Training  -  -
  - Wind & Rain  - Mare  -  -
  - OS A Georgia  - Foal of OS  -  -
  - OS Arkansas  - In Training  -  -

Select  Close
If the mare is already in the Mare list, select her name and click “Edit”.

- Season Year: Click the “New” button, enter the “Season Year” and click “OK”
Starting Status: Select the mare’s Starting Status from the drop down list. The Starting Status reflects her reproductive status on January 1 of the New Season Year that you just added. (Maiden, In Foal, etc.)

Booked To: Enter the name of the stallion that the mare is scheduled to be bred to for that breeding season ("Booked To" field). You can either type in the name of the stallion, or if you have entered the stallion in your master horse list, click on the "🔍" button and select the stallion from your master list of horses.

[Optional] Share Owner: Enter the name of the person/farm that owns the share you are breeding the mare on.

[Optional] Share #: Enter the share number you will be using.

[Optional] Confirmed By / On: Enter the name of the person that confirmed this breeding on this share and select the date it was confirmed. Remember you can manually enter the date or you can click the drop down arrow and select a date from the calendar.

Standing Farm: Enter the name of the farm where the stallion stands. You can type in the name of the farm or you can click on the "🔍" button and select the farm name from your master list of farms.

If you selected the farm name from the master farm list, the system will automatically fill in the farm’s phone number, contact name and breeding requirements (if you had originally entered this information in the farm master file list).

If you did not select the farm name from the master farm list, you can manually enter the Farm Name, Contact name, the farm’s phone number and the farm’s Breeding Requirements.

Final Status: At the conclusion of the breeding season, select the mare’s status from the drop down selection (In Foal, Barren, Slipped, Not Bred, etc.)

Last Exam: As the mare is checked for pregnancy during the season, you can enter her status in the “Last Exam” field (Pg, Pd, Pd+, Barren, Slipped, etc.)

Last Date Bred: The system will automatically fill in the “Last Date Bred” field in the lower left hand side of the Mare Info. Entry/Edit screen.

Mare Info Comments: Comments entered in this field will show up only on the “Broodmare Listing” report.
Note: Previous Season information and Foaling Info are read-only fields. The Previous Season information will be populated with the breeding information from the previous year if it has been entered and the Foaling Info will be populated with the foaling information from the previous season if it has been entered.

Mare Info Sheet and Breeding Shed Form

These forms are time savers as they are pre-populated with the mare information found in the Mare Entry/Edit screens. You can print them out and send them with the mare when she goes to the breeding shed.
NAME OF STALLION: Whisper My Name

Please indicate the way you would like the mare ownership reported to The Jockey Club:

Name: Michael J. Wett
Phone: (301) 541-3311
Address: 152 Magnolia Bay Lane, Springfield, Virginia 22159

MARE INFORMATION

Mare's Name: Yellow Jellou (NU01) Year of Birth: 2015 Color: Chestnut
Sire: Spring Frost Dam: Whitmore Miss
Mare's Current Status: In-foal

MARE'S 2010 PRODUCE (If Applicable)

Foaling Date: 
Foal Sex: 
Foal Color: Chestnut

Stallion End to in 2009: Call Me
Last Date Covered in 2009: 05/01/2009

IMPORT STATUS: Is this mare an IMPORT for the 2010 Breeding Season?
Yes / No
Import Date: 
Country of Origin:

MARE'S 2010 BOARDING FARM

Farm Name: TJCIS Secondary Mare Farm
E-mail: info@secondaryfarm.com
Address: 841 TJCIS Farm Lane, Lexington, Kentucky 40503
Phone: (859) 224-2800
Manager: Secondary
Contact: Secondary Contact
Fax:
Mare's Veterinarian: Secondary Vet
Tel: Phone: Secondary Phone 222-4444

MARE'S RECENT PRODUCE HISTORY

<table>
<thead>
<tr>
<th>Year Bred</th>
<th>Sire Of Foal</th>
<th>Date Foaled</th>
<th>Color</th>
<th>Sex</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>Hafl and Hafl</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2007</td>
<td>Wandering Lou</td>
<td>01/02/2008</td>
<td>Bay</td>
<td>Colt</td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>Gem Of A Guy</td>
<td>01/15/2006</td>
<td>Chestnut</td>
<td>Colt</td>
<td></td>
</tr>
</tbody>
</table>
2010 Breeding Season

This breeding shed form must accompany the mare each time she is presented for breeding.

Date: _______________ Time: _______________ Breeding Session: _______________

Stallion: Whisper My Name  
Mare: Yellow Jumper [YJ01]

Mare's Sire: Spring Frost  
Mare's Dam: Wildflower Blis.

Mare's Age: 8  
Mare's Color: Chestnut

- Mare must have proper identification (halter nameplate or neckstrap) in order to be bred.
- Please circle the appropriate requirements for each trip that need to accompany the mare and attach the necessary paperwork.
- Please note that the mare will not be bred without these documents.

<table>
<thead>
<tr>
<th></th>
<th>1st Trip</th>
<th>2nd Trip</th>
<th>3rd Trip</th>
<th>4th Trip, ETC.</th>
<th>DOUBLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domestic Maiden</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
</tr>
<tr>
<td></td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
</tr>
<tr>
<td>Domestic Barren</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
</tr>
<tr>
<td></td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
</tr>
<tr>
<td>Domestic Foaling</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
</tr>
<tr>
<td></td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
</tr>
<tr>
<td>Imported Maiden</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
</tr>
<tr>
<td></td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
</tr>
<tr>
<td>Imported Barren</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
<td>Sheath Form</td>
</tr>
<tr>
<td></td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
<td>Uterine Culture</td>
</tr>
<tr>
<td></td>
<td>- 2 CEM Cultures</td>
<td>- 2 CEM Cultures</td>
<td>- 2 CEM Cultures</td>
<td>- 2 CEM Cultures</td>
<td>- 2 CEM Cultures</td>
</tr>
<tr>
<td></td>
<td>- 1 set to include Endometrium Swab Jumped</td>
<td>- 1 set to include Endometrium Swab Jumped</td>
<td>- 1 set to include Endometrium Swab Jumped</td>
<td>- 1 set to include Endometrium Swab Jumped</td>
<td>- 1 set to include Endometrium Swab Jumped</td>
</tr>
</tbody>
</table>

Page 193 of 324
2. Automatically Adding New Broodmare Season Records

- Select “Mare Info”
- Select Generate Broodmare Season
- Enter the Season Year and select Generate

- The “Generate Broodmare Season” is used to generate a new season record for all mares at one time. In order for the system to generate a new season record, the mare must have a previous record to generate from and the mare must have a current arrival date. You can generate new season records at any time during the year and as many times as needed or you can add seasons one by one manually.
Note: The system will automatically print a list of mares that it has created a new season record for each time you generate.

- If there are no mares that need a new season, you will get a message to that effect when you generate. Mares that already have a season will not be duplicated.

3. Booking the Mare for Breeding

- Select “Mare Info” from the menu.
- Select “Mares”
- Select a horse name from the Mare Entry/Edit list and click “Edit” (You can also get to this screen by clicking the “Mare Info.” tab on the “Horse Entry/Edit” form)
- Select the season that you would like to work with
- Click on the “Breeding Dates” tab to open the “Breeding Dates Entry/Edit” Screen

- Click “New”
4. Recording the Breeding Dates

When you have confirmation that the mare has been bred:

- Select “Mare Info” from the menu.
- Select “Mares”
- Select the horse name from the Mare Entry/Edit list and click “Edit” (You can also get to this screen by clicking the “Mare Info.” tab on the “Horse Entry/Edit” form)
- Select the season that you would like to work with
- Click on the “Breeding Dates” tab to open the “Breeding Dates Entry/Edit” Screen
- Select “Bred” in the status area

- [Optional] Enter any comments related to the breeding (Excellent Cover, etc.)

- [Optional] Print breeding comments on invoice: Click in the box if you want the breeding comments to appear on the client’s invoice. Leave the box blank if you do not want the comments to appear on the client’s invoice. **Note:** in order for this option to work, you must have already set up a single procedure as your “Breeding Procedure”. See Master Files “Procedure Master Entry/Edit” section.
• These comments will appear as part of the horse’s health record whether or not the “Print breeding comments on invoice” box is checked if you have set up one procedure as your “Breeding Procedure”.
• Click “Save”

- Last day the mare was bred: The system will automatically fill in the “Last Date Bred” field in the lower left hand side of the Mare Entry/Edit screen.

Note: Comments entered in the “Mare Info Comments” area will print only on the “Broodmare Listing” report.

5. Recording the Foaling Information

Important Note: Foaling information must be entered in the mare’s record based on the breeding season not the foaling year. For example: If a foal is born on 3/17/11, that foaling information must be entered through the 2010 season.

• Select “Mare Info” from the menu.
• Select “Mares”
• Select the horse name from the Mare Entry/Edit list and click “Edit” (You can also get to this screen by clicking the “Mare Info.” tab on the “Horse Entry/Edit” form)
• Select the season that you would like to work with
• Click on the “Foaling Info” tab to open the “Foaling Entry/Edit” screen.
Enter the foaling information:
- The foaling date
- The time the water broke
- The time of foaling
- The time that the foal stood
- The time that the foal nursed
- The time that the placenta was shed
- The name of the farm where the mare foaled
- The foal's color and the foal's sex
- Enter any comments related to the foal or foaling
- After entering all of the foaling information, click the “Add Foal as New Horse” button (A)
The foal’s name will be pre-populated based on the settings you selected in Setup > Preferences > Mare/Foal Settings.

- Edit the foal name if necessary
- Select the Board Type
- The Foaling Date will be pre-populated based on the foaling date you entered on the foaling info. page.
- Click “OK” and the system will automatically create a new horse record for the foal using the information you have supplied in the Foaling Entry/Edit screen. The system will assign ownership of the foal to be the same as the dam's ownership and it will automatically enter an arrival date in the Boarding screen.
- Click “Save”

**Teasing Information**

- Select “Mare Info”
- Select “Teasing Worksheet”

**Teasing Worksheet**

This produces a worksheet where teasing results and comments can be noted and then later entered into HFM.

- Select “Mare Info”
- Select “Teasing Worksheet”
Select the date for current results.
Select a specific farm from the drop down list or leave Farm as <All> to print worksheets for all farms.
Accept the default to show “Only Currently Boarding” mares or remove the “check” to show all mares on the report.

This report shows the mare name, the date the mare is due to foal, the actual foaling date, the last day she was bred, the results from the last 7 days of teasing (based on the result date selected) and an area to note the current day’s teasing results and comments.

- The “Due Date” is calculated based on what you entered in Setup > Preferences > Mare/Foal Settings (Days Between Last Day Bred and Foaling Date). The value for “Due Date” can be any number that you want to enter.
Teasing Results Entry

To enter teasing results for mares

- Select “Mare Info” from the menu.
- Select “Teasing Results Entry” menu item.

First enter the Teasing Date and then click “Display”. The list will show all mares that have a breeding season set up. If you want the list to display mares that are Not Currently Boarding, uncheck the “Only Currently Boarding” box.

Enter the teasing results for that day and any comments and click “Save”. We recommend that you enter only three (3) characters in the Teasing Results field since the teasing reports will only display three (3) characters. Comments are stored in this record only and will not appear on any reports.

If you want to enter several teasing results for several days just enter a new teasing date, click “Display” and enter the results as before. When finished, click “Save.”
Teasing Results Entry (From the Mare Information Page)

- Select “Mare Info” from the menu.
- Select “Mares”
- Select the horse name from the Mare Entry/Edit list and click “Edit” (You can also get to this screen by clicking the “Mare Info.” tab on the “Horse Entry/Edit” form)
- Select the season that you would like to work with
- Click on the “Teasing Results” tab to open the “Teasing Results Entry/Edit” Screen

- Enter the Teasing Results for this mare. We recommend that you enter only three (3) characters in the Teasing Results field since the teasing reports will only display three (3) characters.
- Enter any Teasing Comments. These comments are stored in this record only and will not appear on any reports.
- Click “Save”
Teasing Results Report

- Select “Mare Info”
- Select “Teasing Results Report”

- Select the season from the drop down list.
- Select a specific farm from the drop down list or leave “Farm” as <All> to see all farms.
- Select an owner from the drop down list or leave “Owner” as <All> to see teasing results for all horses.
- Select a specific horse type from the drop down list or leave “Horse Type” as <All> to see teasing results for all horse types.
- Select a specific horse from the drop down list or leave “Horse” as <All> to see teasing results for all horses or select a Band Tag from the drop down list instead of the horse name.
- Leave the box checked to Show Only Currently Boarding Mares or uncheck the box to see all mares for the season selected.
- Select to sort the report by Farm or Horse. If sorted by Farm, the report will list the farms in alphabetical order and then the horses within each farm alphabetically. If sorted by Horse, the report will list alphabetically by horse name regardless of the farm.
- Select the month range.
- Select to Preview the report or send it directly to the Printer
- Click Submit.
This report will show the mare name, the name of the farm, the mare’s sire, dam, color, YOB, stallion bred to previous season and LDB previous season, current foaling date, color and sex of the foal, stallion booked to in current season, beginning status and final status for current season.

This report will show any Teasing results that have been entered for each horse (Mare Info > Mares > Teasing Info.) or (Mare Info > Teasing Results Entry). Additionally, this report will show entries for LO, RO, Cervix & Other (Master File > Procedure Master > “Procedure Types: Results on Teasing Chart & Update Mare Exam Status)

See Example (A)
Example (A)
1. Foaling Report
   - Select “Mare Info”
   - Select “Reports”
   - Select “Foaling”

   - Select the date range you want to see
   - Select a specific farm from the drop down list or leave “Farm” as <All> to see all foals at all farms.
- [Optional] Group by Farm
- [Optional] Show only currently boarding mares
- [Optional] Format the report to be exported
- Select to Preview the report or send it directly to the Printer
- Click Submit.

The Foaling Report pulls information directly from the "Foaling Info" page on the "Mare Entry/Edit" screen.

```
Foaling Report

<table>
<thead>
<tr>
<th>#</th>
<th>Mare</th>
<th>Bred To 2005</th>
<th>Foal Color</th>
<th>Sex</th>
<th>Date</th>
<th>Time</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Rosemary (fie)</td>
<td>Stuff Of Dreams</td>
<td>Dark Bay/Grey</td>
<td>Colt</td>
<td>2/2/2005</td>
<td>1:30 AM</td>
<td>Very nice first foal - good mother. 130 lbs. Strong colt - nice out slightly left front.</td>
</tr>
</tbody>
</table>

Total Foals: 2
```
The Foaling Report shows the sequence number of the mare, the mare’s name, the name of the stallion that the mare was bred to in the previous season, the color of the foal, the sex of the foal, the date the mare foaled, what time the mare foaled and any comments that were entered in the “Foaling Info” screen.

2. Breeding Report
   - Select “Mare Info”
   - Select “Reports”
   - Select “Breeding”

   ![Breeding Report]

   - Select the Season
   - Select one particular farm or leave “Farm” as <All> to see all mares at all farms
   - If you want the report to be Grouped by farm, click in the box next to “Group By Farm”
   - [Optional] Show only currently boarding mares
   - Select to Preview the report or send it directly to the Printer
   - Click Submit.
This report lists the sequence number of the mare, how many times the mare was bred, the mare’s name, the last day the mare was bred, whether the last day bred was a double, the name of the stallion she was last bred to, how many days since the mare was last bred and the status of the mare after her last exam.

- As mares are re-bred, their names will automatically be re-arranged in chronological order.
- The Status column pulls information from the “Last Exam” field on the Mare Entry/Edit screen.
3. **Outside Bookings**

- Select “Mare Info”
- Select “Reports”
- Select “Outside Bookings”

![Outside Bookings Report](image)

- **Starting Date**: 04/01/2011
- **Ending Date**: 08/31/2011
- **Farm**: <All>

- **Show Cancelled Bookings**: Check to show cancelled bookings.

- **Print Mode**
  - Preview
  - Printer

- **Submit**
- **Close**

- **Select the date range you want to see**
- **Select a specific farm from the drop down list or leave “Farm” as <All> to see the outside bookings for all mares at all farms.**
- **Click the box “Show Cancelled Bookings” if you want the report to show the bookings that have been cancelled. If this box is blank, no cancelled bookings will print on the report.**
- **Select to Preview the report or send it directly to the Printer**
- **Click Submit.**
The Outside Bookings report will show you what day of the week the mare is scheduled (Mon, Tue, etc.), the actual date the mare is scheduled to be bred (m/dd/yyyy), the time the mare is booked, the mare’s name, the name of the stallion the mare is booked to, the name and phone number of the farm where the stallion stands, the breeding requirements at the stallion farm, who will van the mare to the breeding shed and what time they will pick her up.

Additionally, the Outside Bookings report will show any booking comments that have been entered on the “Breeding Dates Entry/Edit” screen and whether or not the mare was Bred or the breeding was **Cancelled**.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Mare Name</th>
<th>Standing Farm</th>
<th>Breeding Requirements</th>
<th>Vannoy By Pick Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tue</td>
<td>2/17/2009</td>
<td>8:00 AM</td>
<td>Siberian Iris [OH 200668 001]</td>
<td>Mountain King</td>
<td>Breeding requirements for Stallion Farm H</td>
</tr>
<tr>
<td>Wed</td>
<td>2/18/2009</td>
<td>8:30 PM</td>
<td>Siberian Iris [OH 200668 001]</td>
<td>Mountain King</td>
<td>Breeding requirements for Stallion Farm H</td>
</tr>
<tr>
<td>Tue</td>
<td>3/3/2009</td>
<td>5:00 PM</td>
<td>Mediterranean Pinks</td>
<td>Win OKar</td>
<td>Breeding requirements for Stallion Farm A</td>
</tr>
<tr>
<td>Wed</td>
<td>3/11/2009</td>
<td>8:30 AM</td>
<td>Watchful Eye</td>
<td>Runaway’s Groom</td>
<td>Breeding requirements for TUCS Main Station Farm</td>
</tr>
<tr>
<td>Fri</td>
<td>5/1/2009</td>
<td>2:00 PM</td>
<td>Yellow Jonquil [Y.R]</td>
<td>Call Me</td>
<td>Breeding requirements Stallion Farm L</td>
</tr>
<tr>
<td>Sun</td>
<td>5/3/2009</td>
<td>2:00 PM</td>
<td>Yellow Jonquil [Y.R]</td>
<td>Call Me</td>
<td>Breeding requirements Stallion Farm L</td>
</tr>
</tbody>
</table>
4. Farm Mares Bred Summary

- Select “Mare Info”
- Select “Reports”
- Select “Farm Mares Bred Summary”

- Select the Breeding Season.
- Select one particular stallion from the drop down list or leave “Stallion” as <All> to see all stallions.
- Select one particular Farm from the drop down list or leave “Farm” as <All> to see all farms.
- Select whether to sort the report by how many “Days Since Last Bred” or alphabetically by the “Mare Name”.
- [Optional] Show only currently boarding mares
- Select to Preview the report or send it directly to the Printer
- Click Submit.
This report shows the mare’s name, what her status was at the beginning of the Breeding Season, her foaling date, the name of the Stallion she was bred to, all of her breeding dates for the selected Breeding Season, how many days since she was last bred, her final status and her projected foaling date for the next year.

If the mare was bred to more than one stallion in a breeding season, each stallion’s name will be displayed. (A)

The “Begin Status” is pulled from the Mare Entry/Edit > Mare Info screen “Starting Status” field.

The “Final Status” is pulled from the Mare Entry/Edit > Mare Info screen “Final Status” field.

The “Projected Foaling Date” is calculated based on what you entered in Setup > Preferences > Mare/Foal Settings (Days Between Last Day Bred and Foaling Date). The value for “Due Date” can be any number that you want to enter.
5. Broodmare Listing

- Select "Mare Info"
- Select "Reports"
- Select "Broodmares"

![Broodmare Listing]

- Select the “Season”
- Select one particular Farm from the drop down list or leave “Farm” as <All> to see all farms
- [Optional] Show only currently boarding mares
- Select to Preview the report or send it directly to the Printer
- Click Submit.
This report will show information for the previous breeding season and the selected season for each broodmare.

The previous season will show the name of the stallion the mare was bred to, the farm where the stallion stands, the name of the person that confirmed the booking and the date the booking was confirmed, the last bred date, the foaling date, the foal color and the foal sex.

The current season will show the name of the stallion, the name of the farm where the stallion stands, the name of the contact person at the stallion farm, the Breeding Requirements for the stallion farm, the stallion farm’s phone number, the share number being used, the owner of the Share/Season, the name of the person that confirmed the booking and the date the booking was confirmed.

It also shows the beginning status for the selected season, the last day bred, the status of the mare after her Last Exam, the Final Status of the mare and any mare comments that were entered on the mare information screen.
6. Mare List by Client

- Select “Mare Info”
- Select “Reports”
- Select “Mare List By Client”

- Select the “Season”
- Select a particular farm from the drop down list or leave “Farm” as <All> to include all farms in the report.
- Select a particular owner from the drop down list or leave “Owner” as <All> to include all owners in the report.
- If the “Show Only Currently Boarding” is checked, only those horses that are currently boarding will be shown on the report.
- If the “Sort by farm” is selected, the report will sort alphabetically by farm name.
- If the Sort By “Owner” is selected, the report will sort alphabetically by the client’s last name.
- Select to Preview the report or send it directly to the Printer
- Click Submit
This report will show the Owner's Name, the Percent Owned, the Mare name, the horse Type, the name of the Farm where the mare is, the Season year (Previous Season and Selected Season), the name of the stallion that the mare was bred to, the last day the mare was bred, the Status After the Last Exam, the Final Status, the date the mare foaled and the foal color & sex.

The Status After Last Exam information is pulled from the “Status After Exam” field on the “Mare Entry/Edit” screen and the Final Status is also pulled from the “Mare Entry/Edit” screen from the “Final Status” field.

Generate Broodmare Season
- Select “Mare Info”
- Select Generate Broodmare Season
- Enter the Season Year and select Generate
The "Generate Broodmare Season" is used to generate a new season record for all mares at the same time. In order for the system to generate a new season record, the mare must have a previous record to generate from and the mare must have a current arrival date. You can generate new season records at any time during the year and as many times as needed or you can add seasons one by one manually.

Note: The system will automatically print a list of mares that it has created a new season record for each time you generate.

<table>
<thead>
<tr>
<th>Mare Name</th>
<th>Farm Name</th>
<th>Beginning Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blackeyed Susan [GH 2009/4/01(5)]</td>
<td>TJCIS Main Mare Farm</td>
<td>In-Foil</td>
</tr>
<tr>
<td>Show Groove</td>
<td>TJCIS Secondary Mare Farm</td>
<td>In-Foil</td>
</tr>
<tr>
<td>Evening Phœnix</td>
<td>TJCIS Main Mare Farm</td>
<td>In-Foil</td>
</tr>
<tr>
<td>Connecticut</td>
<td>TJCIS Secondary Mare Farm</td>
<td>In-Foil</td>
</tr>
</tbody>
</table>

- If there are no mares that need a new season, you will get a message to that effect when you generate. Mares that already have a season will not be duplicated.
Base Reports

1. Clients
This report prints a list of clients that have been entered into the system. You can print just the clients’ names or you can include their address. You can also select to show only those clients whose horses are currently boarding. If the box “Include only boarding?” is blank, the report will list all clients even if they no longer are boarding horses with you.

If the box “Show Inactive Records” is checked, those clients that have been marked as “Inactive” will also appear on the list.

If the box “Sort Suppressed Clients First?” is checked, those clients that you have marked to “Suppress Billing” will appear at the top of the client list.

If the box “Show Tax ID” is checked, the report will show the Tax ID that has been entered for the client. If that box is not checked, the e-mail information for the client will show on the report.
<table>
<thead>
<tr>
<th>Client Name</th>
<th>Farm / Company Name</th>
<th>Phone</th>
<th>Email</th>
<th>Tax ID / SSN</th>
<th>Suppress Billing</th>
<th>Farm Owner</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Unknown</td>
<td>_Unknown</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All In All Incorporated</td>
<td>All In All Incorporated</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Altogether Partnership</td>
<td>Altogether Partnership</td>
<td></td>
<td></td>
<td>E-Mail:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arbear, Frederick J.</td>
<td></td>
<td></td>
<td></td>
<td><a href="mailto:oneforat@gmail.com">oneforat@gmail.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calihan, Careen</td>
<td></td>
<td></td>
<td></td>
<td>Home: (615) 231-3894</td>
<td>123.5456</td>
<td></td>
</tr>
<tr>
<td>E-Mail: <a href="mailto:careen@careen.com">careen@careen.com</a></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliott, Drew</td>
<td></td>
<td></td>
<td></td>
<td>E-Mail:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>February Rain Farm</td>
<td>February Rain Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fields of Gold Farm</td>
<td>Fields of Gold Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gemstone Racing</td>
<td>Gemstone Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jockey Club Syndicate</td>
<td>Jockey Club Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Just Because Farm</td>
<td>Just Because Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>McDaidby, Anne</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O'Donnovan, Colleen</td>
<td>Emerald Isle Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offley's Racing</td>
<td>Offley's Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outside Mars Owner</td>
<td>Outside Mars Owner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Riera, Sara</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway's Groom Syndicate</td>
<td>Runaway's Groom Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Agent/Consignor</td>
<td>Sales Agent/Consignor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Client Syndicate</td>
<td>Test Client Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verdugos, James</td>
<td>Suppressed Success</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wade, Michael J.</td>
<td>2BECA Enterprises</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Williams, Edward</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Client Name</th>
<th>Farm / Company Name</th>
<th>Phone</th>
<th>Email</th>
<th>Tax ID / SSN</th>
<th>Suppress Billing</th>
<th>Farm Owner</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Unknown</td>
<td>_Unknown</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All In All Incorporated</td>
<td>All In All Incorporated</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Altogether Partnership</td>
<td>Altogether Partnership</td>
<td></td>
<td></td>
<td>E-Mail:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arbear, Frederick J.</td>
<td></td>
<td></td>
<td></td>
<td><a href="mailto:oneforat@gmail.com">oneforat@gmail.com</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Calihan, Careen</td>
<td></td>
<td></td>
<td></td>
<td>Home: (615) 231-3894</td>
<td>123.5456</td>
<td></td>
</tr>
<tr>
<td>E-Mail: <a href="mailto:careen@careen.com">careen@careen.com</a></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliott, Drew</td>
<td></td>
<td></td>
<td></td>
<td>E-Mail:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>February Rain Farm</td>
<td>February Rain Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fields of Gold Farm</td>
<td>Fields of Gold Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gemstone Racing</td>
<td>Gemstone Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jockey Club Syndicate</td>
<td>Jockey Club Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Just Because Farm</td>
<td>Just Because Farm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>McDaidby, Anne</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>O'Donnovan, Colleen</td>
<td>Emerald Isle Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offley's Racing</td>
<td>Offley's Racing</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outside Mars Owner</td>
<td>Outside Mars Owner</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Riera, Sara</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Runaway's Groom Syndicate</td>
<td>Runaway's Groom Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sales Agent/Consignor</td>
<td>Sales Agent/Consignor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Client Syndicate</td>
<td>Test Client Syndicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verdugos, James</td>
<td>Suppressed Success</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wade, Michael J.</td>
<td>2BECA Enterprises</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Williams, Edward</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Page 222 of 324
This report prints a list of horses that have been entered into the system.
You can create the report based on a combination of options: Sort by Farm Name or Horse Name and show only those horses Currently Boarding. You can also print the list based on a particular horse type or Boarding Type and if the box is checked, you can Show Inactive Records (horses that have been marked as Inactive).

Sort by: Select “Farm Name” and the report will print each farm on a separate page. Select “Horse Name” and the report will alphabetically print a list of all horses regardless of the farm.
This report prints a list of farms that have been entered into the system. The list includes Farm Name, Address, Manager, Contact, Vet, Owner and any phone numbers that you entered in the Farm Master File Entry/Edit form.

If the box “Show Inactive Records” is checked, those farms that have been marked as “Inactive” will also appear on the list.
4. Boarding Types
This report prints an alphabetical listing of all of the Boarding Types that you have set up for your farm/company. The Standard Board rate associated with each Boarding Type will be shown as well as the Default Horse Type that is associated with each Boarding Type.

The report will indicate the G/L Number that has been entered for each Boarding Type and the Billing System. Comments that were entered in the Board Type Entry/Edit form appear on this report.

If the box “Show Inactive Records” is checked, those Boarding Types that have been marked as “Inactive” will also appear on the list.

<table>
<thead>
<tr>
<th>Boarding Type</th>
<th>Standard Board Rate</th>
<th>Default Horse Type</th>
<th>G/L Account Number</th>
<th>Billing System</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boarding</td>
<td>$25.00</td>
<td>Mare</td>
<td>421</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Polo</td>
<td>$20.00</td>
<td>Mare</td>
<td>422</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>In Training</td>
<td>$45.00</td>
<td>Mare</td>
<td>410</td>
<td>Standard</td>
<td>Can be used for any age group</td>
</tr>
<tr>
<td>Lay-up</td>
<td>$45.00</td>
<td>Mare</td>
<td>403</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Mare Under Lights</td>
<td>$35.00</td>
<td>Mare</td>
<td>404</td>
<td>Standard</td>
<td>Can be used for maiden mares, barren mares or mares that have slipped.</td>
</tr>
<tr>
<td>Pasture Board</td>
<td>$5.00</td>
<td>Mare</td>
<td>405</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Recruit Mare</td>
<td>$20.00</td>
<td>Mare</td>
<td>420</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Sales Rep - Mare</td>
<td>$35.00</td>
<td>Mare</td>
<td>406</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Sales Rep - Yearling</td>
<td>$35.00</td>
<td>Yearling</td>
<td>407</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Stallion</td>
<td>$80.00</td>
<td>Stallion</td>
<td>NS5701</td>
<td>Standard</td>
<td>Non-syndicated stallion, Procedures &amp; board should appear on standard</td>
</tr>
<tr>
<td>Stallion - Syndicated</td>
<td>$100.00</td>
<td>Stallion</td>
<td>7015</td>
<td>Syndicate</td>
<td>Syndicated Stallion - syndicate billing only.</td>
</tr>
<tr>
<td>Test A</td>
<td>$30.00</td>
<td>Stallion</td>
<td>411</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Test B</td>
<td>$35.00</td>
<td>Stallion</td>
<td>412</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Transient Boarder</td>
<td>$41.00</td>
<td>Stallion</td>
<td>413</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Training</td>
<td>$8.00</td>
<td>Yearling</td>
<td>405</td>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>Yearling</td>
<td>$10.00</td>
<td>Yearling</td>
<td>406</td>
<td>Standard</td>
<td></td>
</tr>
</tbody>
</table>
5. Horse List By Client

This report will show the list of horses that have been entered into the system.

- You can select one Farm from the drop down list or leave Farm as <All> to see all horses at all farms.
- You can select one Horse Type from the drop down list or leave Horse Type as <All> to see all horses at all farms.
- You can sort the list by Owner
- You can sort the list by Farm Name
- You can sort the list by Horse Type

If the box “Show Only Currently Boarding” is not checked, those Horses that are no longer boarding will also appear on the list.

If the box “Show Inactive Records” is checked, those horses that have been marked as “Inactive” will also appear on the list.
<table>
<thead>
<tr>
<th>Owner</th>
<th>Parent Owned</th>
<th>Horse</th>
<th>Type</th>
<th>Size</th>
<th>Barn</th>
<th>Date of Birth</th>
<th>Farm</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown</td>
<td>100% IS Rosemary</td>
<td>Points of Grace</td>
<td>Stall of Dreams</td>
<td>Rosemary (Mo)</td>
<td>02/02/2006</td>
<td>TACS Secondary</td>
<td>Annis #3</td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS A Hit In Time</td>
<td>Rocket Wrangler</td>
<td>A Hit In Time</td>
<td>IS A Hit In Time</td>
<td>02/02/2007</td>
<td>TACS Main More</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Death For Cash</td>
<td>Size</td>
<td>Rocket Wrangler</td>
<td>Find a Buyer</td>
<td>02/02/1973</td>
<td>Stallion Farm A</td>
<td>Outside Stallion</td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Miss O'Leary</td>
<td>Size</td>
<td>Irish Nell</td>
<td>Miss O'Leary</td>
<td>02/02/2012</td>
<td>Stallion Farm L</td>
<td>Outside Stallion</td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Dark Side</td>
<td>None</td>
<td>More</td>
<td>More</td>
<td>02/02/2012</td>
<td>TACS Main More</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Rosemary</td>
<td>None</td>
<td>More</td>
<td>More</td>
<td>02/02/2012</td>
<td>TACS Main More</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Rosemary</td>
<td>None</td>
<td>More</td>
<td>More</td>
<td>02/02/2012</td>
<td>TACS Main More</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unknown</td>
<td>100% IS Death For Cash</td>
<td>Size</td>
<td>Dr. Drum</td>
<td>Dr. Drum</td>
<td>02/02/2001</td>
<td>Stallion Farm H</td>
<td>Outside Stallion</td>
<td></td>
</tr>
<tr>
<td>All In All</td>
<td>100% IS A Partner White</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>02/02/2001</td>
<td>TACS Main More</td>
<td>Annis #1</td>
<td></td>
</tr>
<tr>
<td>All In All</td>
<td>100% IS A Partner White</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>02/02/2001</td>
<td>TACS Main More</td>
<td>Annis #1</td>
<td></td>
</tr>
<tr>
<td>All In All</td>
<td>100% IS A Partner White</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>02/02/2001</td>
<td>TACS Main More</td>
<td>Annis #1</td>
<td></td>
</tr>
<tr>
<td>All In All</td>
<td>100% IS A Partner White</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>02/02/2001</td>
<td>TACS Main More</td>
<td>Annis #1</td>
<td></td>
</tr>
</tbody>
</table>

This list has been sorted by **Owner**

<table>
<thead>
<tr>
<th>Owner</th>
<th>Parent Owned</th>
<th>Horse</th>
<th>Type</th>
<th>Size</th>
<th>Barn</th>
<th>Date of Birth</th>
<th>Farm</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vandegrift, James</td>
<td>100% IS 2002</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Secondary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watts, Michael J.</td>
<td>100% IS Always Right</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Secondary</td>
<td>Training Barn</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watts, Michael J.</td>
<td>100% IS Yellow Jacket</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Secondary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watts, Michael J.</td>
<td>100% IS Dance Partner</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Secondary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Watts, Michael J.</td>
<td>100% IS Rosemary</td>
<td>More</td>
<td>More</td>
<td>More</td>
<td>TACS Secondary</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vandegrift, James</td>
<td>100% IS Secret</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Test Farm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vandegrift, James</td>
<td>100% IS Secret</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Test Farm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vandegrift, James</td>
<td>100% IS Secret</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Test Farm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vandegrift, James</td>
<td>100% IS Secret</td>
<td>More</td>
<td>None</td>
<td>More</td>
<td>TACS Test Farm</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This list has been sorted by **Farm**
This list has been sorted by **Horse Type**.

**Note:** If the Horse Type is blank you have not entered any Horse Type for that particular horse on the horse master screen.
1. **Arrival**

Enter a Starting Date and an Ending Date. This report prints a list of horses that have an arrival record within the date range that has been selected.
The report will sort by Farm and will list the Date of the arrival, the Horse Name, where the horse Arrived From, who Vanned the horse and the time of the arrival.

The information on this report is pulled directly from the Boarding screen. (Master Files > Horses > Boarding). 

See Example (A)

**NOTE:** If no arrival time has been entered, the report will default to 12:00 am.
2. Departure

Enter a Starting Date and an Ending Date. This report prints a list of horses that have a departure record within the date range that has been selected.

<table>
<thead>
<tr>
<th>Date</th>
<th>Horse Name</th>
<th>Shipped To</th>
<th>Vanned By</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/23/2009</td>
<td>A Nick In Time</td>
<td>Mare Farm B</td>
<td>Commercial Van</td>
<td>4:00 PM</td>
</tr>
<tr>
<td>01/25/2009</td>
<td>Alaska</td>
<td>Owner's Farm</td>
<td>Client's Van</td>
<td>5:30 PM</td>
</tr>
<tr>
<td>12/02/2008</td>
<td>07 Debutante Debut</td>
<td>Sale Barn #21</td>
<td>Commercial Van</td>
<td>1:00 PM</td>
</tr>
<tr>
<td>04/09/2008</td>
<td>05 Arkansas</td>
<td>Clinic</td>
<td>Farm Van</td>
<td>11:59 PM</td>
</tr>
<tr>
<td>04/17/2009</td>
<td>05 Evening Princess</td>
<td>Owner's Farm</td>
<td>Farm Van</td>
<td>9:46 AM</td>
</tr>
<tr>
<td>04/17/2009</td>
<td>A Nick In Time</td>
<td>Mare Farm B</td>
<td>Commercial Van</td>
<td>11:59 PM</td>
</tr>
<tr>
<td>07/01/2009</td>
<td>Pineapple Princess</td>
<td>Mare Farm K</td>
<td>Commercial Van</td>
<td>3:30 PM</td>
</tr>
</tbody>
</table>

The report will sort by Farm and will list the Date of the departure, the Horse Name, where the horse Shipped To, who Vanned the horse and the Time of the departure.

The information on this report is pulled directly from the Boarding screen. (Master Files > Horses > Boarding).

See Example (B)

NOTE: If no arrival time has been entered, the report will default to 11:59 pm.
Example (B)

3. Departure Form
For horses that are scheduled to leave the farm or have already left the farm, you can print a report that shows selected procedures that have been performed for any date or date range, for any group of horses that have departed the farm or for a single horse that has departed the farm or is scheduled to depart the farm.

**NOTE:** The procedures that appear on this report are based on the criteria you selected when you originally set up your Procedure Categories and your Procedure Masters.

If you are not satisfied with the procedures that are or are not appearing on this report, go back to the Procedure Category Entry/Edit and the Procedure Master and re-select either “No”, “Yes” or “Last” in the “Departure Print” field. Whatever has been selected in the Procedure Master Entry/Edit form will take precedence over what has been entered in the Procedure Category Entry/Edit form.
NOTE: The “Results” column shows information that has been entered in the “Results” field on the procedures performed form.

<table>
<thead>
<tr>
<th>Date Performed</th>
<th>Procedure</th>
<th>Performed By</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/05/2008</td>
<td>Exam - General</td>
<td>The Vet</td>
<td>These are the results of the exam. Horse is in good health and is in good reproductive health. All test results are within normal limits.</td>
</tr>
<tr>
<td>08/18/2008</td>
<td>Exam - General</td>
<td>The Vet</td>
<td></td>
</tr>
<tr>
<td>02/27/2009</td>
<td>Breed To Hot Cocoa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>04/23/2009</td>
<td>Rhino</td>
<td>The Farm Vet</td>
<td></td>
</tr>
<tr>
<td>04/24/2009</td>
<td>Vanning</td>
<td>The Vet</td>
<td></td>
</tr>
<tr>
<td>04/26/2009</td>
<td>Coggins</td>
<td>The Vet</td>
<td></td>
</tr>
<tr>
<td>02/26/2010</td>
<td>Breed To Hot Cocoa</td>
<td></td>
<td></td>
</tr>
<tr>
<td>04/29/2010</td>
<td>Trim 4</td>
<td>The Blacksmith</td>
<td></td>
</tr>
</tbody>
</table>

NOTE: Comments entered in the “Departure Notice” field on the Horse Master form will appear on the Departure Form in the Remarks area. (See Horse Entry/Edit)
4. Horse Notes

This report is based on the information that has been entered through the "Notes" tab on the Horse Entry screen.

(Master Files > Horse Entry/Edit > Notes) See (A) Below
To print the report:

- Select a Starting Date and an Ending Date. You might want to see information for one day, one week, one month, one year, or any other specific date range.
- Once you have selected a date range, you have the option to create the report based on additional criteria.
- Sort By: Select have the report sorted by either the Client Name or by the Horse Name.
- Boarding Only: Click in the box if you want the report to list only those horses that are currently boarding. Leave the box unchecked if you want to see all horses including those that are not currently boarding.
- Category: Select one specific Procedure Category from the drop down list or leave “Category” as <All> to include all Categories.
- Procedure: Select one specific Procedure from the drop down list or leave “Procedure” as <All> to include all Procedures.
- Horse: Select one specific Horse from the drop down list or leave “Horse” as <All> to include all horses.
- Horse Type: Select one specific Horse Type from the drop down list or leave “Horse Type” as <All> to include all Horse Types
- Current Owner: Select one specific Client from the drop down list or leave “Current Owner” as <All> to include all Owners.
- Band/Tag: Select one specific Band/Tag from the drop down list or leave “Band/Tag” as <All> to include all Band/Tags.
- Select to Preview the report or send it directly to the Printer
- Click Submit.
NOTE: This report will automatically group by Horse Type.

5. Health Record Report

This report prints a comprehensive list of procedures that have been performed on a single horse or a group of horses. You can select any given date range, include only those horses that are currently boarding, include only the procedures you have marked as “Health Type”, all procedures in all categories or only procedures in one category.
NOTE: The “Results/Comments” column will show information that has been entered in the “Results” field and/or the “Procedure Comments” field on the procedures performed form.

6. Mini-Pedigree

Based on the information that has been entered in the Master Files > Horse Entry/Edit screen, this report prints a 2 Generation Pedigree.
• Horse Type: Select one specific Horse Type from the drop down list or leave “Horse Type” blank to include all Horse Types.
• Horse: Select one specific Horse from the drop down list or leave “Horse Name” blank to include all Horses
• Band/Tag: Select one specific Band/Tag from the drop down list or leave “Band/Tag” blank to include all Band/Tags
• Select to Preview the report or send it directly to the Printer
• Click Submit.

7. Horse Movement

Utilizing a combination of the Arrival/Departure dates and Movement/Transfer Procedures, this report will allow a user to track the Barn/Location movements of a horse.
You will first set up a procedure master to be the Movement/Transfer procedure. When you enter a Movement procedure for a horse, the current Farm, Location, Barn, Stall and Field will be displayed for that horse.

Update the Movement Details fields to show the new information and click “Save”.
New location information has been entered for this mare.

The Horse information page has been updated with the new location information.
The report will show Arrival and Departure dates and Movement information.

<table>
<thead>
<tr>
<th>Horse</th>
<th>Type</th>
<th>Start Date</th>
<th>End Date</th>
<th>Farm</th>
<th>Location</th>
<th>Barn</th>
<th>Stall</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited Success</td>
<td></td>
<td>11/21/2011</td>
<td>11/21/2011</td>
<td>TUCS Man More Farm</td>
<td>B 3</td>
<td>6</td>
<td>B1</td>
<td></td>
</tr>
</tbody>
</table>

**Type:**
- A = Arrival
- D = Departure
- M = Movement
Procedure Reports

1. Procedures Performed Report

This prints a report of the procedures that have been performed based on the criteria selected.

You can select any date range, sort the report by Performed Date, Horse Name, Order Entered, search either in the Performed Date or the Entered Date, select horses that are boarding or not or with activity or not.

You can also select by the “Farm”, “Horse”, “Location”, “User ID”, “Invoice Ref No”, “Barn”, “Horse Type”, “Band/Tag”, “Procedure”, “Category”, “Performed By” or “Current Owner” field. The report will show amounts charged and totals based on what you have selected to print.
**TIP:** To select more than one procedure for the Procedures Performed Report, simply click in the box to the right of the procedure to select all of the procedures you want to include on your report. Follow the same steps to select more than one Category.

**TIP:** To print a report to double-check your day’s entries, enter “today’s date” in the Starting Date and Ending Date and search in “Entered Date”. Next, Sort By “Ordered Entered” and submit the report either to the printer or the screen. This report will show you all of the procedures that have been entered for that particular day in the order that you actually entered them.
2. **Procedure Category**

This menu item prints an alphabetical list of the categories that have been entered into the system. You can select to show Inactive Procedure Category Records or not.

![Procedure Category Report](image)

This menu item prints an alphabetical list of the categories that have been entered into the system. You can select to show Inactive Procedure Category Records or not.

---

<table>
<thead>
<tr>
<th>Description</th>
<th>Print On Departure Form?</th>
<th>GL Revenue Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>No</td>
<td>1100</td>
</tr>
<tr>
<td>Arrival/Departure</td>
<td>No</td>
<td>7000</td>
</tr>
<tr>
<td>Blocker</td>
<td>Last</td>
<td>7001</td>
</tr>
<tr>
<td>Decomment</td>
<td>Last</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Movement</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>No</td>
<td>97011</td>
</tr>
<tr>
<td>Registrations/Nominations</td>
<td>Yes</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Yes</td>
<td>7008</td>
</tr>
<tr>
<td>Rick</td>
<td>No</td>
<td>7007</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Yes</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccination</td>
<td>No</td>
<td>7008</td>
</tr>
<tr>
<td>Vet - Farm Vet</td>
<td>No</td>
<td>7010</td>
</tr>
<tr>
<td>Vet - Outside/General Vet</td>
<td>No</td>
<td>7000</td>
</tr>
</tbody>
</table>

3. **Procedure Master**

This menu item prints a list of procedures that have been entered into the system either sorted by category or not. You can select to show Inactive Procedure Master records or not.
### Procedure Master Report

**Sort by Category**
- [ ]

**Show Inactive Records**
- [ ]

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Std. Charge</th>
<th>Print on Depart Form</th>
<th>Breeding Procedure</th>
<th>Print on Treat Sheet</th>
<th>GL Account</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advertising</td>
<td>Advertising</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>1100</td>
</tr>
<tr>
<td>Arrival/Departure</td>
<td>Arrival/Departure</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7000</td>
</tr>
<tr>
<td>Blacksmith</td>
<td>Trim 4</td>
<td>$30.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7001</td>
</tr>
<tr>
<td>Deworm</td>
<td>Insectoin</td>
<td>$12.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Deworm</td>
<td>Strongid</td>
<td>$14.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7002</td>
</tr>
<tr>
<td>Horse Movement</td>
<td>Farm to Farm Movement</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Conformation Notes</td>
<td>$0.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Evaluation Notes</td>
<td>$0.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Horse Notes</td>
<td>Reproductive Notes</td>
<td>$0.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>Reregister</td>
<td>$3.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>SME Tabs</td>
<td>$1.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Recurring Procedures</td>
<td>Vitamins &amp; Supplements</td>
<td>$2.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>R7011</td>
</tr>
<tr>
<td>Registrations/Nominations</td>
<td>Breeder's Cup/Nomination</td>
<td>$500.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Registrations/Nominations</td>
<td>Jockey Club Registration</td>
<td>$200.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Breeding Date</td>
<td>$0.00</td>
<td>Yes</td>
<td>True</td>
<td>True</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foal Date of Birth</td>
<td>$0.00</td>
<td>True</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Foaling Information</td>
<td>$200.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Paep</td>
<td>$50.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Paep for Ovulation</td>
<td>$50.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Ultrasound</td>
<td>$60.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7005</td>
</tr>
<tr>
<td>Reproductive</td>
<td>Ultrasound - In Foal</td>
<td>$0.00</td>
<td>False</td>
<td>True</td>
<td>True</td>
<td>7005</td>
</tr>
<tr>
<td>Start Fee Billing Items</td>
<td>Chute Fee</td>
<td>$150.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Start Fee Billing Items</td>
<td>Container Deposit</td>
<td>$200.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Start Fee Billing Items</td>
<td>Shipping Expenses/Fees</td>
<td>$0.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>SF 01</td>
</tr>
<tr>
<td>Tax</td>
<td>New Hatcher</td>
<td>$40.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7007</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Rabies</td>
<td>$10.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Rhinos</td>
<td>$10.00</td>
<td>False</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>Tetanus</td>
<td>$10.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vaccinations</td>
<td>West Nile</td>
<td>$12.00</td>
<td>Last</td>
<td>False</td>
<td>False</td>
<td>7003</td>
</tr>
<tr>
<td>Vanning</td>
<td>Vanning</td>
<td>$75.00</td>
<td>Yes</td>
<td>False</td>
<td>False</td>
<td>7009</td>
</tr>
<tr>
<td>Vet - Farm Vet</td>
<td>Treatment</td>
<td>$0.00</td>
<td>No</td>
<td>False</td>
<td>False</td>
<td>7010</td>
</tr>
</tbody>
</table>
4. Schedule Master

This menu item prints a list of all of the scheduled procedures that have been entered into the system.

<table>
<thead>
<tr>
<th>Schedule Name</th>
<th>Procedures Schedules Due</th>
<th>After</th>
<th>Baseline On</th>
<th>Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Einnarn</td>
<td>01/16/2000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insurance Exam</td>
<td>04/08/2011</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hermelin - One Time</td>
<td>04/10/2000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Annel</td>
<td>New Balance</td>
<td>5 Days</td>
<td>Arrival/Departure</td>
<td></td>
</tr>
<tr>
<td>Yearly Cophr</td>
<td>Cophr</td>
<td>varying</td>
<td>Cophr</td>
<td></td>
</tr>
<tr>
<td>Fields - 10 Day Tolerance</td>
<td>10 Days</td>
<td></td>
<td>Full Date of Birth</td>
<td></td>
</tr>
<tr>
<td>Gnl Exan</td>
<td>Gnl - General</td>
<td>1 Days</td>
<td>Filling Information</td>
<td></td>
</tr>
<tr>
<td>US After Birth</td>
<td>Ultrasound</td>
<td>10 Days</td>
<td>Need for Auscultation</td>
<td></td>
</tr>
<tr>
<td>Monthly Tech - Horse</td>
<td>Tray 4</td>
<td>every 1 month</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Procedure Type</th>
<th>Horse Type</th>
<th>Location</th>
<th>Horse</th>
<th>LO</th>
<th>RD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>Test</td>
<td>Test</td>
<td>Test</td>
<td>LO</td>
<td>RD</td>
</tr>
<tr>
<td>Other</td>
<td>Other</td>
<td>Other</td>
<td>Other</td>
<td>LO</td>
<td>RD</td>
</tr>
</tbody>
</table>
5. Scheduled Procedures Due

- Select “Procedures” from the menu
- Select “Reports” from the menu
- Select “Scheduled Procedures Due” menu item

- Select a date range to print. You might want to see what procedures have been scheduled for one day, one week, one month or even one year.

- Once you have selected a date range, you have the option to further limit the report by selecting other criteria.
  - To group all horses in the list by location, check the box “Group By Location?”
  - This report defaults to show horses “Currently Boarding Only?” Uncheck this box if you want to see all horses on the report, even if they are no longer currently boarding.
  - If you want to see everything that is scheduled for “In-Foal” mares only, check the box next to “Include Only In-Foal Mares?” and leave the other fields blank.
  - If you want to see everything that is scheduled for all horses on one particular farm, select the specific farm name from the drop down list and leave the other fields blank.
  - If you want to see everything that is scheduled for one particular horse, select the one horse’s name from the drop down list and leave the other fields blank.
  - If you want to see everything that is scheduled for one particular horse type, select that particular horse type from the drop down list and leave the other fields blank.
  - If you want to see all horses that have been scheduled for a particular procedure, select the specific procedure from the drop down list and leave the other fields blank.
- If you want to see all horses of one horse type that have been scheduled for a particular procedure, first select the specific horse type from the drop down list and then select the specific procedure from the drop down list and leave the other fields blank.
- If you want to see everything that is scheduled for a horse with a particular Band/Tag number, select that particular Band/Tag number from the drop down list and leave the other fields blank.
- If you want to see all horses that have been scheduled for all procedures in a particular category, select the specific category from the drop down list and leave the other fields blank.

**Note:** The Schedule Procedures Due Report will provide you with a list of what should be done to your horses based on what has been entered in the Schedule Master screen. Because it has been scheduled does not mean that the procedure has actually been performed on a horse or a group of horses.

**NOTE:** When the due date in the Schedule Master screen has passed for a scheduled procedure, that scheduled procedure will appear as (Past Due) on the procedure Detail screen and (Over Due) on the Scheduled Procedures Due Report.

![Procedure Detail](image)
1. Foaling Report
   - Select “Reports”
   - Select “Mare Reports”
   - Select “Foaling”
Select the date range you want to see
Select a specific farm from the drop down list or leave “Farm” as <All> to see all foals at all farms.
[Optional] Group by Farm
[Optional] Show only currently boarding mares
[Optional] Format the report to be exported
Select to Preview the report or send it directly to the Printer
Click Submit.
The Foaling Report will display the information from the “Foaling Info” page on the “Mare Entry/Edit” screen.

- The Foaling Report shows the sequence number of the mare, the mare’s name, the name of the stallion that the mare was bred to in the previous season, the color of the foal, the sex of the foal, the date the mare foaled, what time the mare foaled and any comments that were entered in the “Foaling Info” screen.
2. Breeding Report

- Select "Reports"
- Select "Mare Reports"
- Select "Breeding"

- Select the Season
- Select one particular farm or leave "Farm" as <All> to see all mares at all farms
- If you want the report to be Grouped by farm, click in the box next to "Group By Farm"
- [Optional] Show only currently boarding mares
- Select to Preview the report or send it directly to the Printer
- Click Submit.

This report lists the sequence number of the mare, how many times the mare was bred, the mare’s name, the last day the mare was bred, whether the last day bred was a double, the name of the stallion she was last bred to, how many days since the mare was last bred and the status of the mare after her last exam.
As mares are re-bred, their names will automatically be re-arranged in chronological order.

The Status column displays information that is in the “Last Exam” field on the Mare Entry/Edit screen.

3. Outside Bookings
- Select “Reports”
- Select “Mare Reports”
- Select “Outside Bookings”
- Select the date range you want to see
- Select a specific farm from the drop down list or leave “Farm” as <All> to see the outside bookings for all mares at all farms.
- Click the box “Show Cancelled Bookings” if you want the report to show the bookings that have been cancelled. If this box is blank, no cancelled bookings will print on the report.
- Select to Preview the report or send it directly to the Printer
- Click Submit.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Mare Name</th>
<th>Booked To Standing Farm</th>
<th>Breeding Requirements</th>
<th>Vanned By Pick Up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tue 2/17/2009 8:00 AM</td>
<td>Siberian Iris [OH 20068 #061]</td>
<td>Mountain King</td>
<td>Breeding requirements for Stallion Farm H</td>
<td>Farm Van 7:00 AM</td>
<td></td>
</tr>
<tr>
<td>Wed 2/18/2009 8:30 PM</td>
<td>Siberian Iris [OH 20068 #061]</td>
<td>Mountain King</td>
<td>Breeding requirements for Stallion Farm H</td>
<td>Farm Van 2:00 PM</td>
<td></td>
</tr>
<tr>
<td>Tue 3/3/2009 2:00 PM</td>
<td>Mediterranean Pinks</td>
<td>Min O'Yar</td>
<td>Breeding requirements for Stallion Farm A</td>
<td>Farm Van 2:00 PM</td>
<td></td>
</tr>
<tr>
<td>Wed 3/11/2009 8:30 AM</td>
<td>Watchful Eye</td>
<td>Runaway's Groom</td>
<td>Breeding requirements for TJCIS Main Station Farm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fri 5/11/2009 2:00 PM</td>
<td>Yellow Jusquill [Y.01]</td>
<td>Call Me</td>
<td>Breeding requirements Stallion Farm L</td>
<td>Farm Van 1:00 PM</td>
<td></td>
</tr>
<tr>
<td>Sun 5/3/2009 2:00 PM</td>
<td>Yellow Jusquill [Y.01]</td>
<td>Call Me</td>
<td>Breeding requirements Stallion Farm L</td>
<td>Farm Van 1:00 PM</td>
<td></td>
</tr>
</tbody>
</table>

- The Outside Bookings report will show you what day of the week the mare is scheduled (Mon, Tue, etc.), the actual date the mare is scheduled to be bred (m/dd/yyyy), the time the mare is booked, the mare’s name, the name of the stallion the mare is booked to, the name and phone number of the farm where the stallion stands, the breeding requirements at the stallion farm, who will van the mare to the breeding shed and what time they will pick her up.
- Additionally, the Outside Bookings report will show any booking comments that have been entered on the “Breeding Dates Entry/Edit” screen and whether or not the mare was Bred or the breeding was **Cancelled**.
4. Farm Mares Bred Summary

- Select “Reports”
- Select “Mare Reports”
- Select “Farm Mares Bred Summary”

- Select the Breeding Season.
- Select one particular stallion from the drop down list or leave “Stallion” as <All> to see all stallions.
- Select one particular Farm from the drop down list or leave “Farm” as <All> to see all farms.
- Select whether to sort the report by how many “Days Since Last Bred” or alphabetically by the “Mare Name”.
- [Optional] Show only currently boarding mares
- Select to Preview the report or send it directly to the Printer
- Click Submit.
The "Farm Mares Bred Summary" report shows the mare’s name, what her status was at the beginning of the Breeding Season, her foaling date, the name of the Stallion she was bred to, all of her breeding dates for the selected Breeding Season, how many days since she was last bred, her final status and her projected foaling date for the next year.

If the mare was bred to more than one stallion in a breeding season, each stallion’s name will be displayed. (A)

The “Begin Status” is pulled from the Mare Entry/Edit > Mare Info screen “Starting Status” field.

The “Final Status” is pulled from the Mare Entry/Edit > Mare Info screen “Final Status” field.

The “Projected Foaling Date” is calculated based on what you entered in Setup > Preferences > Mare/Foal Settings (Days Between Last Day Bred and Foaling Date). The value for “Due Date” can be any number that you want to enter.
5. Broodmare Listing
   - Select “Reports”
   - Select “Mare Reports”
   - Select “Broodmares”

   - Select the “Season”
   - Select one particular Farm from the drop down list or leave “Farm” as <All> to see all farms
   - [Optional] Show only currently boarding mares
   - Select to Preview the report or send it directly to the Printer
   - Click Submit.
This report will show information for the previous breeding season and the selected season for each broodmare.

The previous season will show the name of the stallion the mare was bred to, the farm where the stallion stands, the name of the person that confirmed the booking and the date the booking was confirmed, the last bred date, the foaling date, the foal color and the foal sex.

The current season will show the name of the stallion, the name of the farm where the stallion stands, the name of the contact person at the stallion farm, the Breeding Requirements for the stallion farm, the stallion farm’s phone number, the share number being used, the owner of the Share/Season, the name of the person that confirmed the booking and the date the booking was confirmed.

It also shows the beginning status for the selected season, the last day bred, the status of the mare after her Last Exam, the Final Status of the mare and any mare comments that were entered on the mare information screen.

<table>
<thead>
<tr>
<th>Horse: A Real Ruby</th>
<th>Standing Farm:</th>
<th>Confirmed By:</th>
<th>Last Bred Date:</th>
<th>Foaling Date:</th>
<th>Foal Color:</th>
<th>Foal Sex:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005 Stallion: Runaway's Groom</td>
<td>TJCS Main Stallion Farm</td>
<td>One</td>
<td>6/2/2005</td>
<td>Feal</td>
<td>Feal</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Horse: Blackeyed Susan [QH 2008040102]</th>
<th>Standing Farm:</th>
<th>Confirmed By:</th>
<th>Last Bred Date:</th>
<th>Foaling Date:</th>
<th>Foal Color:</th>
<th>Foal Sex:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005 Stallion: West by West</td>
<td>Stallion Farm A</td>
<td>One</td>
<td>6/2/2005</td>
<td>Feal</td>
<td>Feal</td>
<td></td>
</tr>
</tbody>
</table>

| Horse Comments: Information pertaining to the 2006 breeding season for the mare: A Real Ruby | 

<table>
<thead>
<tr>
<th>Horse: Blackeyed Susan</th>
<th>Standing Farm:</th>
<th>Confirmed By:</th>
<th>Last Bred Date:</th>
<th>Foaling Date:</th>
<th>Foal Color:</th>
<th>Foal Sex:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006 Stallion: Nobody’s Fool</td>
<td>Stallion Farm L</td>
<td>One</td>
<td>4/4/2006</td>
<td>Feal</td>
<td>Feal</td>
<td></td>
</tr>
</tbody>
</table>

| Horse Comments: More info comments for the mare: Blackeyed Susan. These comments show up on the Broodmare Listing Report | 

- This report will show information for the previous breeding season and the selected season for each broodmare.
- The previous season will show the name of the stallion the mare was bred to, the farm where the stallion stands, the name of the person that confirmed the booking and the date the booking was confirmed, the last bred date, the foaling date, the foal color and the foal sex.
- The current season will show the name of the stallion, the name of the farm where the stallion stands, the name of the contact person at the stallion farm, the Breeding Requirements for the stallion farm, the stallion farm’s phone number, the share number being used, the owner of the Share/Season, the name of the person that confirmed the booking and the date the booking was confirmed.
- It also shows the beginning status for the selected season, the last day bred, the status of the mare after her Last Exam, the Final Status of the mare and any mare comments that were entered on the mare information screen.
6. Mare List by Client
   - Select “Reports”
   - Select “Mare Reports”
   - Select “Mare List By Client”

- Select the “Season”
- Select a particular farm from the drop down list or leave “Farm” as <All> to include all farms in the report.
- Select a particular owner from the drop down list or leave “Owner” as <All> to include all owners in the report.
- If the “Show Only Currently Boarding” is checked, only those horses that are currently boarding will be shown on the report.
- If the “Sort by farm” is checked, the report will sort alphabetically by farm name.
- If the Sort By “Owner” is checked, the report will sort alphabetically by the client’s last name.
- Select to Preview the report or send it directly to the Printer
- Click Submit
This report will show the Owner's Name, the Percent Owned, the Mare name, the horse Type, the name of the Farm where the mare is, the Season year (Previous Season and Selected Season), the name of the stallion that the mare was bred to, the last day the mare was bred, the Status After the Last Exam, the Final Status, the date the mare foaled and the foal color & sex.

The Status After Last Exam information is populated from the “Status After Exam” field on the “Mare Entry/Edit” screen and the Final Status is also populated from the “Final Status” field on the “Mare Entry/Edit” screen.

7. Teasing Worksheet
This produces a worksheet where teasing results and comments can be noted and then later entered into HFM.

- Select “Reports”
- Select “Mare Reports”
- Select “Teasing Worksheet”
Select the date for current results.
Select a specific farm from the drop down list or leave Farm as <All> to print worksheets for all farms.

This report shows the mare name, the date the mare is due to foal, the actual foaling date, the last day she was bred, the results from the last 7 days of teasing (based on the result date selected) and an area to note the current day’s teasing results and comments.

- The “Due Date” is calculated based on what you entered in Setup > Preferences > Mare/Foal Settings (Days Between Last Day Bred and Foaling Date). The value for “Due Date” can be any number that you want to enter.
8. Teasing Results Report
   - Select “Reports”
   - Select “Mare Reports”
   - Select “Teasing Results Report”

   - Select the season from the drop down list.
   - Select a specific farm from the drop down list or leave “Farm” as <All> to see all farms.
   - Select an owner from the drop down list or leave “Owner” as <All> to see teasing results for all horses
   - Select a specific horse type from the drop down list or leave “Horse Type” as <All> to see teasing results for all horse types.
   - Select a horse from the drop down list or leave “Horse” as <All> to see teasing results for all horses or select a Band Tag from the drop down list instead of the horse name.
   - Select to sort the report by Farm or Horse. If sorted by Farm, the report will list the farms in alphabetical order and then the horses within each farm alphabetically. If sorted by Horse, the report will list alphabetically by horse name regardless of the farm.
   - Select the month range.
   - Select to Preview the report or send it directly to the Printer
   - Click Submit.
This report will show the mare name, the name of the farm, the mare’s sire, dam, color, YOB, stallion bred to previous season and LDB previous season, current foaling date, color and sex of the foal, stallion booked to in current season, beginning status and final status for current season.

This report will show any Teasing results that have been entered for each horse (Mare Info > Mares >Teasing Info.) or (Mare Info > Teasing Results Entry). Additionally, this report will show entries for LO, RO, Cervix & Other (Master File > Procedure Master > “Procedure Types: Results on Teasing Chart & Update Mare Exam Status)

See Example (A)
Example (A)
9. Foaling Mares By Location

- Select “Reports”
- Select “Mare Reports”
- Select “Foaling Mares By Location”

- Select the season from the drop down list.
- Select a specific Stallion from the drop down list or leave “Stallion” as <All> to see all Stallions.
- Select a specific Farm from the drop down list or leave “Farm” as <All> to see all Farms
- Select a specific Location from the drop down list or leave “Location” blank to see all Locations.
  - The Location items are found in Setup > Master Lists > Location
- If the “Show Only Currently Boarding” is checked, only those horses that are currently boarding will be shown on the report.
- If the Sort by “Days Since Last Bred” is checked, the report will sort chronologically by the days since the mare was last bred.
- If the Sort By “Mare Name” is checked, the report will sort alphabetically by the mare’s name.
- Select to Preview the report or send it directly to the Printer
- Click Submit

This report groups first by Location and shows the Mare name, the Stallion she was bred to for the season that was selected, the last date she was bred for the season that was selected, the Days Since she was last bred, the Final Status for the season that was selected and the Projected Foaling Date.

- **Note:** The Projected Foaling Date is set up in The “Projected Foaling Date” is calculated based on what you entered in Setup > Preferences > Mare/Foal Settings (Days Between Last Day Bred and Foaling Date). The value for “Due Date” can be any number that you want to enter.
Note: This Report will show only those mares that have been marked as “In-Foal” in the Final Status field on the Mare Information page.
Fertility Analysis Reports

1. Farm-Mares: Mares by Month
   - Select “Reports”
   - Select “Fertility Analysis Reports”
   - Select “Farm-Mares: Mares by Month”

   ![On-Farm Fertility Analysis by Month Report]

   - Select the season year.
   - Status to Use: Select “Final” if you want the report to be calculated based on the “Final Status” of the mare.
   - Status to Use: Select “After Last Exam” if you want the report to be calculated based on the Status after the Last Exam of the mare. (Important: See NOTE below)
   - Select the Run Period (Northern Hemisphere/Southern Hemisphere)
   - Select to Preview the report or send it directly to the Printer
   - Click Submit
2. Farm-Mares: Mares by Mare Type

- Select “Reports”
- Select “Fertility Analysis Reports”
- Select “Farm-Mares: Mares by Mare Type”

Select the season year.

Status to Use: Select “Final” if you want the report to be calculated based on the “Final Status” of the mare.

Status to Use: Select “After Last Exam” if you want the report to be calculated based on the Status after the Last Exam of the mare. (See NOTE below)
• Select to Preview the report or send it directly to the Printer
• Click Submit

3. Farm-Mares: Mares by Stud Farm

• Select “Reports”
• Select “Fertility Analysis Reports”
• Select “Farm-Mares: Mares by Stud Farm”

- Select the season year.
- Status to Use: Select “Final” if you want the report to be calculated based on the “Final Status” of the mare.
- Status to Use: Select “After Last Exam” if you want the report to be calculated based on the Status after the Last Exam of the mare. (See
NOTE below)

- Group by mare’s farm: If this box is checked, each mare farm will be grouped together. If this box is blank, the report will print the analysis without grouping the information based on the mare farm.
- Select to Preview the report or send it directly to the Printer
- Click Submit

**IMPORTANT NOTE:** In order for the system to calculate the Fertility Analysis Reports correctly, you must enter a Final Status or a Status After Exam in the appropriate field on the Mare Information page.

The Final Status must be selected from the drop down list and has to be an entry from the Master Lists Category “Mare Status” that is indicated as System Defined True. See (A)
The default settings for Status After Exam have to be entered as Barren, Maiden, Not Bred, Open, Slipped or SL or Unknown. To indicate a pregnancy, you must enter Pg, Preg, PD, Pg+ or any word of your choice that begins with the letter “P”.

When calculating fertility based on Status After Exam, the system will determine the percentages based on the following default settings:

- “P” = Pregnant
- “B” = Barren
- “SL” = Slipped
- Anything else = Unknown
OR

You can go to Setup > Preferences > Company Settings and enter your own Fertility Analysis codes for the Status After Exam calculations.
Labels

- Avery Label: Select a pre-defined Avery Label from the drop down list.
- Start on Label #: This screen defaults to start on Label #1. If not starting on the first label, select the label number by clicking the up/down arrows. For example, if you have used the first 3 labels on a sheet, you can tell the system to start printing labels on the 4th label of that sheet.
- Sort By: Select to print the labels sorted either alphabetically by client name or numerically by ZIP Code.
- Client: Select to show Active Only and/or Boarding Only
- Client Filter: Select a Category from the drop down list and leave Client Name as <All> to see all clients that have been identified as being included in that Category. The Client Filter Categories are set up in Setup > Master Lists > Mailing Code and then individually selected on the Client Master File > Mailing Codes tab.
• **Invoices**: If you have generated monthly billing and have not yet finalized, you can print labels for those clients that are included in this billing. Select the name of your billing from the drop down list (Standard, Monthly, etc.).
• **Sort by Name or ZIP Code**
• **Output the report either to the Printer or to the Screen**
• **Click on the Submit button to print the report.**

• **Farm**: If you want to print labels for all farms that have been entered into the system, click “Farm”.
• **Sort By**: Select to print the labels sorted either alphabetically by farm name or numerically by ZIP Code.
• **Select to show Active Only or not**
• **Click on the Submit button to print the report**
Report Writer

This menu option will allow you to create custom reports based on an established list of “Available Fields”.

To Begin
Select “Reports”
Select “Report Writer”

Click “New” to create a New Report
Or click “Open” to open an existing report

Report Setup
For a new report, choose the report data set “Standard” from the drop down list.
Report Title: Enter a name for the report
Click “Private” if you do not wish to share the report across your network (if your HFM software is networked).

Report Layout: Select “Portrait” or “Landscape”
Select a different Font and Size if needed.

Next, click on the **Select Fields** tab.

When you select the fields you want to include in your report they will appear at the bottom of the screen in the “Sample Data” area.

Once you have selected all of the fields you want to include in your report, click on the “Filters” tab. The filters tab will allow you to limit the report based on the criteria you select.

For example, you may want to include only those horses that are currently boarding or you may want a report with breeding information or foaling information from one specific breeding season.

First select the Field from the drop down list, then select the Condition from the drop down list and then select the Value from the drop down list and click the button “Add as And”.

Once you have selected all of the criteria you can click “Finish” or “Print” to see the report. If you are satisfied with the report you can click “Save” to save the report and retrieve it again when needed.
Samples of Filters

[Diagram of Report Writer interface showing filter settings for fields such as Name, Breed, Sex, etc., with conditions and values for each field.]
For advanced reports we recommend that you call The Jockey Club directly (800) 333-1778 or (859) 224-2800 to get detailed information on how to create more complex reports using the Report Writer.
Setup

1. Companies
   - Select “Setup” from the menu
   - Select “Companies”
   - On the Company Search screen, highlight the name “Place Your Name HERE” and click the Edit button.
   - On the Company screen, go to the “Name” field, DELETE the words “Place Your Name HERE” and type in your own company/farm name.
Enter your complete address
Enter your Phone/E-Mail information.
To enter your Phone/E-Mail Entries, click the “New” button at the bottom of the screen and select the Type of entry from the drop down list. Enter a Description if you need one or just leave the description blank.
Click “Save” when done. You can come back to this screen at a later time and set up additional companies if you need to.

TIP: If your company logo is available and you want it to appear on your invoices, click “New”, browse for your logo and then click the box “Show on Invoice”.

TIP: If you select a logo that is too large you will get this message. Click “OK” and browse for a smaller logo or re-size the selected logo and try again.

2. Preferences

The Preferences section allows you to change some of the default settings for HFM in the following areas:
- Application Settings
  - Mare/Foal Settings
- Company Settings
- Billing Settings
  - Standard Billing Settings
- User Settings
- Email Settings
Application Settings

- If you want to be able to type horse names in lower case and let the system automatically convert them to uppercase, check the box next to “Capitalize All Horse Names”

Mare/Foal Settings

- Days Between Last Day Bred and Foaling Date: 342
- New Foal Naming:
  - Mare Name & Season Year
  - Season Year & Mare Name
- Stallion Mare:
  - Show warning when booking mare with no “Confirmed By”
  - Show warning when booking an imported mare
  - Auto refresh stallion mare ownership when adding mates
- Days Between Last Day Bred and Foaling Date. This number is pre-populated but can be changed. This is the number used to calculate the projected foaling date which shows up on the Mares Bred Summary Report and the Due Date on the Teasing Worksheet.

- New Foal Naming. Select whether you want a new foal’s name to begin with the dam name or the season year.

- Stallion Mare pertains only to those farms that have purchased the HFM Stallion Module.

**Company Settings**

- Band/Tag Numbers. Select to enable the Band/Tag Field and whether or not you want the Band/Tag Number to be displayed before a horse’s name.
- Select the default breed from the drop down list
- Select your own farm name from the drop down list as the “Default Farm”
- It is important to make note of the *Location and Name* of the Save Folder. This folder will hold all of the saved invoices from the closed billing periods and it should be backed up on a regular basis.
- Fertility Analysis Codes. These codes refer to the *Status After Last Exam* field on the mare information page. These codes determine the status of a mare when calculating fertility based on the code that has been used in the Status After Last Exam field on the mare information page.
Billing Settings

Print Company Name on Invoices
- If you want your name, address, etc. to automatically appear as the heading on your invoices, leave the “✓” marked in the box. If you are using pre-printed stationery and do not want the system to automatically generate the heading, simply un-check the box next to Print Company Name on Invoice to remove the “✓”.

Print Board Descriptions on Invoice
- Invoices usually show “Board @ $xx.xx per day”. If the Print Board Type Description On Invoice is checked, the invoice will show “Sales Prep @ $xx.xx per day”.

Check for Duplicate Procedures
- This option will warn you if you have entered a duplicate item within the same entry set

Disable the Warning When Removing A Billing Option On Procedure Detail
- If you DO NOT want the system to warn you that you have removed a procedure from invoicing, check the box next to “Disable the Warning When Removing A Billing Option On Procedure Detail”.

Tax Name
- For Non-US clients, enter the tax name that will be used in billing (such as HST, VAT).
Display Auto-Allocation Options
o When this box is checked, options will be displayed to help automate the process of applying credit invoices and unapplied payments to outstanding invoices.

Billing Settings > Standard

Default Standard Service Charge. Select the default service charge from the drop down menu. This will auto-populate the service charge field on the client master file each time a new client is added to the program.

Standard Billing Starting Invoice #. This is the default number that will be used as the first number on your first invoice generated through the billing menu. This number can be changed but it has to be a number that is greater than the default shown.

Summarize Invoice History Details. If checked, the invoice will be shown in summary format. If unchecked the invoice will be shown in detail format.

Show Horse Charge Details on Invoice. If checked, the invoice will print the detail page for all of the horse charges. If unchecked the details will not be printed.

Show Procedure Summary on Invoice. If checked, the invoice will print the charges by category page. If unchecked there will be no summary page printed.

Use double window envelope. If checked, the invoice heading will be shifted so that the address shows through the double window envelope.
- Standard Billing Invoice Comments. Enter any information in this area that you want to appear on client invoices such as: Net 30, Payable Upon Receipt or Happy Holidays. The text that is entered here will appear on the first page of all client invoices.

**User Settings**

- If you want your reports to print to the screen first before printing to a printer, check the box next to “Default All Reports To The Screen”
- Each person can select his/her own Required Field Color and the Alternate Required Field Color from the drop down list. This setting is for an individual’s workstation, not all of the workstations if you are on a network.
- Show reports with formatting bands. If checked, all reports will display formatting bands. If this option is unchecked there will be no formatting bands on any of the reports.
Email Settings

Please contact The Jockey Club directly for detailed instructions on how to set up your Email. (800) 333-1778 or (859) 224-2800
3. Master Lists
No changes are needed to the Master Lists unless your farm uses a different set of terms or if you would like to add additional items to a Category.

- Select “Setup” from the menu
- Select “Master Lists”
- Select the category that you wish to review from the drop down list. Once you select a Category, the items in that category will be displayed on the screen.
You can add more items to a category by clicking the “New” button and typing your entry on the new blank line.

4. Billing Setup

- Billing Codes
  - AR Maintenance
  - Service Charge
  - Service Tax
  - GL Account Setup
Billing Codes

- "Description" can be changed
- "Default Debit Account" can be changed
- "Default Credit Account" must be selected from the drop down list.
A/R Maintenance

*Initial A/R Client Balances for New Users Only*

- Select “Setup”
- Select “Billing Setup”
- Select “A/R Maintenance”
- A list is displayed with all of the clients that you have entered into the system.

- Add the ending balances for each client from your previous billing. (You can put the full amount in the current column or you may want to break down the amount owed into Current, Over 30, Over 60, Over 90 and Service Charges in order for the Aged A/R Balance Reports to be correct.)

**Note:** The amounts entered in this table will be reflected as the beginning balance on the first billing run performed on HFM.
• **Important:** You can only edit A/R balances in this manner during your initial install/configuration process. Once you have Generated and Finalized a billing, you can **no longer** edit information on this page.
Service Charge [optional]

If you charge late fees for unpaid invoices, you will enter codes for each rate you plan to use. The Horse Farm Management System will automatically apply a “late fee” to any unpaid balances for those clients that you specifically indicate should be charged late fees/service charges. A client will never be charged late fees unless you specifically mark it as such. To set up the Service Charges/Late Fees:

- Select “Setup”
- Select “Billing Setup”
- Select “Service Charge”
- Click the button “New” to add each Service Charge

Each line can have a different Service Charge Code with different percentages. Depending on your specific needs, you can enter just one service charge type or several. Click the button “New” then enter the Service Charge Description and the rate in the 30, 60 & 90 columns.
Service Tax
(Setup > Billing Setup > Service Tax)

**Note:** This feature is used by international clients. It allows the entry of a service tax such as GST, HST, VAT, etc. to be charged on boarding and procedures.

- Select “Setup”
- Select “Billing Setup”
- Select “Service Tax”
- Click the button “Add”
- Add the tax Name
- Add the Rate
- Add the G/L Account Number [optional]
- Go to Setup > Preferences > Billing Settings and enter the Tax Name

*See (A)*
- Go to Master Files > Boarding Types and select the appropriate TAX name from the drop down list.
- Go to Master Files > Procedure Master and select the appropriate TAX name from the drop down list.

When you enter a procedure for a horse that has been marked to have the Service Tax applied, the information will automatically populate on the procedure entry screen.

If you do not want a client to be charged the Services Tax, enter the Exempt Code on their Client master page. See (A)
G/L Account Setup [optional]

- Select “Setup”
- Select “Billing Setup”
- Select the “G/L Account Setup”

**Note:** The system has been preloaded with all necessary G/L Account Numbers. Only if your farm uses specific G/L accounting codes will you need to change the preloaded Account Numbers.
5. Security

There are two levels of security. The first involves “Form Level Security”. **Part (A)** This level enables you to assign what forms each user can access.

The second involves “Startup Security” and requires users to have a password. **Part (B)** This level of security requires that a user has been identified as a valid user and must have a password in order to access HFM.

**Part A**

<table>
<thead>
<tr>
<th>Setup</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Companies</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master Lists</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Master Zip Codes List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Utilities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Registration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online Verification</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Users Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Permissions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Password</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Group Permissions

The Group “Admin” will already have the default permissions set for “Full Rights”.

- Click the button “New” to add each additional group
- Next, select the Group from the drop down list and determine what forms they have rights to use.
- For each “Group”, select the Rights to each of the System Areas listed. You can select Full Rights, Read Only Rights or No Access
- If “Update” is checked, they will be able to read and change the record. (Full rights)
- If “Read” is checked but not “Update”, they will be able to read the record only and not make any changes. (Read Only)
- If “Update” and “Read” are not checked, that menu option will not be visible at all to the user.
- When finished click “Save”
Users Setup
  o Click the “Add” button to begin entering each of your users.
o **Login:** Click “Get Network Username” or type in the name of the Username you wish to add.

o **User Info:** [Optional] You can enter the first and last name of the individual that corresponds to the Username.

o **Group Membership:** First determine whether or not each user is a member of one of the Groups that have been established and then click on the group name in the Available Groups box. Click “Add>” to make that user a member of that specific group.
When finished click “Save”
Part B

Security can be set to Require Login or to Require Password. Select Setup > Preferences > Application Settings

To enable this level of security, you can check the box “Require Login” and also check the box “Require Password”.

If “Require Password” has been checked, the Change Password screen will appear the first time the program is started. The user will have to identify their password.

Change Password

To change your current password, select Setup > Security > Change Password. Enter a new password on the first line, retype the new password on the second line and then click “OK”.

You will log into HFM with the new password you have selected.
Logout System

- If you want to log out of HFM and not shut down your entire system, select “File” at the top left of the screen and then select Logout System. See (A)
- If someone else wanted to access HFM on your computer they would have to log in under their own User ID and/or Password.
6. Utilities

Mass Boarding Entry

If you want to change the boarding type for a large number of horses all at once, do so through “Mass Boarding Entry.” **Be sure** to make the changes starting with the oldest group first. For instance, change all yearlings to two year old’s first and then change all foals/weanlings to yearlings.

*Warning*

WARNING: Before using this feature you should read the help guide. When changing boarding types to the next older type you should start from the oldest board type and work backwards (i.e. racing, two-year old, yearling, foal).
- **Farm**: Select a specific farm from the drop down list or leave “Farm” as <All> to select all Farms.
- **Horse Type**: Select a single Horse Type from the drop down list or leave “Horse Type” as <All> to select all Horse Types.
- **Boarding Type**: Select a single Boarding Type from the drop down list or leave “Boarding Type” as <All> to select all Boarding Types.
- **Barn**: Select a specific barn from the drop down list or leave “Barn” as <All> to select all Barns.
- **Field**: Select a specific field from the drop down list or leave “Field” as <All> to select all Fields.
- **Location**: Select a specific location from the drop down list or leave “Location” as <All> to select all Locations.
- Click on “Apply Filter” and a list of currently boarding horses for the criteria you have selected will be shown in the list on the left.
- Using the arrows in the center of the form, select all horses or certain particular horses and place them in the box on the right.
- Click on “Next”

- Boarding Type: Select the new boarding type
- Start Date: Enter the date that the new Horse Type will be effective.
- Standard Rate: Rate will automatically appear in this field.
- Exception Rate: Enter an exception rate in this field if you want all selected horses to get a rate that is different than what is shown as “Standard”
• Comment: Enter any comments regarding this Boarding Type Change. These comments will appear on the Mass Boarding Worksheet (Comment/Error) that will automatically print after you select “Yes” See (A)

• “Comments”: These comments will also appear in the Boarding screen in the Boarding Comments area for each horse that was included in the “Mass Boarding Entry” group. See (B)

• After you have entered any comments, click on “Finished”
• Select “Yes” to continue

• The “Mass Boarding Worksheet” will automatically appear on screen.
Print the worksheet if needed and then close the Mass Boarding Worksheet screen.

- Click "Previous" to go back and create another Mass Boarding Entry or click "Close".
Zip Codes

If you need to add new Zip Codes to HFM, click “Add” then fill in the information in the fields provided and click “Save”.

Once added, the Zip code will be available in the Address/Zip Code fields in HFM.
Screenshot

If you need to make a screenshot of any one of the HFM screens that you are currently viewing, simply click on Utilities > Screenshot, enter a File name or accept the default File name and click “Save”.

Once the screenshot has been saved you will be able to e-mail it to TJC should you have any questions about that particular screen or HFM entry.
**Roll Back Billing**

If you have finalized your billing in error or have discovered a data entry error that you simply cannot correct via an adjusting entry, you may be able to “unlock” the finalized billing.

Click Setup > Utilities > Roll Back Billing

You will have to call TJC to get a Rollback Security Code. Enter the code that the TJC support person gives to you and click “Submit”.

This screen will show you the billing that has been finalized, the date range of the billing and the person that finalized it along with the date and time.

Verify that the Billing Period that was last finalized is correct and click “Rollback”.

A warning will appear. Click “Yes” if you wish to continue.
You will receive notification that the billing has been rolled back.

At this point you should make any necessary changes and corrections and then process the billing as usual, making sure to finalize after you have proofed each of the Preliminary Billing Reports.

7. Registration

This screen identifies the Registration Number that The Jockey Club has assigned to your farm/business. When you first install HFM, TJC will provide you with the Registration Code.

If this screen appears when you first start the program, please call The Jockey Club for assistance.
8. Online Verification

Please contact The Jockey Club for instructions for setting up and using the
Online Verification. (800) -333-1778 or (859) 224-2800
Help Menu

FAQ

This displays a list of Frequently Asked Questions and their corresponding answers. The list includes questions and answers related to Installation of HFM, Setup, A/R Transactions, Procedure Entry, Mare Information Entry and Billing.
Information for Backups

This shows the location of the files you should back up on a regular basis. The Database holds all of the information that you have entered into HFM and the Save Folder contains all of the invoices that have been saved during month end closing.

The farm is responsible for creating backups of these files stored on their system. These file holds ALL of the farm’s information. If these files get lost or damaged then ALL of the farm’s information will be lost or damaged.

Note the location and name of your Database and your Save Folder so that you are sure they are included in your daily backups.

You should back up these files on a regular basis.
SQL Loader

This is used to apply patches to your database and should only be used under the direction of a TJCIS support person.

Send Database to TJCIS

*This menu option is in Development and is currently not available.*
Check for Updates

From this screen you can check your Program & Database versions, go to Fast Support under the direction of a TJCIS support person; you can go directly to The Jockey Club website or you can Upload your datafile directly to TJCIS.
Note: This is an informational page. You can check to see which HFM Version you are currently running.

This example shows Version 4.2.2.04 See (A)

NOTE: HFM has two components. One component is the actual Program and the other part is your Database. The version number for the Program and the Database should always be the same.

If you open up the program and get this message, it indicates that your Program Version and your Database version do not match. You must contact The Jockey Club to rectify the problem.
HOW TO REACH US

The Jockey Club Information Systems, Inc.
821 Corporate Drive
Lexington, KY 40503

**Phone:** (800) 333-1778
(859) 224-2800

**Fax:** (859) 224-2810

**E-Mail:** support@tjcis.com

Regular business hours:
8:00 am – 5:00 pm (EST) Monday – Friday

Web Address for More Information

[www.horsefarmmanagementsoftware.com](http://www.horsefarmmanagementsoftware.com)

or

[www.tjcis.com](http://www.tjcis.com)